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Chapter 1: Introduction to ScanMaster 2.05.01 

 Introduction to ScanMaster 2.05.01 
ScanMaster Release 2.05.01 is state of the art software for the grocery industry.  
Written in Microsoft Visual Basic for speed and efficiency, the ScanMaster back office 
runs on Windows XP Professional SP2, Windows 2000 Professional SP2, Windows 
2000 Server SP2 and Windows 2003 Server.  It provides the following benefits: 

• Task switching.  You can have many programs or tasks running at the same time 
and switch between them.  This allows you to work more efficiently than with a 
system that only allows you to use one program at a time. 

• Ease of use and fast training.  Since Microsoft Windows is the largest selling 
Graphical User Interface (GUI), many users already know how to use it.  Even if 
they do not, once they learn to use one ScanMaster function, they can quickly 
learn the others.  Users spend less time learning to use ScanMaster, and more time 
in productive work. 

• Windows device support.  ScanMaster can use inkjet and laser printers, high-
resolution monitors, sound cards, or any other device that has a Windows driver. 
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Supported Configurations 
ScanMaster can be configured with a single PC, with the server and back office 
software on the same computer.  ScanMaster can also be configured with two PCs, 
using one as a server and the other as a Back Office Workstation.   The hardware must 
be certified with the selected operating system. 

Combined Server/ Back Office PC 
This configuration uses a single Pentium 1.7 GHz CPU/Server, which runs both the 
network and ScanMaster. 

 
 

Individual Server & Back Office PC 
 

This configuration uses a Pentium 2.7 GHz CPU/Server, which runs both the network 
and ScanMaster software.  It also uses a Pentium 2.7 GHz CPU as a Back Office 
Workstation. 
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Determining Your System Needs 
Some of your system needs are determined by your actual working environment.  For 
example, how many lanes are in your store and how busy are they?  Other factors that 
affect your requirements include the following considerations.  

• The size of your database is determined by the number of customers and 
transactions.  

• Your choice of a combined or individual Back Office/Server combination will 
affect both your hardware and software requirements. 

LAN Communications 
A LAN communications network requires a hub device (concentrator) connecting the 
server, the Back Office, and every POS workstation.  ScanMaster supports the 
following 10BaseT Ethernet cards: 

• SMC Ethernet 10/100 BaseT Ethernet Cards 

• Intel 10/100 BaseT Ethernet Cards 

Remote Support 
The easiest way for you to get ScanMaster upgrades and technical support is over the 
phone line.  Your computers can receive software quickly, and customer support 
personnel can check the state of your computers.  You must have a 28.8K Baud (or 
faster) Hayes Compatible Modem. Any software for the modem must support X-
modem and Z-modem standards. 
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Combined Server & Back Office Workstation  
Combined Server & Back Office 
Workstation Configuration 

Minimum Recommended 

Hardware   

Processor 400 MHz Pentium or highter 2.7 GHz Pentium or higher 

Disk 4.5GB  SCSI Disk or Ultra 
IDE Disk 

40GB SCSI Disk or Ultra IDE 
Disk  (2 if mirroring) 

Removable Disk 3.5” 1.44 MB Removable 
Disk 

3.5” 1.44 MB Removable 
Disk 

Memory 1 GB RAM 2 GB RAM 

CD ROM Required Required 

Video Display SVGA - 1024 x 768, 256 
Color Support, 14 Inch 

SVGA – 1024 x 768, 256 
Color Support, 17 Inch 

Tape Back Up Unit Required: XP Compatible 
Tape Drive (Minimum 4 GB) 

Required: XP Compatible 
Tape Drive (Minimum 4 GB) 

Uninterruptable Power Supply Optional Recommended 

80 Column Printer Ink Jet or Laser Ink Jet or Laser 

Modem 

(External type recommended) 

28.8 KBPS, V.32 Hayes 
Compatible 

56 KBPS, V.32 Hayes 
Compatible 

Ethernet Card  (Note:  
Recommend network card 
supporting multiple protocols). 

10 BaseT (and equivalent 
Hub) 

10-100 (and equivalent Hub) 

Figure 1-3: Minimum and Recommended Requirements 

Server and Individual Back Office Workstation 
Server with 1 or more Workstations 
Configuration 

Minimum Recommended 

Hardware   

Processor 400 MHz Pentium or higher 2.7 GHz Pentium or higher 

Disk 4.5 GB SCSI Disk or Ultra IDE 
Disk 

40 GB SCSI Disk or Ultra IDE 
Disk (2 if mirroring) 

Removable Disk 3.5” 1.44 MB Removable Disk 3.5” 1.44 MB Removable Disk 

Memory 1 GB RAM 2 GB RAM 

CD ROM Required Required 

Video Display SVGA - 1024 x 768, 256 Color 
Support, 14 Inch 

SVGA - 1024 x 768, 256 Color 
Support, 17 Inch  

Tape Back Up Unit Required: XP Compatible Tape 
Drive (Minimum 4 GB) 

Required: XP Compatible Tape 
Drive (Minimum 4 GB) 

Server with 1 or more Workstations Minimum Recommended 
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Configuration 

Uninterruptable Power 
Supply 

Optional Recommended 

80 Column Printer Ink Jet or Laser Ink Jet or Laser 

Modem 28.8 KBPS, V.32 Hayes 
Compatible 

56 KBPS, V.32 Hayes Compatible 

Ethernet Card (Note:  
Recommend network card 
supporting multiple 
protocols) 

10BaseT (and equivalent Hub) 10-100 (and equivalent Hub) 

Figure 1-4: Minimum and Recommended Requirements for Server with 1 or more Back Office 
Workstations 

 

BackOffice Workstation 
BackOffice Workstation 
Configuration 

Minimum Recommended 

Hardware   

Processor 400 MHz Pentium or higher 2.7 GHz Pentium or higher 

Disk 4.5 GB SCSI Disk 40 GB SCSI Disk (2 if mirroring) 

Removable Disk 3.5” 1.44 MB Removable Disk 3.5” 1.44 MB Removable Disk 

Memory 256 MB RAM (see Note 
below) 

512 MB RAM (see Note Below) 

CD ROM Required Required 

Video Display SVGA - 1024 x 768, 256 Color 
Support, 14 Inch 

SVGA - 1024 x 768, 256 Color 
Support, 17 Inch  

Tape Back Up Unit Optional Optional 

Ethernet Card (Note:  
Recommend network card 
supporting multiple 
protocols) 

10BaseT (and equivalent 
Hub) 

10-100 (and equivalent Hub) 

Figure 1-5: Minimum and Recommended Requirements for Back Office Workstation 

Note: Memory requirements listed here are for the ScanMaster application only.  If additional 
applications are loaded, the ScanMaster memory minimum and recommended requirements need to 
increase accordingly.
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Fujitsu TeamPOS M POS Terminal 
A description of the minimum and recommended POS hardware and software 
configurations and the peripherals that are supported by the Fujitsu TeamPOS 
terminal are detailed below.   

Note: In addition to the software outlined below, it is necessary to obtain the proper 
number of workstation licenses.  Please consult the Microsoft licensing requirements 
for further details. 

POS Workstation TeamPOS 
 

Minimum Recommended 

Hardware   

Processor 400 MHz or higher  1.3 GHz or higher 

Disk 2 GB Hard Disk 40 GB Hard Disk or higher 

Memory 256 MB 512 MB 

Ethernet Adapter Ethernet 10 Base T  Ethernet 10 Base T or 10/100 

Software   

Windows Microsoft XP Embedded or 
Windows 2000 Professional, 
Service Pack 2 

Microsoft XP Embedded or 
Windows 2000 Professional, 
Service Pack 2 

OPOS Fujitsu OPOS 

Epson or Axiohm OPOS (PTR) 

 

 
Figure 1-6: Fujitsu TeamPOS 2000 M Requirements  

Support 7452 Peripherals  

Printers Scanners & Scanner/Scales 

Epson h-TM6000II –113 Symphony 9900 (Single Cable RS232) 

Epson h-TM6000II –118 SmartScan 9950 (Single Cable RS232) 

Epson h-TM6000II –123 SlimScan 1200 (RS232) 

Epson h-TM6000II –128 NCR 7835/7836/7837 Hand Scanners (RS232)  

Axiohm A760 NCR 7875 UPC Scanner & Scanner/Scale (RS232 
Magellan emulation) 

 NCR 7870 Scanner/Scale ( RS232 Magellan 
emulation) 

 NCR 7880 Scanner Scale (RS232 Magellan emulation) 
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EPD’s Customer Displays 

NCR 5944 (RS232) 

NCR 5945 (RS232) 

Verifone Omni-490 (RS232) 

Verifone Everest (RS232) 

Verifone Omni-7000 (RS232) 

 

Fujitsu  2X20  (RS232)  

Fujitsu 15” Flat Panel Display (Analog) 

Keyboards Operator Displays 

Fujitsu 92M POS Keyboard w/ or w/o 
MSR 

Fujitsu 92U POS Keyboard w or w/o MSR 

Fujitsu 15” Touch Panel Digital (TeamPOS 2000 M) 

Fujitsu 15” Panel No Touch Digital (TeamPOS 2000 M) 

Cash Drawers Coin Dispenser 

Fujitsu Full size Cash Drawer 
Fujitsu  

NCR Serial 2010 

Figure 1-7: Fujitsu TeamPOS 2000 M Supported Peripherals 

Fujitsu TeamPOS S POS Terminal 
A description of the minimum and recommended POS hardware and software 
configurations and the peripherals that are supported by the Fujitsu TeamPOS S 
terminal are detailed below.   

Note: In addition to the software outlined below, it is necessary to obtain the proper 
number of workstation licenses.  Please consult the Microsoft licensing requirements 
for further details. 

POS Workstation TeamPOS 
 

Minimum Recommended 

Hardware   

Processor 400 MHz or higher  850 MHz or higher 

Disk 2 GB Hard Disk 40 GB Hard Disk or higher 

Memory 256 MB 512 MB 

Ethernet Adapter Ethernet 10 Base T  Ethernet 10 Base T or 10/100 

Software   

Windows Microsoft XP Embedded or Windows 
2000 Professional, Service Pack 2 

Microsoft XP Embedded or Windows 
2000 Professional, Service Pack 2 

OPOS Fujitsu OPOS 

Epson or Axiohm OPOS (PTR) 

 

 
Figure 1-8: Fujitsu TeamPOS 2000 S Requirements 
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Printers Scanners & Scanner/Scales 

Epson h-TM6000II –113 Symphony 9900 (Single Cable RS232) 

Epson h-TM6000II –118 SmartScan 9950 (Single Cable RS232) 

Epson h-TM6000II –123 SlimScan 1200 (RS232) 

Epson h-TM6000II –128 NCR 7835/7836/7837 Hand Scanners (RS232)  

Axiohm A760 NCR 7875 UPC Scanner & Scanner/Scale (RS232 
Magellan emulation) 

 NCR 7870 Scanner/Scale ( RS232 Magellan 
emulation) 

 NCR 7880 Scanner Scale (RS232 Magellan emulation) 

EPD’s Customer Displays 

NCR 5944 (RS232) 

NCR 5945 (RS232) 

Verifone Omni-490 (RS232) 

Verifone Everest (RS232) 

Verifone Omni-7000 (RS232) 

 

Fujitsu 15” Flat Panel Display (Analog) 

Keyboards Operator Displays 

Fujitsu 92M POS Keyboard w/ or w/o 
MSR 

Fujitsu 92U POS Keyboard w or w/o MSR 

Fujitsu 15” Touch Panel Analog  

Fujitsu 15” Panel No Touch Analog  

Cash Drawers Coin Dispenser 

Fujitsu Full size Cash Drawer 

Fujitsu  

NCR Serial 2010 

Figure 1-9: Fujitsu TeamPOS 2000 S Supported Peripherals 
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ScanMaster System Software 
ID Description Integration Requirement Configuration Notes and 

Workarounds 
 Windows XP 

Professional SP2 

Windows 2000 Server, 
SP2 

Windows 2003 Server 

Required Operating 
System for the 
ScanMaster Server 

Please consult the 
Microsoft XP/2000 Server 
licensing requirements for 
details 

 Windows XP 
Professional SP2 

Windows 2000 
Professional, SP2 

Windows XP 
Professional 

Required Operating 
System for the 
ScanMaster Back 
Office Workstation 

Please consult the 
Microsoft XP/2000 Server 
licensing requirements for 
details 

 Windows XP 
Embedded 

or 

Windows 2000 
Professional, SP2 

Required for each 
POS terminal 

Typically is pre-loaded in 
each NCR POS terminal 

 Pervasive SQL Version 
8 Server Edition 

Server version 
required for server  

Note:  Not StoreNext 
sourced. May be obtained 
through Pervasive 
distributors (800) 287-4383 
or Retalix.  

Please consult this guide 
for installation 
instructions. 

 Pervasive SQL Version 
8 Workstation Edition 

Required for each 
back office 
workstation and POS 
terminal. 

Note:  Not StoreNext 
sourced. May be obtained 
through Pervasive 
distributors (800) 287-4383 
or Retalix.  

Please consult this guide 
for installation 
instructions. 

Figure 1-10: ScanMaster System Software 

ScanMaster Application Software 
Description Package 

Dependencies 
Configuration Notes and Workarounds 
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ScanMaster 
2.05.01 Base 
Application 

None This package contains the ScanMaster application 
software, which provides basic POS checkout 
functionality.  It includes the necessary software for the 
POS and back office workstations as well as the server 
applications.  It provides the user with such functionality 
as POS sales functions and processing, store accounting, 
sales reporting, and administrative functions such as file 
maintenance.   This software is licensed on a per server 
basis. 

ScanMaster 
2.05.01 POS 
Workstation 
License 

Base Application Included in this package is the standard sales application 
software which resides in the TeamPOS 2000 
workstations and is licensed on a per POS workstation 
basis.   Note that it is necessary that this package be 
licensed for each POS workstation in use. 

ScanMaster 2.05 
Back Office 
Workstation 
License 

Requires: 

Base Application 

This package contains the necessary software to enable 
the use of back office clients, which reside on processors 
other than the ScanMaster server. This software is 
licensed on a per back office workstation basis.   

ScanMaster 2.05 
Electronic Journal 
Package 

Requires: 

Base Application  
and either Sales 
Application for 
the POS 
Workstation 

This software package provides the user with complete 
electronic journal functions.  It includes the necessary 
software for the POS and back office workstations as well 
as the server.  It eliminates the need for a paper journal to 
be used on each of the POS terminals by capturing this 
information electronically.  In addition, it provides the 
user with the ability to do electronic searches and 
inquires as well as file management functions. This 
software is licensed on a per POS workstation basis. 

ScanMaster 2.05 
Electronic Coupon 
Package 

Requires: 

Base Application  

  

This software package provides the user with ability to 
link UPC’s or PLU’s to either manufacturer or store 
coupons.  These coupons, which can be controlled by 
date and time, can reduce the price of an item (by a 
percentage or fixed amount) as well as issue frequent 
buyer points (regular or bonus.)  Additionally, it provides 
the user the ability to create, edit and report upon 
coupons.  This software is licensed on a per server basis. 

ScanMaster 2.05 
SIL Hostlink 
Package 

Requires: 

Base Application 

 

This software package provides the ability for the store 
system to communicate to a host processing system via 
the Standard Interchange Language (SIL.)  This software 
is licensed on a per server basis. 
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Description Package 

Dependencies 
Configuration Notes and Workarounds 

ScanMaster 2.05 
FM Terminal 
Support Package 

Requires: 

Base Application 

 

This software package provides the necessary interfaces 
into the following FM terminals to support both direct 
and batch mode maintenance for the PLU file: 

• Telxon 912 terminals 

• Telxon 960 terminals 

• Symbol 6140 terminals 

• Symbol 6842 terminals 

• Symbol 6846 terminals 

Note that this package does not include the FM terminals 
nor the application, which resides in them.  This must be 
obtained from the vendor or dealer selling the FM 
terminal.  This software is licensed on a per server basis. 

 

ScanMaster 2.05 
RDS Shelf Label 
Interface 

Requires: 

Base Application 

 

This software package enables the RDS Shelf Label 
software to be interfaced into ScanMaster. Note that it 
does not include the RDS Shelf Label software itself, 
which must be obtained from an authorized supplier of 
this software. This software is licensed on a per server 
basis. 

 

ScanMaster 2.05 
EFT Interface 

Requires: 

Base Application 

 

This software package provides ScanMaster interfaces 
with the following EFT providers or networks: 

 

Concord 

Plourde 

EPS 

Hypercom (Microtrax) 

MPS 

Lynk 

 

Note that it does not include the EFT network hardware 
nor the authorization software itself, which must be 
obtained from an authorized supplier.   The individual 
EFT suppliers should be contacted directly to obtain 
additional information relative to the switches supported 
and installation details.  This software is licensed on a per 
server basis. 
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Description Package 

Dependencies 
Configuration Notes and Workarounds 

ScanMaster 2.05 
S&H Green Points 
Software Interface 
(formerly 
xiNETix) 

Requires: 

Base Application 

 

This software package provides the necessary software to 
interface the S&H Green Points software into ScanMaster.  
Note that it does not include the S&H Green Points 
software itself, which must be obtained from an 
authorized supplier of this software. This software is 
licensed on a per server basis. 

Figure 1-11: ScanMaster Application Software 

Customer Information Products 
Description How to Obtain 

ScanMaster USER GUIDE 
Release 2.05 

Publication is included on CD with new ScanMaster software 
orders.  

 

ScanMaster Installing and 
Supporting Release 2.05 

Publication is included on CD with new ScanMaster software 
orders.  

 
Figure 1-12: Customer Information Products 
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Site Preparation 

Before Installation 
Careful planning assures successful installation of hardware and software 
components required for ScanMaster.  The following factors require investigation and 
study before installation. 

Site Wiring 
Familiarize yourself with the layout of existing site wiring to aid in installing network 
cable and other wiring. 

• Grounding requirements.  Check the following items to ensure the integrity of 
the power grounding: 

• The ground wire must be an insulated wire, not a conduit. 

• Do NOT use the ground conductor as a return or neutral conductor for any 
equipment. 

• Receptacle requirements.   

• All receptacles for the system must be 2-pole, 3-wire; 15 or 20 amperes. 

• The ground terminal must be insulated from the mounting hardware. 

• For 115 Volts AC, use Hubbell receptacle #IG5262 (15A) or #IG5362 (20 A). 

• No other device should be connected to these receptacles. 
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Equipment location 
Compare the dimensions of the equipment when in use to the available free space.  
You may require the services of qualified electricians and maintenance personnel to 
assure successful installation. 

• Communications hubs, also called concentrators 

• Server 

• Back office PCs 

• Check stands for all lanes.  Contact the vendor for specifications and installation 
requirements. 

• Point-of-Sale (POS) Workstations (Registers) 

• Location of all necessary communications cables, jacks, and connectors. 

• Location of power boxes, grounds, conduits, and lightening protection devices. 

• Location of existing equipment which may interfere with the operation of 
scanning equipment and software 

Particular caution should be exercised when preparing installations around 
equipment producing electrical noise and heat, which present the potential for 
electrical interference. 

• Familiarity with all existing regulations, codes and laws pertaining, but not 
limited to, electrical and power installation, safety and health considerations 

Network Interconnection 
Before ScanMaster software can be installed, the server, Back Office PC, and every 
POS workstation must be interconnected to the network. 

The following requirements must be met in order to make network interconnection 
possible: 

• An Ethernet card must be installed on each computer associated with the network, 
including the POS workstation, the server, and the Back Office PC. 

• A twisted-pair interface cable must be provided for each computer associated 
with the network.  The untwisted, flat cable commonly known as "silver satin" is 
NOT acceptable.  Its use can cause false data collisions on the network 

The Ethernet Card 
(for File Server and Back Office PC) 
The Ethernet card includes the following components, which are visible at the rear of 
the computer when the card is installed: 

• BNC connector 

• AUI port 
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• RJ-45 port 

• Link status LED indicator 

The RJ-45 port is the preferred port for network interconnection.  

When used with twisted-pair cable, the Ethernet card must always connect to a hub 
(concentrator).  This results in a star-wired network, with the hub at the center of the 
star. 

The Ethernet card is compatible with 10 BaseT hubs from Intel and SMC.  The 
Ethernet card also is compatible with the NCR “StarLAN 10” twisted-pair signaling 
method, when the reference disk is used to produce the configuration. 

An Ethernet card should already be installed on your PC. If for some reason an 
Ethernet card is not installed, install the Ethernet card and insert the setup disk. 

Note: The Ethernet card must be installed before you can load the Windows NT 
software and ScanMaster. 

Twisted-Pair Interface Cable 
Twisted-pair interface cable has an eight-pin modular plug at each end that mate with 
RJ-45 ports. 

NOTE: The untwisted, flat cable commonly known as "silver satin" is NOT 
acceptable.  Its use can cause false data collisions on the network. 

Requirements of Unshielded Twisted Pair Cable 
Below are the requirements for twisted-pair cabling.  This information pertains to the 
Ethernet PLUS Elite 10T/A adapter. 

• Unshielded, twisted-wire pairs (2 pairs) 

• 22, 24, or 26 gauge 

• Characteristic impedance of 85 to 110 ohms at 10 MHz 

• Maximum attenuation of 11.5 dB/100 meters at 10 MHz 

• Maximum attenuation of 7.2 dB/100 meters at 5 MHz 

• RJ-45 modular plugs:  Molex 90075-0037, or equivalent 

• Crimper Tool: Molex 11-01-0026 or equivalent RJ-45 Modular wall socket: Molex 
95015-0003, or equivalent. 



1-16 Chapter 1: Introduction to ScanMaster 2.05.01 

 

NCR D-Inside Wire (DIW and PDS) 

4-Pair/Non-Plenum DIW 4/24 W1000 

4-Pair/Plenum C-Plenum 4 R1000 

25-Pair/Non-Plenum DIW 25/24 R1000 

25-Pair/Plenum C-Plenum 25 R1000 

IBM Type 3 

6-Pair Twisted Belden-9566 

2-Pair Twisted Belden-9562 

4-Pair Twisted Belden-1583A (cat.5) 
Figure 1-17: Various Unshielded Twisted Pair Cables 

Hubs (Concentrators) 
Hubs must conform to IEEE 802.3 10 BaseT specifications. 

Network Characteristics 
The table below describes the characteristics required for the unshielded twisted-pair 
network: 

Standard IEEE 802.3 10 BaseT 

Data Rate 10 MBps 

Maximum length of connecting cable 
between a computer and concentrator 

100m 

Maximum number of computers 
(nodes per network) 

1024 

UTP Cable Type NCR D-inside wire (DIW and PDS)  

IBM Type 3 
Figure 1-18: Unshielded Twisted-Pair Network Characteristics 

 
Adding Computers to the Network 
1. Make sure an Ethernet card is installed into each computer intended for network 

interconnection. 

2. Insert the modular plug at the end of the twisted-pair interface cable into the RJ-45 
port at the rear of the computer. 

3. Attach the other end of the interface cable to the RJ-45 port of a 10 BaseT-
compatible hub. 

4. After connecting the computer to the hub, power on both the computer and the 
hub. 



  Chapter 1: Introduction to ScanMaster 2.05.01 1-17 

5. Verify the connection by observing the green link (LNK) status LED indicators on 
the hub and at the rear of the computer.  

If the computer and hub are powered on and a valid connection exists, the link status 
LED indicators light up.  (If the AUI port is in use, the link status LED indicators do 
not light up.) 

If the AUI port is not in use and the indicators do not light up after following the 
above steps, check the modular plug connections and all associated wiring.





Chapter 2: 2.05.01-050 Upgrade and Installation 
Procedures 

 ScanMaster Upgrade and Installation Overview Procedures 
The procedures for this chapter outline full installation and upgrade instructions for 
ScanMaster version 2.05.01. This release supports the upgrade from ScanMaster 
versions 1.02.00, 1.02.01, 1.02.02, 1.02.03, 2.00.01, 2.00.02, 2.00.03, 2.01.00, 2.01.02, 
2.02.00, 2.03.00, 2.03.01, 2.04.01, 2.04.02 and 2.05.00. 

 

Important Notes: 

1.    New to this release – ScanMaster security is now implemented by a hardware 
key called a HASP. The HASP module needs installed to the ScanMaster Server’s 
parallel port or to a USB port on the Server depending on the HASP model. The 
HASP module must be installed for ScanMaster software to run! There is no longer 
a grace period for securing the system. DO NOT perform an upgrade until a 
properly programmed HASP is available, and installed into the ScanMaster server. 

1. In this release - Support for Windows 2003 Server Standard Edition and 
Windows XP SP2 for Back Office PC’s.  The ScanMaster Server should be setup 
as a Standard Server, not a Primary Domain Controller. 

2. In this release - Due to Windows 2003 Server requirements that no blank 
passwords are permitted, the ScanMaster Installation will create the following 
User Names and Passwords: 

Back Office Workstations – Workstation User Names of “WRKSTN100” to 
“WRKSTN120” with Passwords of “BO100” through “BO120”, respectively.  

PoS Workstations – Workstation User Names of “WRKSTN01” to 
“WRKSTN99” with Passwords of “POS01” through “POS99”, respectively.  

(A “LOCALSM” user for Server login and “REMOTESM” user for remote 
support are also created.)  All Users will be assigned to the Administrator’s 
Group.  For an initial installation, the installer should always be logged on as 
the Administrator.  In addition, the Administrator on all PC’s and PoS 
workstations accessing the ScanMaster Server should be set up with the same 
password.   If the store system is to be part of a WAN then the IT installer will 
need to adjust the ScanMaster users’ security according to the WAN’s 
requirements.  This needs to be done AFTER the installation is complete.  The 
ScanMaster users’ net permissions and file and folder permissions (on NTFS) 
will need granted full control on all folders created by the install. 

3. Do not attempt to install or upgrade to ScanMaster 2.05.01 unless at least 5 GB 
of hard drive space is available. 
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4. See previous chapter for supportable hardware configurations. 

5. This release does not support the upgrade from ScanMaster 1.1.6.  If an upgrade 
from 1.1.6 is desired, the system must first be upgraded from 1.1.6 to 2.00.00 (or 
1.02.00), then to 2.05.01. 

6. Beginning with ScanMaster 2.01.00, the Windows 98 operating system will no 
longer be supported, and beginning with ScanMaster 2.., the Windows NT4 
operating system will no longer be supported. 
 
Only Windows 2000 Professional or Windows XPe(Embedded) is supported on 
the PoS terminals. Windows 2003 Server, Windows 2000 Server, Windows 2000 
Pro (for small store) and XP Professional (for Express or Expresso) are supported 
on the ScanMaster Servers and Windows 2000 Professional and Windows XP 
Professional are supported on the BackOffice Workstations. 

7. The 2.05.01 release and above also requires Pervasive V8.6 (or newer) server and 
workstation software as the database manager.  

8. IMPORTANT UPGRADE NOTE: If upgrading ScanMaster at a 24-hour site, 
upgrade all PoS workstations prior to upgrading the Server and any backoffice 
workstations.  After each PoS workstation is upgraded it will run in “Offline 
mode” until the server has been upgraded. After upgrading the PoS 
Workstations, upgrade the Server and then the BackOffice Workstations. 

9. Automatic Updates are not recommended because they require rebooting the 
computer (and will continually prompt for a reboot until it has been 
performed).  It is recommended to manually install security updates only from 
the Windows Update Web Site at a store-convenient time when the computer 
can be rebooted. (See page 43 for more information). 
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Server Setup 
This section describes the setup of a ScanMaster Server, including: 

• Installing the operating system 

• All necessary prerequisite components of ScanMaster 

• Installing or upgrading ScanMaster 2.05.01 

• Installing the PoS workstation installation on the server (for later network 
installation of the PoS workstations). 

Prerequisites 
Before starting the install/upgrade ensure you have: 

• Operating System Installation CDs with “Product Key” from Microsoft if 
system is not preloaded. 

• Pervasive v8.x\v9.x Server Engine Installation CD  

• ScanMaster 2.05.01 Installation CD 

• At least 5GB available hard drive space on the server, after the Operating 
system has been installed. 

• If upgrading, a complete data backup of the system. 

• If upgrading a 24-hour site, upgrade all PoS workstations prior to upgrading 
the Server and any Back Office Workstations. 
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Operating System Installation for the Server 
This section details the steps necessary to install the operating system on the 
ScanMaster server.  Supported operating systems are: 

• Windows 2003 Server 

• Windows 2000 Server  

• Windows XP Professional (Express and Espresso Configurations) 

• Windows 2000 Professional (Small Store Configuration) 

Windows 2003 Server 
Servers can be purchased with Windows 2003 Server pre-installed. If Windows 2003 
Server is pre-installed on your server, continue to the section Configuring Your Server 
(page 7).  

Installing Windows 2003 Server 
1. Boot your server from the CD-ROM drive with the Windows 2003 Server CD in 

the drive. 

The Windows Setup program initializes and the Welcome to Setup screen displays. 

2. Press Enter to continue. 

The Windows 2003 Server Licensing Agreement screen displays. 

3. (Optional) Press Page Down and read the License. 

4. Press F8 to accept the licensing agreement. 

The Windows 2003 Server Setup screen displays. If you have an existing partition, 
you will delete it using the instructions below. If you do not have a partition, skip to 
step #13. 

5. Press D to delete the selected partition. 

6. Press Enter to continue. 

7. Press L to delete the partition. 

8. Press C to create a partition in the unpartitioned space. 

9. Take the default maximum partition size and press Enter to continue. 

10. Press Enter to Install. 

11. Select NTFS and press Enter. 

The formatting may take several minutes. When the formatting is complete, you will 
be prompted to remove the diskette (if you booted from a floppy disk). 

12. If booting from a floppy drive, remove the diskette and press Enter. 

The system reboots.  When finished, the Regional Setting window displays. 
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13. Click Next to continue. 

The Personalize your Software window displays.  

14. Type your Name and Organization in the fields provided and click Next. 

The Product key screen appears. 

15. Type in the Product Key and click Next. 

The Licensing Modes screen appears. 

16. Input the number of licenses and click Next. 

The Computer Name and Administrator Password windows display. 

17. Type SERVER in the computer name field. 

18. Type an administrator password and confirm that password. 

Note: The password cannot be blank and must be at least 6-characters in length.  (It 
may be a combination of letters and numbers) 

19. Click Next. 

The Windows 2003 Server Components window displays. 

20. Accept the default and click Next to continue. 

The Date and Time Settings window displays. 

21. Set the correct date, time, and time zone and click Next. 

The system reboots. 

22. Login as the Administrator. 

After additional file loading, the “Manage Your Server” window displays.   

23. Click the “Don’t Display This Page at Login” checkbox (lower left-hand portion of 
the screen) and close the window.  
 

Note: If you need to install any hardware drivers follow the installation steps to 
install these drivers at this time.  Consult your network administrator before 
assigning or changing any TCP/IP settings. 

Note: Do not select any configuration that may make the server a Domain Controller. 

Note: If you are prompted to install the Service Pack CD (which is already included 
on the some Windows 2003 Server CDs) keep the CD in the drive and acknowledge 
the message to continue. 

24. When the program finishes the installation process, remove the CD-ROM from the 
CD-ROM and click Finish. 

Configuring your Server 
1. If not logged on, press CTRL + Alt + Delete to log on. 
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2. Type your Administrator name and Password in the fields provided and click OK. 

3. Select Start. 

4. Right-click on My Computer and select Properties from the pop-up menu. 

5. Click the Computer Name Tab. 

6. Click the Change button. 

7. Confirm the “Workgroup” radio button is selected and enter the name of STORE 
for you workgroup, and click OK. 

The welcome to the STORE workgroup window displays. 

8. Click OK. 

You are prompted to reboot the computer. 

9. Click OK. 

10. Click OK. 

11. Click Yes to restart your computer. 

Changing Display Settings on the Windows 2003 Server 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

2. Click the Settings tab. 

3. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

4. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

5. Click OK. 

 

Windows 2000 Server 
Servers can be purchased with Windows 2000 Server pre-installed. If Windows 2000 
Server is pre-installed on your server, continue to the section Configuring your Server 
(Page 11).  

Note: If the Server’s BIOS supports a bootable CD, installation can be run from the 
CD (if the BIOS is set to check the CD-ROM drive prior to looking at the Hard Drive 
for the operating system.  Most servers manufactured after 1997 have this BIOS 
option.)  If you boot from a CD-ROM drive, skip to step 6 of Installing Windows 2000 
Server below.  Be sure to set your BIOS’s boot sequences back to their original settings 
after  the install.   
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Create Boot Disks 
You will need to create boot disks if you server does not have the capability to boot 
from the server. Follow the directions below to create the boot disks.  

1. Insert the Microsoft Windows 2000 Server CD-ROM into the CD-ROM drive. 

2. From a command (C:\) prompt, type X: (where X is the drive letter for your CD-
ROM drive) and press Enter. 

3. Type CD BOOTDISK and press Enter to change to the bootdisk folder. 

4. Type MAKEBOOT and press Enter to launch the executable that will make your 
boot disks. 

5. When prompted, specify the floppy drive to which you will copy the images. 

6. Label a diskette Windows 2000 Server Setup Disk #1 and insert the diskette into 
the floppy drive. 

7. Click Enter to continue. 

8. When prompted insert diskettes #2, #3, and #4. Remember to label each diskette. 

Installing Windows 2000 Server 
1. Turn off the Server and insert Windows 2000 Server Setup Disk #1 into the floppy 

drive. 

2. Power the Server on. 

The Windows 2000 Server Setup window displays. 

3. When prompted, insert Windows 2000 Server Setup Disk #2 and press Enter. 

4. When prompted, insert Windows 2000 Server Setup Disk #3 and press Enter. 

5. When prompted, insert Windows 2000 Server Setup Disk #4 and press Enter. 

The Welcome to Setup screen displays. 

6. Press Enter to continue. 

7. Insert the Windows 2000 Server CD-ROM and press Enter. 

The Windows 2000 Server Licensing Agreement screen displays. 

8. Press Page Down and read the License. 

9. Press F8 to accept the licensing agreement. 

The Windows 2000 Server Setup screen displays. If you have an existing partition, 
you will delete it using the instructions below. If you do not have a partition, skip to 
step #14. 

10. Press ESC to not repair the previous installation. 

11. Press D to delete the selected partition. 

12. Press Enter to continue. 

13. Press L to delete the partition. 
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14. Highlight the unpartitioned space and press C to create a partition in that space. 

15. Take the default maximum partition size and press Enter to continue. 

16. Highlight the new partition and press Enter to Install. 

17. Select NTFS and press Enter. 

The formatting may take several minutes. When the formatting is complete, you will 
be prompted to remove the diskette. 

18. Remove any diskette in the floppy drive and press Enter. 

The system reboots.  When finished, the Regional Setting window displays. 

19. Click Next to continue. 

The Personalize your Software window displays.  

20. Type your Name and Organization in the fields provided and click Next. 

The Product key screen appears. 

21. Type in the Product Key and click Next. 

The Licensing Modes screen appears. 

22. Input the number of licenses and click Next. 

The Computer Name and Administrator Password windows display. 

23. Type SERVER in the computer name field. 

24. Type an administrator password and confirm that password. 

25. Click Next. 

The Windows 2000 Server Components window displays. 

26. Ensure the IIS (Internet Information Service) component is unchecked and click 
Next to continue. 

The Date and Time Settings window displays. 

27. Set the correct date, time, and time zone and click Next. 

Additional file loading continues. 

28. When the program finishes the installation process, remove the CD-ROM from the 
CD-ROM and click Finish. 

29. Login as the Administrator. 

30. Click the “I will configure this server later” radio button and click Next. 

31. Close the Windows 2000 Server Configure Your Server window. 

Note: If you need to install any hardware drivers follow the installation steps to 
install these drivers at this time.  Consult your network administrator before 
assigning or changing any TCP/IP settings. 

Note: Do not select any configuration that may make the server a Domain Controller. 
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Note: If you are prompted to install the Service Pack CD (which is already included 
on some Windows 2000 Server CDs) keep the CD in the drive and acknowledge the 
message to continue. 

Configuring your Server 
1. If not logged on, press CTRL + Alt + Delete to log on. 

2. Type your Administrator name and Password in the fields provided and click OK. 

3. Upon reboot uncheck the “Show this screen at startup” checkbox and exit the 
Getting Started screen. 

4. Right-click on My Computer and select Properties from the pop-up menu. 

5. Click the Network Identification Tab. 

6. Click the Properties button. 

7. Confirm the “Workgroup” radio button is selected and enter the name of STORE 
for your workgroup, and click OK. 

The welcome to the STORE workgroup window displays. 

8. Click OK. 

You are prompted to reboot the computer. 

9. Click OK. 

10. Click OK. 

11. Click Yes to restart your computer. 

Changing Display Settings on the Windows 2000 Server 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

2. Click the Settings tab. 

3. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

4. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

5. Click OK. 

Sharing the Server CD-ROM Drive (Windows 2000 Server) 
To install the various components of this release, you will need to share the CD-ROM 
drive on the server with the registers. 

1. Click from the Windows taskbar Start → Programs → Accessories → Windows 
Explorer. 
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2. Click My Computer. 

3. Right-click on the CD-ROM drive. 

4. Select Sharing from the pop-up menu. 

5. Click on the Share this Folder radio button. 

6. In the Shared Name field type CD_ROM. 

7. Click Permissions and then select Everyone.  Ensure everyone has Full Control 
selected.  Click OK. 

8. Click OK to complete the operation. 

Setting TCP/IP as the Network Protocol on the Server (Windows 2000 Server) 
Note: If you find that TCP/IP has already been installed, click Cancel after Step 3 
and exit the install procedure. 

1. From the Microsoft Windows taskbar, select Start → Settings → Control Panel. 

The Control Panel window displays. 

2. Double-click on the Network and Dial Up Connections icon. 

3. Right-click on Local Area Connection and select Properties from the pop-up 
menu. 

4. Look for the “Internet Protocol (TCP/IP)” and ensure it is checked (by clicking the 
box).   

5. Click OK. 

The restart window may appear. 

6. Click Yes to restart the server (if prompted). 

7. If the server is restarted, log on to the server as Administrator. 

 

Windows XP Professional  (Acer OEM Version) 
This section describes configuring the OEM version of Windows XP Professional 
preloaded on the Acer models V5600GT, and V7600GT PCs.    

Note: Do not use this section if you are installing a new copy of Windows XP 
Professional on the PC.  Instead use the section after this titled “Windows XP 
Professional” on page 16. 

The first time the Acer is powered on, the “Welcome to Microsoft Windows” screen 
displays. 

1. Click Next. 

The Select Your System Settings screen displays. The default selections are for United 
States, English (United States) Language, and US for the keyboard. 
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2. Click Next. 

The End User License Agreement screen displays. 

3. Select the “Yes, I accept…” radio-button, and click Next. 

The “What’s your computer’s name?” screen displays. 

4. Type SERVER in the computer name field. 

5. Click Next. 

The “What’s your Administrator password?” screen displays. 

6. Type an administrator password and confirm that password. 

Note: It is recommended the password not be blank and be at least 6-characters in 
length.  (It may be any combination of letters and numbers) 

7. Click Next. 

The “Is this computer in a domain?” screen appears. 

8. Select “No, don’t make this computer part of the domain” radio-button, and then 
click Next. 

The system checks for Internet connectivity, and then displays the “Will this computer 
connect to the Internet…”screen. 

9. Select the appropriate radio-button response, and click Next. 

The “Ready to register with Microsoft?” screen appears. 

10. Select “Yes…” radio-button response, and click Next. 

The “Collecting Registration Information” screen appears. 

11. Enter appropriate information and then click Next. 

The “Who will use this computer?” screen appears.  

12. At least one user name must be entered.  Enter Local in the “Your name” field 
and click Next. 

The “Thank You!” screen displays. 

13. Click Finish. 

14. Login as the Administrator. 

15. Turn off the Welcome screen by clicking Start → Control Panel→ User 
Accounts→ Change the way users log on or off. 

16. Unselect “Use the Welcome Screen” and click Apply Options. 

17. Close the User Accounts and Control Panel window.  

Note: Install any Windows XP Professional Service Packs (Start→All 
Programs→Windows Update if connected to the Internet) that are available for your 
release level. 
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Configuring your Server 
1. If not logged on, press CTRL + Alt + Delete to log on. 

2. Type your Administrator name and Password in the fields provided and click OK. 

3. Select Start. 

4. Right-click on My Computer and select Properties from the pop-up menu. 

5. Click the Computer Name Tab. 

6. Click the Change button. 

7. Confirm the “Workgroup” radio button is selected and enter the name of STORE 
for you workgroup, and click OK. 

The welcome to the STORE workgroup window displays. 

8. Click OK. 

You are prompted to reboot the computer. 

9. Click OK. 

10. Click OK. 

11. Click Yes to restart your computer. 

Changing Display Settings on the Windows XP Professional server 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

2. Click the Settings tab. 

3. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

4. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

5. Click Apply. 

6. Click the Appearance tab. 

7. In the “Windows and Buttons” drop down box, select Windows Classic Style. 

8. Click OK. 

9. Right-click the Start button. 

10. Choose Properties from the pop-up menu. 

11. Select the “Classic Start Menu” radio-button. 

12. Click OK. 
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Configuring the Firewall, Automatic Update and Virus Protection Options  (XP 
Service Pack 2 and greater) 
1. Click Start→Control Panel→Security Center. 

2. In the Resources section (on the left), click “Change the way Security Center alerts 
me”. 

3. Uncheck all three Alert Setting options. 

4. Click OK. 

5. On the bottom, click Windows Firewall (under “Manage security settings for”). 

6. Click “Off”. 

7. Click OK. 

8. On the bottom, click Automatic Updates (under “Manage security settings for”). 

9. Click “Turn off Automatic Updates”. 

10. Click OK. 

11. Close the Security Center and Control Panel windows. 

12. Double-click the Norton AntiVirus icon located in the system tray (to the left of 
the time). 

The Norton AntiVirus window displays 

13. Click the Options button at the top of the window. 

The Norton AntiVirus Options window displays 

14. Deselect the “Enable Auto-Protect…” checkbox. 

15. Click Script Blocking from the menu on the top left. 

16. Deselect the “Enable Script Blocking” checkbox. 

17. Click OK. 

18. Close all open windows. 

Disabling Windows Messenger (Optional) 
Note: Before attempting to disable Windows Messenger, close all open windows. 

1. Double-click the Windows Messenger icon in the system tray, to the left of the 
time. 

The Windows Messenger window appears. 

2. On the Windows Messenger menu bar, select Tools, and the select Options from 
the pop-up menu. 

The Options window appears. 

3. Click the Preferences tab. 
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4. Deselect the “Run this program when Windows starts.”checkbox, and then click 
OK. 

5. Close the Windows Messenger window. 

6. Click the Windows Messenger icon in the system tray, to the left of the time. 

7. Select Exit from the pop-up menu. 

8. Click OK. 

 

Windows XP Professional 
Follow the directions below to install Windows XP Professional on the ScanMaster 
server PC.  

Note: Do not use this section if you are using the preloaded OEM version of 
Windows XP Professional on the Acer models V5600GT and V7600GT PCs, instead 
use the previous section titled “Windows XP Professional (Acer OEM Version)” on 
page 12. 

Change the Boot Sequence 
1. Boot the computer, enter the computer’s CMOS Setup Utility and change the Bios 

settings to boot from the CD-ROM drive. 

2. Insert the Microsoft Windows XP Professional CD-ROM into the CD-ROM drive 
and reboot. 

The Windows XP Professional Setup screen displays and after a few minutes of 
loading files. 

3. Press Enter to setup Windows XP Professional now. 

The Windows XP Professional Licensing Agreement screen displays. 

4. Press Page Down and read the License. 

5. Press F8 to accept the licensing agreement. 
 
The Windows XP Professional Setup screen displays. If you have an existing partition, 
you will delete it using the instructions below. If you do not have a partition, skip to step 
#12. 

6. Press ESC to install a fresh copy of Windows XP Professional. 

7. Locate and press D to delete the desired partition. 

8. Press Enter to continue. 

9. Press L to delete the partition. 

10. Repeat steps 7 through 9 for any additional partitions. 
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11. Locate the un-partitioned space to load Windows XP Professional and press C to 
create a partition in that space. 

12. Accept the default drive size and press Enter to continue. 

13. Select the new partition to install Windows XP Professional and press Enter to 
continue. 

14. Ensure “Format the partition using the NTFS file system” is highlighted and press 
Enter.  
 
The formatting and loading will take several minutes. When formatting and loading is 
complete, the system will reboot automatically.  Additional file loading will continue.  This 
may take several minutes.  When finished, the Regional Setting window displays.  

15. Click Next to continue. 
 
The Personalize your Software window displays. 

16. Type your Name and Organization in the fields provided and click Next. 

The Product Key Window displays. 

17. Enter the product key from the back of the CD Case. 

The Computer Name and Administrator Password windows display. 

18. Type SERVER (or the name provided by your IT department) in the computer 
name field. 

19. Type in an administrator password and confirm that password. 

20. Click Next. 

The Date and Time Settings window displays. 

21. Set the correct date, time, and time zone and click Next. 

After additional file loading, the system reboots. The Display Settings adjustment 
window then displays.  

22. Click OK. 

The Welcome to Microsoft Windows displays.  

23. Click Next. 

The “Who will use this computer?” screen appears.  

24. At least one user name must be entered.  Enter Local in the “Your name” field 
and click Next. 

The “Thank You!” screen displays. 

25. Click Finish. 

26. Login as the Administrator. 

27. Turn off the Welcome screen by clicking Start → Control Panel→ User 
Accounts→ Change the way users log on or off. 

28. Unselect “Use the Welcome Screen” and click Apply Options. 
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29. Close the User Accounts and Control Panel window. 

Note: If you need to install any hardware drivers follow the installation steps to 
install these drivers at this time.  Consult your network administrator before 
assigning or changing any TCP/IP settings. 

Note: Do not select any configuration that may make the server a Domain Controller. 

Note: Install any Windows XP Professional Service Packs (Start→All 
Programs→Windows Update if connected to the Internet) that are available for your 
release level. 

Configuring your Server 
1. If not logged on, press CTRL + Alt + Delete to log on. 

2. Type your Administrator name and Password in the fields provided and click OK. 

3. Select Start. 

4. Right-click on My Computer and select Properties from the pop-up menu. 

5. Click the Computer Name Tab. 

6. Click the Change button. 

7. Confirm the “Workgroup” radio button is selected and enter the name of STORE 
for your workgroup, and click OK. 

The welcome to the STORE workgroup window displays. 

8. Click OK. 

You are prompted to reboot the computer. 

9. Click OK. 

10. Click OK. 

11. Click Yes to restart your computer. 

Changing Display Settings on the Windows XP Professional server 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

2. Click the Settings tab. 

3. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

4. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

5. Click Apply. 

6. Click the Appearance tab. 
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7. In the “Windows and Buttons” drop down box, select Windows Classic Style. 

8. Click OK. 

9. Right-click the Start button. 

10. Choose Properties from the pop-up menu. 

11. Select the “Classic Start Menu” radio-button. 

12. Click OK. 

Configuring the Firewall, Automatic Update and Virus Protection Options  (XP 
Service Pack 2 and greater) 
1. Click Start→Control Panel→Security Center. 

2. In the Resources section (on the left), click “Change the way Security Center alerts 
me”. 

3. Uncheck all three Alert Setting options. 

4. Click OK. 

5. On the bottom, click Windows Firewall (under “Manage security settings for”). 

6. Click “Off”. 

7. Click OK. 

8. On the bottom, click Automatic Updates (under “Manage security settings for”). 

9. Click “Turn off Automatic Updates”. 

10. Click OK. 

11. Close the Security Center and Control Panel windows. 

Disabling Windows Messenger 
Note: Before attempting to disable Windows Messenger, close all open windows. 

1. Double-click the Windows Messenger icon in the system tray, to the left of the 
time. 

The Windows Messenger window appears. 

2. On the Windows Messenger menu bar, select Tools, and the select Options from 
the pop-up menu. 

The Options window appears. 

3. Click the Preferences tab. 

4. Deselect the “Run this program when Windows starts.”checkbox, and then click 
OK. 

5. Close the Windows Messenger window. 

6. Click the Windows Messenger icon in the system tray, to the left of the time. 
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7. Select Exit from the pop-up menu. 

8. Click OK. 

Windows 2000 Professional 
Note: If the Server’s BIOS supports a bootable CD, installation can be run from the 
CD (if the BIOS is set to check the CD-ROM drive prior to looking at the Hard Drive 
for the operating system.  Most servers manufactured after 1997 have this BIOS 
option.)  If you boot from a CD-ROM drive, skip to step 6 of Installing Windows 2000 
Professional below.  Be sure to set your BIOS’s boot sequences back to their original 
settings after the install.   

Create Boot Disks 
You will need to create boot disks if you server does not have the capability to boot 
from the server. Follow the directions below to create the boot disks.  

1. Insert the Microsoft Windows 2000 Professional CD-ROM into the CD-ROM 
drive. 

2. From a command (C:\) prompt, type X: (where X is the drive letter for your CD-
ROM drive) and press Enter. 

3. Type CD BOOTDISK and press Enter to change to the bootdisk folder. 

4. Type MAKEBOOT and press Enter to launch the executable that will make your 
boot disks. 

5. When prompted, specify the floppy drive to which you will copy the images. 

6. Label a diskette Windows 2000 Professional Setup Disk #1 and insert the diskette 
into the floppy drive. 

7. Click Enter to continue. 

8. When prompted insert diskettes #2, #3, and #4. Remember to label each diskette. 

Follow the directions below to install Windows 2000 Professional on the server. 

Installing Windows 2000 Professional 
1. Turn off the Server and insert Windows 2000 Professional Setup Disk #1 into the 

floppy drive. 

2. Power the Server on. 

The Windows 2000 Professional Setup window displays. 

3. When prompted, insert Windows 2000 Professional Setup Disk #2 and press 
Enter. 

4. When prompted, insert Windows 2000 Professional Setup Disk #3 and press 
Enter. 
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5. When prompted, insert Windows 2000 Professional Setup Disk #4 and press 
Enter. 

The Windows 2000 Professional Setup screen displays and after a few minutes of 
loading files. 

6. Press Enter to setup Windows 2000 Professional now. 

The Windows 2000 Professional Licensing Agreement screen displays. 

7. Press Page Down and read the License. 

8. Press F8 to accept the licensing agreement. 

The Windows 2000 Professional Setup screen displays. If you have an existing 
partition, you will delete it using the instructions below. If you do not have a 
partition, skip to step #9. 

Note: If setup detects and an existing installation and you wish to install a fresh copy 
of Windows 2000 Professional, press ESC. 

9. Press D to delete the selected partition. 

10. Press Enter to continue. 

11. Press L to delete the partition. 

A Warning Message displays. 

12. Press C to create a partition in the unpartitioned space. 

13. Take the default maximum partition size and press Enter to continue. 

14. Arrow-down to format the drive using NTFS and press Enter.  

The formatting and loading will take several minutes. When the formatting is 
complete, you will be prompted to reboot. 

15. Remove any diskettes in the floppy drive and press Enter. 

The system reboots with a Windows 2000 Professional splash screen.  When 
completed, the Welcome to Windows 2000 Professional window displays. 

16. Click Next to install devices. 

This may take several minutes.  When finished, the Regional Setting window displays.  

17. Click Next to continue. 

The Personalize your Software window displays. 

18. Type your Name and Organization in the fields provided and click Next. 

The Product Key Window displays. 

19. Enter the product key from the back of the CD Case. 

The Computer Name and Administrator Password windows display. 

20. Type SERVER in the computer name field. 

21. Type an administrator password and confirm that password. 

22. Click Next. 
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The Date and Time Settings window displays. 

23. Set the correct date, time, and time zone and click Next. 

After additional file loading, the Network Settings window displays. 

24. Select Typical Settings and click Next. 

The workgroup and computer domain window displays. 

25. Click the Yes radio button and enter a domain name of Store.  Click Next when 
finished. 

Note: If you are prompted for a user name and password, click Cancel, return to the 
workgroup and computer domain window, click the No radio button and continue 
with the installation.   

26. When the program finishes the installation process, remove the CD-ROM from 
and click Finish. 

Connecting to the Network 
1. After reboot, the Network Identification Wizard is launched.  Click Next to 

continue. 

The Users of this Computer window displays. 

2. Confirm the Windows always assumes the following user has logged on to 
this computer radio button is pressed.  Click the User Name field’s pull down 
arrow and choose Administrator.  Click Next. 

The completion screen displays. 

3. Click Finish. 

The Log On Window displays. 

Configuring your Workstation 
1. Type your Administrator name and Password in the fields provided and click OK. 

2. Upon reboot uncheck the “Show this screen at startup” checkbox and Exit the 
Getting Started screen. 

3. Right-click on the Windows Desktop and select Properties from the pop-up 
menu. 

4. Click the Settings tab. 

5. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

6. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

7. Click OK. 
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Pervasive Installation 

Shutting Down Server Processes – Upgrades only 
Note:  The following steps must be followed when performing an upgrade, to ensure 
proper installation of the Pervasive Server and Workstation engines. 

1. Shut down all applications on the system, including any windows programs and 
all ScanMaster applications. 

Note: If the EJ Processor is not running on the server, shutdown the EJ Processor 
on the PC where it is running as described in steps 2 through 4.  If no EJ Processor 
is currently installed or running, skip to step 5.   

2. On the Task Bar of the machine running the EJ processor, double-click the EJ 
Processor task icon (to the left of the time). 

The EJ Processor Window Displays. 

3. Click ShutDown EJ Processor.  

4. Click Yes to the prompt  “Are you sure you wish to shutdown the EJ Processor?”. 

5. From the Server, press Ctrl+Alt+Del,then click Task Manager. 

The Windows Task Manager screen displays. 

6. Click the Processes tab to display a list of Windows processes. 

7. Search for and shut down the following processes: 

• NTVDM 

• W32MKDE (if running) 

8. Close the Task Manager 

 

Installing Pervasive Server Engine on the Server 
Note:  If you are upgrading a 24-hour store, you must first upgrade all PoS 
Workstations to ScanMaster version 2.05.01 prior to installing Pervasive Server 
Engine on the server.    Skip to page 34. 

Note:  If Pervasive Server Engine version 7 is installed already (upgrading from 
ScanMaster version 2.00.xx), uninstall version 7 before installing version 8.  This 
can be done by selecting Pervasive SQL Engine in Add/Remove Programs in the 
Control Panel. 

Note: If you have installed Internet Information Services (IIS) on the server, it 
must be temporarily disabled before installing the Pervasive Server Engine. 

Note: If the server has AntiVirus script blocking enabled, you must disable this 
prior to installing Pervasive, and re-enable it after installation is complete. 
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Perform the Pervasive Server Engine Installation on the SERVER ONLY.  

Before continuing, make sure that you are logged onto the Server as Administrator.  

1. Insert the CD labeled Pervasive Server Engine into the Server CD-ROM drive. 

Note: If the Pervasive Installation CD autoruns, skip to step 7.   

2. From the Windows Task Bar, click Start→Run. 

The Run dialog box displays. 

3. Click Browse. 

4. Look in the CD-ROM drive. 

5. Double-click SETUP.EXE to launch the installation procedure. 

6. Click OK to begin setup. 

The Pervasive Welcome window displays.   

7. Click Next to continue. 

The Software License Agreement displays. 

8. Accept the agreement by clicking “I accept….” and then click Next. 

The Enter License window displays. 

9. Enter the license number from the Pervasive Server Engine CD and click Next. 

Note: Capitalization does not matter. 
 
The Setup Type window displays.   

10. Select Complete and click Next. 

 The Ready to Install Window displays. 

11. Review the information and click Install. 

If other applications are running, the Conflicting Programs Report Window displays. 
If not, skip to step 14. 

12. Review the information and click Next. 

A Question window displays asking if you want to continue testing for running 
programs. 

13. Click No to continue the installation. 

After Setup has completed copying files and starting services, the Setup Complete 
window displays. 

14. Click Finish. 

The HTML help window displays with links to the Pervasive web site.  While this 
window displays in the background, the Transactional Engine Test window displays. 

15. Click Next to perform the Transactional test. 

The results display.  
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16. Click Next. 

The Relational Engine Test window displays. 

17. Click Next to continue. 

The test results display.  

18.  Click Next. 

An installation summary appears.  

19. Click Finish. 

20. Remove the Pervasive Server Engine CD and close the HTML Help Window.   
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ScanMaster 2.05.01 

Full Installation of ScanMaster 2.05.01 on the Server 
Note:  For upgrading see ScanMaster 2.05.01 Upgrade section. 

To install ScanMaster 2.05.01 on the server, you must first ensure that you are 
logged on to the server as the Administrator. To Install ScanMaster on the Back 
Office Workstations, go to the section entitled “Installing ScanMaster Software on 
the Back Office Workstations.” 

1. Make sure the HASP security key is plugged into the server.  If any message boxes 
pop up asking to install a driver, click cancel. 

2. Insert the CD labeled ScanMaster Version 2.05.01 into the Server CD-ROM drive. 

Note: If any Window displays asking “What do you want Windows to do?”, click 
Cancel. 

3. From the Task Bar, click Start→Run. 

The Run dialog box displays. 

4. Click Browse. 

5. Look in the CD-ROM drive. 

6. Double-click the Scan2base folder to display the contents. 

7. Double-click SETUP.EXE and click OK to launch the ScanMaster installation 
procedure. 

An Information screen appears. 

Read screen and Click OK. 

The ScanMaster Welcome window displays.   

If requirements on the Information page have NOT been met select Cancel, then select 
YES.   

8. Click Next to begin the installation. 

The ScanMaster Installation Requirements window appears. 

9. Click Next. 

You are prompted to “Enter the Currently Logged On User Name”.  

10. Make sure you are logged in as “Administrator “and with “Administrator” in the 
text box, click Next. 

The Choose Installation Type window displays.   

11. Select Server - Full Installation then click Next. 

If Internet Explorer is already installed, the Enter Computer Name window displays. 
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NOTE:  If you do not have Internet Explorer version 5.5 or higher installed, you will 
receive a message with this information.  You must install Internet Explorer version 
5.5 or higher to continue with the ScanMaster 2.05.01 installation.  Internet Explorer 
5.5 is located on the ScanMaster 2.05.01 CD-ROM in the IE55 folder and is called 
ie5setup.exe.  If Pervasive v8.x/v9.x is not installed, you will receive a message that 
Pervasive v8.x/v9.x must be installed prior to the ScanMaster 2.05.01 install.  If the 
version requirements of either Pervasive or Internet Explorer are not met, the user will 
be notified and the install will terminate.    

12. Validate the computer name is correct.  Click Next. 

The Select Installation window displays with the “Typical” option selected. 

13. You may choose Typical if you have no drives configured as the “F:” drive.  If 
your system does not meet these conditions, skip to step 14. 

ScanMaster will create a shared directory called SCAN1DOS and install shared files 
to this directory. 

14. Click Next to continue and move to Step 19 for Typical Installations (or if you 
have chosen a custom installation see below). 

The Confirm Selections screen displays. 

15. Choose Custom if this computer has more than one fixed disk or multiple 
partitions.  

ScanMaster will allow you choose the drives on which you would like install program 
files and network files. 

16. Click Next to continue. 

The Select Installation Location screen displays.   

17. Select (click) the drive designation where you would like to install the ScanMaster 
program files.  Click Next to continue. 

The Select Network Drive screen displays.   

18. Select (click) the drive designation where you would like to install the shared 
ScanMaster files.  Click Next to continue. 

Note: ScanMaster will create a network share on the drive/partition you select. 

The Confirm Selections screen displays. 

19. Click Next to continue. 

ScanMaster is loaded as the progress bar appears.  When finished copying a message 
box displays saying “Are you sure you want to add the information in 
C:\Grocery\V8Srv.reg or C:\Grocery\V9Srv.reg to the registry?” (for Windows 
2000 & 2003 installations). 

20. Click Yes. 

A message box displays confirming that the information has been successfully entered 
into the registry. 

21. Click OK. 
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A message box appears for the HASP Device Install Utility with a “Please Wait”    
followed by a message that “The operation was completed successfully.” 

22. Click OK. 

Three separate DOS boxes will appear briefly and then close. 

A warning message appears describing the consequences of performing a restart 
during the MS Scripting Engine and MDAC installation. 

23. Click OK. 

Note: On Windows 2003 Installations the Microsoft Data Access Components 2.8 
Setup begins.  Skip to Step 26. 

On XP Installations the ScanMaster Server Database Creation Utility displays. Skip 
to Step 29. 

A message displays, asking if you are sure you want to install Windows Script 5.6.23. 
Click Yes. 

The Windows Script 5.6 License Agreement appears. 

24. Click Yes to accept. 

The Windows Script 5.6 files are copied.  A message displays stating that Windows 
Script 5.6 is now installed. 

25. Click OK. 

NOTE:  If you are prompted whether you wish to restart your computer, press NO.  
DO NOT RESTART THE COMPUTER at this point.    

The Microsoft Data Access Components 2.8 Setup begins, and the End User License 
Agreement displays. 

26. Click the checkbox to accept the terms of the license agreement and click Next. 

 The Installing the Software window displays. 

27. Click Finish. 

The MDAC components are installed.   

Note:  It may take a few moments for the files to begin copying.  On NT 4.0 
installations, you may receive an error registering the wshom.ocx file.  Click OK to 
continue.  ScanMaster’s use of MDAC is unaffected. 

After the files are copied, the setup completion window displays.  

If a Restarting the system screen appears, select “I will restart the system myself.” 

28. Click Close. 

The ScanMaster Server Database Creation Utility displays. 

29. Enter the user’s password (if any) and click CreateDB button. 

In the Database Creation Status section a green message will appear: 

ScanMaster DBName created successfully. 
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ScanMaster Database created successfully. 

30. Click Exit. 

The install now creates the ScanMaster Users. 

The ScanMaster Installation Customization window displays.  

31. Enter your Customer Information, ID and specify the number of PoS Workstations 
(by using the arrows).  When finished, click Save Information. 

A dialog box displays asking if you are sure that you want to save this information. 

32. Click Yes. 

The register options screen displays. 

33. Click (select) the radio button for the type of PoS workstations for your store 
(Fujitsu or NCR).  When finished click Next. 

This completes the ScanMaster version 2.05.01 Server Installation.  

 The ScanMaster Windows Register Installation begins, displaying the Welcome 
screen. 

34. Click Next to begin the installation of the register files to the server. 

35. A “Question” dialog may appear stating the “Lan Drive not detected.”  If the 
drive exists, click YES to continue.  If the drive does not exist, click NO and 
correct the problem or contact your support representative. 

The ScanMaster Setup Completion screen appears. 

36. Select “Yes, I want to restart my computer now” and click Finish. 

Upgrading ScanMaster 2.05.01 on the Server 
Note:  The following steps should be taken only when performing an upgrade from a 
previous version of ScanMaster.   For a new installation, refer to the previous section 
called ScanMaster 2.05.01 Installation. 

Note: Pervasive 8.6 (or greater) must be installed on the server before upgrading 
ScanMaster). 

Ensure that you are logged on to the server as the Administrator.   

1. Make sure the HASP security key is plugged into the server.  If any message boxes 
pop up asking to install a driver, click cancel. 

2. Insert the CD labeled ScanMaster Version 2.05.01 into the Server CD-ROM drive. 

3. From the Task Bar, click Start→Run. 

The Run dialog box displays. 

4. Click Browse. 

5. Look in the CD-ROM drive. 

6. Double-click the Scan2base folder to display the contents. 
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7. Double-click SETUP.EXE and click OK to launch the ScanMaster installation 
procedure. 

 

An Information screen appears. 

Read screen for requirements and Click OK. 

The ScanMaster Welcome window displays 

If requirements on the Information page have NOT been met select Cancel, then select 
YES.    

8. Click Next to begin the installation. 

The Install Requirements Screen displays.   

9. Confirm the installation requirements have been met and click Next continue. 

The Enter Text dialog box appears.  

10. Confirm the currently logged on user is the Administrator, then click Next. 

The Choose Installation Type window displays. 

11. Select Server - Upgrade then click Next. 

A message box appears that warns the user that upgrades require the PoS 
Workstations to be upgraded first and the BackOffice Workstations last. 

12. Click OK 

Select Currently installed version of ScanMaster window displays. 

13. Confirm version of ScanMaster upgrading from, and then click Next. 

The Confirm Selections window displays. 

14. Click Next to continue. 

ScanMaster is loaded as the progress bar appears.  After ScanMaster is finished 
loading, a Registry Editor Message box appears which says “Are you sure you want to 
add the information to the registry?” 

15. Click Yes. 

A Registry Editor message appears which says “Information has been successfully 
entered into the registry”. 

16. Click OK. 

A “SETUPEX” dialog box may display stating “Uninstall complete, you need to 
restart before attempting to re-install,”  Ignore the text of this message, as it is being 
generated by the removal of the old software security system.  There will be no need for 
a reinstall because the software is now being secured by HASP modules. 

17. If the SETUPEX dialog appears, Click OK. 

A message box appears for the HASP Device Install Utility with a “Please Wait” 
followed by a message that the operation was completed successfully. 

18. Click OK. 
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19. Three separate DOS boxes will appear briefly and then close. If a dialog displays, 
click OK. 

A warning message appears describing the consequences of performing a restart 
during the MS Scripting Engine and MDAC installation. 

20. Click OK. 

Note: On Windows 2003 Installations, the MDAC End User License screen will 
display.  Skip to Step 25. 

On XP Installations, the ScanMaster Installation Customization window displays. 
Skip to Step 32. 

A warning message displays. 

21. Click YES to install Windows Script 5.6. 

22. Click YES for the License Agreement for Windows Script 5.6. 

23. Click OK to finish the installation. 

Note: This next selection is extremely important as the ScanMaster 2.05.01 
Upgrade will not continue if the system is restarted now.   

24. Click NO to not reboot at this time if prompted. 

The MDAC End User License screen will then display. 

25. Click the checkbox to accept the terms of the license agreement and click Next. 

26. If the MDAC Detecting In Use Files window displays, click Next. 

27. Click Finish. 

28. Click Close. 

The MDAC Installing the Software window displays.  
The MDAC components are installed. 

Note:  It may take a few moments for the files to begin copying. When finished, the 
system restart message may display.   

29. If prompted, select “I will restart the system myself”, and Click Finish. 

If upgrading from ScanMaster 2.01.xx or higher, the Create Database Screen will 
NOT display. Skip to step 32. 

30. Enter the user’s password (if any) and click CreateDB button. 

In the Database Creation Status section a green message will appear: 

ScanMaster DBName created successfully. 
ScanMaster Database created successfully. 

31. Click Exit. 

The ScanMaster Installation Customization window displays.  

32. Enter your Customer Information, ID and specify the number of PoS Workstations 
(by using the arrows).  When finished, click Save Information. 
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A dialog box displays asking if you are sure that you want to save this information. 

33. Click Yes. 

If the register install has already been installed to the server, a window asking if you 
would like to reinstall the software appears.  

34. Click Yes to install the register install to the server if the software needs to be 
installed or reinstalled, otherwise click No and skip to step 38. 

A window asking to select between Fujitsu and NCR register install appears.  

35. Click (select) the radio button for the type of PoS workstations for your store 
(Fujitsu or NCR).  When finished click Next. 

The “ScanMaster v2.05.01 Register Installation to Server” window appears.  

36. Click Next. 

37. A “Question” dialog may appear stating the “Lan Drive not detected.”  If the 
drive exists, click YES to continue.  If the drive does not exist, click NO and 
correct the problem or contact your support representative. 

Components are copied to the server and you are prompted to restart your computer.  

38. Select ”Yes, I want to restart my computer now” and click Finish. 

The Server restarts. 

39. Log into the server as the Administrator again. 

If upgrading from v2.05.01 the upgrade is now complete. 

If upgraded from a version prior to v2.05.01 the Welcome window for ScanMaster 
Server/Back office Upgrade Part 2 displays.   

40. Click Next. 

The Install Requirements Screen displays. 

41. Confirm the installation requirements have been met and click Next continue. 

42. Confirm installation type, and click Next continue. 

The ScanMaster File Conversion Utility window displays with the message: 

“It is required to close down all Server, Back Office, and Online PoS Workstation 
applications including the EJ Processor during this conversion!  Restart the EJ after 
conversion completed.” 

Click OK and if upgrading from ScanMaster v2.01.00 or later, a message will appear 
asking if you want to CONVERT EJ FILES ? Y/N.   Depending on file size, this could 
take several hours.  Skip to step 47. 

43. Click OK. 

The Conversion Utility converts the necessary files. The checkboxes next to these files 
get checked automatically as the conversion progresses.  The screen may flash, and 
other screens may appear during the conversion process. 
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A message box appears “ScanMaster program names have changed from Smw*.exe to 
Sm2*.exe.  Please review the SM2EOD.SCR file for custom .BAT files and manually 
fix program names located within these .BAT files.”   

The process of reviewing the batch files should be done by the ScanMaster 
installation team, or the end user’s I.T. department. All of the entries within 
the SM2EOD.SCR file ending with .BAT are the names of batch files found in 
C:\GROCERY of the machine that does the End of Day.  These batch files 
need to be reviewed and possibly updated to use the new ScanMaster 
application names.  

44. Click OK. 

The application message shows at top of the screen “Conversion completed. Click 
Exit.” 

45. Click Exit. 

The register conversion warning message displays.  Confirm all server and back office 
applications are shut down, including the EJ Processor.   

46. Click OK. 

A message will appear asking if you want to CONVERT EJ FILES ? Y/N. 

Depending on file size, this could take several hours!!!  

47. Select YES or NO.  

Selecting YES will update the tables and files (DO NOT ABORT ONCE STARTED) 

Selecting NO will bypass this conversion until the next time someone accesses an EJ 
related function. The tables/files will be updated at that time. 

The conversion utility Part 1 screen displays briefly, processes, and then exits 
automatically. 

The Install Shield Wizard Complete window displays. 

48. Click Finish. 

49. If prompted, select ”Yes, I want to restart my computer now”. 

50. If system reboots, login as the Administrator. 

51. If the old icon “Start NCR ScanMaster” does not appear on your desktop, the 
upgrade is complete.  If it still appears on your desktop, right-click the icon and 
select “Delete” from the pop-up menu. 

52. Confirm the deletion and click Yes. 

53. Right-click on the Start button and select Open All Users from the pop-up menu. 

54. Double-click on the Programs file folder. 

55. Right-click on NCR ScanMaster for Windows folder and select “Delete” from the 
pop-up menu. 

56. Confirm the deletion and click Yes. 

57. Close all open windows. 
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Installing ScanMaster 2.05.01 PoS Workstation Software on the Server 
Note:  When performing an upgrade, it is extremely important if the installation is 
at a live 24 hour store, to follow the order of the steps listed.  Install the PoS 
workstation Software on the Server first.  Next, upgrade all of the PoS 
workstations, one at a time.  Then, upgrade the server.  Finally, upgrade any back 
office workstations. 

If performing a full install, this step has already been completed during the install 
of the server, and does not need to be repeated. 

1. With the ScanMaster 2.05.01 CD in the CD-ROM Drive, from the task bar, select 
Start → Run. 

2. Click Browse. 

3. Look in the CD-ROM drive. 

4. If installing Fujitsu PoS Workstations, Double-click the RegServInstall folder, 
otherwise Double-click the RegServInstallN folder. This will display the contents 
of the folder. 

5. Double-click SETUP.EXE and click OK to launch the ScanMaster workstation 
install procedure. 

6. A “Question” dialog may appear stating the “Lan Drive not detected.”  If the 
drive exists, click YES to continue.  If the drive does not exist, click NO and 
correct the problem or contact your support representative. 

The Welcome screen appears 

7. Click Next. 

The ScanMaster register software installs into F:\Winreg\Install directory and 
returns you to the Windows Desktop. 

Post Installation 

Norton AntiVirus (Windows XP Acer OEM Version) 
If your server has Norton AntiVirus installed, you will need to re-enable the Script 
Blocker.  

1. Double-click the Norton AntiVirus icon located in the system tray (to the left of 
the time). 

The Norton AntiVirus window displays 

2. Click the Script Blocking hyperlink in the middle of the window. 

3. Click the Enable button on the right of the window. 

4. Close all open windows. 

 



  Chapter 2: 2.05.01-050 Upgrade and Installation Procedures 2-35 

 

 

 

 

Windows XP Professional as Server – Sharing adjustments 
1. Select Programs →Accessories→Windows Explorer. 

The Explorer Window displays. 

2. Click My Computer. 

3. Click “Local Disk C:” (or the drive on which ScanMaster was installed). 

4. Right-click on the folder name SCAN1DOS. 

5. Choose “Sharing and Security…” from the pop-up menu. 

6. Click on the hyperlink “If you understand the security risks…”. 

The Enable File Sharing window displays. 

7. Select the Just enable file sharing radio button. 

8. Click OK. 

9. Ensure that both “Share this folder on the network” checkbox, and “Allow 
network users to change my files” checkbox are enabled. 

10. Click OK. 

11. Close all open windows. 
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Back Office Workstation Setup 
Note: This section describes the setup of a ScanMaster Back Office Workstation.  
Instructions for installing the operating system, all necessary prerequisite components 
of ScanMaster, and installing or upgrading ScanMaster 2.05.01. 

Prerequisites 
Before starting the install/upgrade, ensure you have: 

• Operating System Installation CDs with “Product Key” from Microsoft if 
system is not preloaded. 

• Pervasive v8.x/v9.x Workstation Engine CD  

• ScanMaster 2.05.01 Installation CD 

• At least 5GB available hard drive space on the Back Office Workstation, after 
the Operating system has been installed. 

• If upgrading, a complete data backup of the system. 

• If upgrading a 24-hour site, upgrade all PoS workstations prior to upgrading 
the Server and any Back Office Workstations. 
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Operating System Installation for the Back Office 
Workstation 

This section details the steps necessary to install the operating system on the 
ScanMaster Back Office Workstation.  Supported operating systems are: 

• Windows XP Professional  

• Windows 2000 Professional  

Windows XP Professional  (Acer OEM Version) 
This section describes configuring the OEM version of Windows XP Professional 
preloaded on the Acer models V5600GT, and V7600GT PCs.    

Note: Do not use this section if you are installing a new copy of Windows XP 
Professional on the PC.  Instead use the section after this titled “Windows XP 
Professional” on page 40. 

The first time the Acer is powered on, the “Welcome to Microsoft Windows” screen 
displays. 

1. Click Next. 

The Select Your System Settings screen displays. The default selections are for United 
States, English (United States) Language, and US for the keyboard. 

2. Click Next. 

The End User License Agreement screen displays. 

3. Select the “Yes, I accept…” radio-button, and click Next. 

The “What’s your computer’s name?” screen displays. 

4. Type BACKOFFICExx (where xx is the PC number) in the computer name field. 

5. Click Next. 

The ”What’s your Administrator password?” screen displays. 

6. Type an administrator password and confirm that password. 

Note: The password cannot be blank and must be at least 6-characters in length if 
using a Windows 2003 Server.  (It may be a combination of letters and numbers) 

7. Click Next. 

The “Is this computer in a domain?” screen appears. 

8. Select “No, don’t make this computer part of the domain” radio-button, and then 
click Next. 

The system checks for Internet connectivity, and then displays the “Will this computer 
connect to the Internet…” screen. 

9. Select the appropriate radio-button response, and click Next. 
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The “Ready to register with Microsoft?” screen appears. 

10. Select “Yes…” radio-button response, and click Next. 

The “Collecting Registration Information” screen appears. 

11. Enter appropriate information and then click Next. 

The “Who will use this computer?” screen appears.  

12. At least one user name must be entered.  Enter Local in the “Your name” field 
and click Next. 

The “Thank You!” screen displays. 

13. Click Finish. 

14. Login as the Administrator. 

15. Turn off the Welcome screen by clicking Start → Control Panel→ User 
Accounts→ Change the way users log on or off. 

16. Unselect “Use the Welcome Screen” and click Apply Options. 

17. Close the User Accounts and Control Panel window.  

Note: Install any Windows XP Professional Service Packs (Start → All Programs → 
Windows Update if connected to the Internet) that are available for your release level. 

Configuring your Back Office Workstation 
1. If not logged on, press CTRL + Alt + Delete to log on. 

2. Type your Administrator name and Password in the fields provided and click OK. 

3. Select Start. 

4. Right-click on My Computer and select Properties from the pop-up menu. 

5. Click the Computer Name Tab. 

6. Click the Change button. 

7. Confirm the “Workgroup” radio button is selected and enter the name of STORE 
for you workgroup, and click OK. 

The welcome to the STORE workgroup window displays. 

8. Click OK. 

You are prompted to reboot the computer. 

9. Click OK. 

10. Click OK. 

11. Click Yes to restart your computer. 
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Changing Display Settings on the Windows XP Professional Back Office 
Workstation 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

2. Click the Settings tab. 

3. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

4. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

5. Click Apply. 

6. Click the Appearance tab. 

7. In the “Windows and Buttons” drop down box, select Windows Classic Style. 

8. Click OK. 

9. Right-click the Start button. 

10. Choose Properties from the pop-up menu. 

11. Select the “Classic Start Menu” radio-button. 

12. Click APPLY. 

13. Click the Desktop tab. 

14. Click the Customize Desktop button. 

15. Deselect “Run Desktop Cleanup Wizard every 60 days.” checkbox 

16. Select “My Computer” and “My Network Places” checkboxes. 

17. Click OK. 

Configuring the Firewall, Automatic Update and Virus Protection Options (XP 
Service Pack 2 and greater) 
Note: Automatic Updates are not recommended because they require rebooting the 
computer (and will continually prompt for a reboot until it has been performed).  It is 
recommended to manually install security updates only from the Windows Update 
Web Site at a store-convenient time when the computer can be rebooted. 

1. Click Start→Control Panel→Security Center. 

2. In the Resources section (on the left), click “Change the way Security Center alerts 
me”. 

3. Uncheck all three Alert Setting options. 

4. Click OK. 

5. On the bottom, click Windows Firewall (under “Manage security settings for”). 

6. Click “Off”. 
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7. Click OK. 

8. On the bottom, click Automatic Updates (under “Manage security settings for”). 

9. Click “Turn off Automatic Updates”. 

10. Click OK. 

11. Close the Security Center and Control Panel windows. 

12. Double-click the Norton AntiVirus icon located in the system tray (to the left of 
the time). 

The Norton AntiVirus window displays 

13. Click the Options button at the top of the window. 

The Norton AntiVirus Options window displays 

14. Deselect the “Enable Auto-Protect…” checkbox. 

15. Click Script Blocking from the menu on the top left. 

16. Deselect the “Enable Script Blocking” checkbox. 

17. Click OK. 

18. Close all open windows. 

Disabling Windows Messenger (Optional) 
Note: Before attempting to disable Windows Messenger, close all open windows. 

1. Double-click the Windows Messenger icon in the system tray, to the left of the 
time. 

The Windows Messenger window appears. 

2. On the Windows Messenger menu bar, select Tools, and the select Options from 
the pop-up menu. 

The Options window appears. 

3. Click the Preferences tab. 

4. Deselect the “Run this program when Windows starts.”checkbox, and then click 
OK. 

5. Close the Windows Messenger window. 

6. Click the Windows Messenger icon in the system tray, to the left of the time. 

7. Select Exit from the pop-up menu. 

8. Click OK. 

Windows XP Professional  
Follow the directions below to install Windows XP Professional on a back office PC.   
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Note: Do not use this section if you are using the preloaded OEM version of 
Windows XP Professional on the Acer models v5600GT and V7600GT PCs, instead 
use the previous section titled “Windows XP Professional (Acer OEM Version)” on 
page 37. 

Change the Boot Sequence 
1. Boot the computer, enter the computer’s CMOS Setup Utility and change the Bios 

settings to boot from the CD-ROM drive. 

2. Insert the Microsoft Windows XP Professional CD-ROM into the CD-ROM drive 
and reboot. 

The Windows XP Professional Setup screen displays and after a few minutes of 
loading files. 

3. Press Enter to setup Windows XP Professional now. 

The Windows XP Professional Licensing Agreement screen displays. 

4. Press Page Down and read the License. 

5. Press F8 to accept the licensing agreement. 

The Windows XP Professional Setup screen displays. If you have an existing 
partition, you will delete it using the instructions below. If you do not have a 
partition, skip to step #12. 

6. Press ESC to install a fresh copy of Windows XP Professional. 

7. Locate and press D to delete the desired partition. 

8. Press Enter to continue. 

9. Press L to delete the partition. 

10. Repeat steps 7 through 9 for any additional partitions. 

11. Locate the unpartitioned space to load Windows XP Professional and press C to 
create a partition in that space. 

12. Accept the default drive size and press Enter to continue. 

13. Select the new partition to install Windows XP Professional and press Enter to 
continue. 

14. Ensure “Format the partition using the NTFS file system” is highlighted and press 
Enter.  

The formatting and loading will take several minutes. When formatting and loading is 
complete, the system will reboot automatically.  Additional file loading will continue.  
This may take several minutes.  When finished, the Regional Setting window displays.  

15. Click Next to continue. 

The Personalize your Software window displays. 

16. Type your Name and Organization in the fields provided and click Next. 

The Product Key Window displays. 
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17. Enter the product key from the back of the CD Case. 

The Computer Name and Administrator Password windows display. 

18. Type BACKOFFICExx (where xx is the PC number) in the computer name field. 

19. Type in an administrator password and confirm that password. 

20. Click Next. 

The Date and Time Settings window displays. 

21. Set the correct date, time, and time zone and click Next. 

After additional file loading, the system reboots. The Display Settings adjustment 
window then displays.  

22. Click OK. 

The Welcome to Microsoft Windows displays.  

23. Click Next. 

The “Who will use this computer?” screen appears.  

24. At least one user name must be entered.  Enter Local in the “Your name” field 
and click Next. 

The “Thank You!” screen displays. 

25. Click Finish. 

26. Login as the Administrator. 

27. Turn off the Welcome screen by clicking Start → Control Panel→ User 
Accounts→ Change the way users log on or off. 

28. Unselect “Use the Welcome Screen” and click Apply Options. 

29. Close the User Accounts and Control Panel window. 

Note: If you need to install any hardware drivers follow the installation steps to 
install these drivers at this time.  Consult your network administrator before 
assigning or changing any TCP/IP settings. 

Note: Do not select any configuration that may make the workstation a Domain 
Controller. 

Note: Install any Windows XP Professional Service Packs (Start→All 
Programs→Windows Update if connected to the Internet) that are available for your 
release level. 

Configuring your Workstation 
1. If not logged on, press CTRL + Alt + Delete to log on. 

2. Type your Administrator name and Password in the fields provided and click OK. 

3. Select Start. 



  Chapter 2: 2.05.01-050 Upgrade and Installation Procedures 2-43 

 

4. Right-click on My Computer and select Properties from the pop-up menu. 

5. Click the Computer Name Tab. 

6. Click the Change button. 

7. Confirm the “Workgroup” radio button is selected and enter the name of STORE 
for your workgroup, and click OK. 

The welcome to the STORE workgroup window displays. 

8. Click OK. 

You are prompted to reboot the computer. 

9. Click OK. 

10. Click OK. 

11. Click Yes to restart your computer. 

Changing Display Settings on the Windows XP Professional Workstation 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

2. Click the Settings tab. 

3. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

4. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

5. Click OK. 

Configuring the Firewall, Automatic Update and Virus Protection Options  
(Windows XP Professional Service Pack 2 and greater) 
Note: Automatic Updates are not recommended because they require rebooting the 
computer (and will continually prompt for a reboot until it has been performed).  It is 
recommended to manually install security updates only from the Windows Update 
Web Site at a store-convenient time when the computer can be rebooted. 

1. Click Start→Control Panel→Security Center. 

2. In the Resources section (on the left), click “Change the way Security Center alerts 
me”. 

3. Uncheck all three Alert Setting options. 

4. Click OK. 

5. On the bottom, click Windows Firewall (under “Manage security settings for”). 

6. Click “Off”. 

7. Click OK. 
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8. On the bottom, click Automatic Updates (under “Manage security settings for”). 

9. Click “Turn off Automatic Updates”. 

10. Click OK. 

11. Close the Security Center and Control Panel windows. 

 

Windows 2000 Professional 
Follow the directions below to install Windows 2000 Professional on a back office PC.  

Change the Boot Sequence 
1. Boot the computer, enter the computer’s CMOS Setup Utility and change the Bios 

settings to boot from the CD-ROM drive. 

2. Insert the Microsoft Windows 2000 Professional CD-ROM into the CD-ROM drive 
and reboot. 

The Windows 2000 Professional Setup screen displays and after a few minutes of 
loading files. 

3. Press Enter to setup Windows 2000 Professional now. 

The Windows 2000 Professional Licensing Agreement screen displays. 

4. Press Page Down and read the License. 

5. Press F8 to accept the licensing agreement. 

The Windows 2000 Professional Setup screen displays. If you have an existing 
partition, you will delete it using the instructions below. If you do not have a 
partition, skip to step #10. 

6. Press ESC to not repair the previous installation. 

7. Highlight the partition to delete and press D to delete the selected partition. 

8. Press Enter to continue. 

9. Press L to delete the partition. 

10. Highlight the unpartitioned space and press C to create a partition in that space. 

11. Take the default maximum partition size and press Enter to continue. 

12. Highlight the new partition and press Enter to Install. 

13. Select NTFS and press Enter.  

The formatting and loading will take several minutes. When the loading is complete, 
you will be prompted to reboot. 

14. Remove any diskette in the floppy drive and press Enter. 

The system reboots with a Windows 2000 Professional splash screen.  When 
completed, the Welcome to Windows 2000 Professional window displays. 
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15. Click Next to install devices. 

This may take several minutes.  When finished, the Regional Setting window displays.  

16. Click Next to continue. 

The Personalize your Software window displays. 

17. Type your Name and Organization in the fields provided and click Next. 

The Product Key Window displays. 

18. Enter the product key from the back of the CD Case. 

The Computer Name and Administrator Password windows display. 

19. Type BACKOFFICExx (where xx is the PC number) in the computer name field. 

20. Type an administrator password and confirm that password. 

21. Click Next. 

The Date and Time Settings window displays. 

22. Set the correct date, time, and time zone and click Next. 

After additional file loading, the “Completing the Windows 2000 Professional Setup 
Wizard” displays. 

23. Click Finish. 

The system reboots.  After reboot, the Network Identification Wizard displays. 

24. Click Next. 

The Users of This Computer screen displays. 

25. Select the “Users must enter a user name and password to use this computer” 
radio button.  Click Next. 

26. Click Finish. 

27. Login as the Administrator. 

Note: If you need to install any hardware drivers follow the installation steps to 
install these drivers at this time.  Consult your network administrator before 
assigning or changing any TCP/IP settings. 

Note: Install any service packs that may be available for your Windows 2000 
Professional release level. 

Configuring your Workstation 
1. If not logged on, press CTRL + Alt + Delete to log on. 

2. Type your Administrator name and Password in the fields provided and click OK. 

3. Right-click on My Computer and select Properties from the pop-up menu. 

4. Click the Network Identification Tab. 

5. Click the Properties button. 
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6. Confirm the “Workgroup” radio button is selected and enter the name of STORE 
for your workgroup, and click OK. 

The welcome to the STORE workgroup window displays. 

7. Click OK. 

You are prompted to reboot the computer. 

8. Click OK. 

9. Click OK. 

10. Click Yes to restart your computer. 

Configuring your Display 
1. Right-click on the Windows Desktop and select Properties from the pop-up 

menu. 

2. Click the Settings tab. 

3. Set the Screen Area to 800x600 pixels and click OK. 

A display properties informational box displays. 

4. Click OK to apply the new settings. 

The Monitor Settings informational box displays asking if you wish to save these 
settings. 

5. Click OK. 

Configuring TCP/IP Protocol on Windows 2000 Professional (Optional) 
Note: If using static IP addresses for your workstations, please use the following 
steps: 

1. On the Windows desktop, right-click on the My Network Places icon and select 
Properties from the pop-up menu. 

2. Right-click on Local Area Connection and select Properties. 

3. Highlight Internet Protocol (TCP/IP) and click Properties. 

4. Click the Use the following IP Address radio button. 

5. Enter an IP Address and Subnet Mask. 

Note: Consult your network administrator to obtain an IP Address and subnet 
mask.  Leave the Default Gateway setting blank.  

6. Click OK. 

7. Click OK on the Local Area Connection Properties window. 

8. Close the Local Area Connections Status window. 

9. Close the Network and Dial-up Connections window. 
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Pervasive Installation 

Shutting Down Server Processes – Upgrades only 
Note:  The following steps must be followed when performing an upgrade, to ensure 
proper installation of the Pervasive Server and Workstation engines. 

1. Shut down all applications on the system, including any windows programs and 
all ScanMaster applications. 

Note: If the EJ Processor is not running on the server, shutdown the EJ Processor 
on the PC where it is running as described in steps 2 through 4.  If no EJ Processor 
is currently installed or running, skip to step 5.   

2. On the Task Bar of the machine running the EJ processor, double-click the EJ 
Processor task icon (to the left of the time). 

The EJ Processor Window Displays. 

3. Click ShutDown EJ Processor.  

4. Click Yes to the prompt  “Are you sure you wish to shutdown the EJ Processor?”. 

5. From the Server, press Ctrl+Alt+Del,then click Task Manager. 

The Windows Task Manager screen displays. 

6. Click the Processes tab to display a list of Windows processes. 

7. Search for and shut down the following processes: 

• NTVDM 

• W32MKDE (if running) 

8. Close the Task Manager 

Installing Pervasive Workstation Engine  
Note: Be sure to install Pervasive on the Server prior to installing Pervasive on the 
Back Office Workstation. 

Note: If you have installed Internet Information Services (IIS) on the workstation, it 
must be temporarily disabled before installing the Pervasive Server Engine. 

This installation assumes you have a CD-ROM Drive on the back office workstation.  If you do 
not, you can run the installation over the network using the server’s CD ROM Drive. 

1. At the back office workstation, insert the CD labeled V8/V9 Workgroup Engine 
into the CD-ROM drive. 

Note: If the Autorun program starts, skip to step 10. 

2. Press the Start  key on the keyboard.  
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3. Press <R> for Run. 

4. Press <ALT><B> for Browse. 

5. Press <ALT><I> for Look In. 

6. Press the Arrow Down key and highlight the CD-ROM drive on the server and 
press Enter. 

7. Press the Tab key until the first folder on the CD is highlighted. 

8. Press the Arrow Down key, highlight Setup and press Enter. 

9. Press Enter for OK to run Setup installation wizard. 

The Welcome screen appears. 

10. Press Enter for Next. 

The Software License Agreement Displays.  

11. Read the agreement and click “I accept….” Or press <Alt><A>then press Enter for 
Next. 

Note: You may also the up and down arrow keys. 

The Setup Type Screen Displays.  

12. Accept Complete and press Enter for Next. 

The Verification Window displays. 

13. Review the information and press Enter for Install. 

After Setup has completed copying files and starting services, the Setup Complete 
window displays. 

14. Press Enter for Finish. 

The HTML help window displays with links to the Pervasive web site.  After closing 
this window, the Transactional Engine Test screen appears (within a few seconds). 

15.  Press Enter for Next. 

The Test Results will appear. 

16. Press Enter for Next. 

The Relational Engine Test Screen appears. 

17. Press Enter for Next. 

The Test Results will appear. 

18. Press Enter for Next. 

19. Press Enter for Finish. 
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ScanMaster 2.05.01 

Full Installation of ScanMaster 2.05.01 on the Back Office Workstation 
To install ScanMaster 2.05.01 on the back office workstation, you must first ensure 
that you are logged on as the Administrator.  

1. Insert the CD labeled ScanMaster Version 2.05.01 into the CD-ROM drive or 
share the CD-ROM drive on the server and map the shared CD-ROM drive on the 
server and insert the ScanMaster Installation CD into the server CD-ROM drive. 

Note: If any Window displays asking “What do you want Windows to do?”, click 
Cancel. 

2. From the Task Bar, click Start→Run. 

The Run dialog box displays. 

3. Click Browse. 

4. Look in the CD-ROM drive. 

5. Double-click the Scan2base folder to display the contents. 

6. Double-click SETUP.EXE and click OK to launch the ScanMaster installation 
procedure. 

An Information screen appears. 

Read screen for requirements and Click OK. 

The ScanMaster Welcome window displays 

If requirements on the Information page have NOT been met select Cancel, then select 
YES.    

7. Click Next to begin the installation. 

The ScanMaster Installation Requirements window appears. 

8. Click Next. 

You are prompted to “Enter the Currently Logged On User Name”.  

9. Make sure you are logged in as “Administrator “ and with “Administrator” in the 
text box , click Next. 

The Choose Installation Type window displays.   

10. Select Back Office - Full Installation then click Next. 

If Internet Explorer is already installed, the Enter Computer Name window displays. 
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NOTE:  If you do not have Internet Explorer version 5.5 or higher installed, you will 
receive a message with this information.  You must install Internet Explorer version 
5.5 or higher to continue with the ScanMaster 2.05.01 installation.  Internet Explorer 
5.5 is located on the ScanMaster 2.05.01 CD-ROM in the IE55 folder and is called 
ie5setup.exe. If Pervasive v8/v9 Workgroup Engine is not installed, you will receive a 
message that Pervasive must be installed prior to the ScanMaster 2.05.01 install.  If 
the version requirements of either Pervasive or Internet Explorer are not met, the user 
will be notified and the install will terminate. 

11.  Validate the computer name and server name is correct.  Click Next. 

The Select Installation Location window displays with C: selected. 

12. Select (click) the drive designation where you would like to install the ScanMaster 
program files.  Click Next to continue. 

The Select Shared Drive screen displays.   

13. Click the field selection arrow and choose the drive you would like to map to the 
shared ScanMaster files on the server.  Click Next to continue.  

The Confirm Selections screen displays. 

14. Click Next to continue.  

ScanMaster is loaded as the progress bar appears.  When finished copying a message 
box displays saying “Are you sure you want to add the information in 
C:\Grocery\V8/V9Wrkstn.reg to the registry?” (for Windows 2000 Professional and 
Windows XP Professional installations). 

15. Click Yes. 

Note: A message box displays confirming that the information has been successfully 
entered into the registry. 

16. Click OK. 

A warning message appears describing the consequences of performing a restart 
during the MS Scripting Engine and MDAC installation. 

17. Click OK. 

Note: If this is a Windows XP Professional installation, the ScanMaster Server 
Database Creation Utility displays.  Skip to step 25. 

A message displays, asking if you are sure you want to install Windows Script 5.6. 

18. Click Yes. 

The Windows Script 5.6 License Agreement appears. 

19. Click Yes to accept. 

The Windows Script 5.6 files are copied.  A message displays stating that Windows 
Script 5.6 is now installed. 

20. Click OK. 
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NOTE:  If you are prompted whether you wish to restart your computer, press NO.  
DO NOT RESTART THE COMPUTER at this point 

The Microsoft Data Access Components 2.8 Setup begins, and the End User License 
Agreement displays. 

21. Click the checkbox to accept the terms of the license agreement. 

The MDAC Detecting In Use Files window displays. 

22. Click Next to continue. 

The Installing the Software window displays. 

23. Click Finish. 

The MDAC components are installed. 

Note:  It may take a few moments for the files to begin copying.   

After the files are copied, the setup completions window displays. 

24. Click Close. 

The ScanMaster Server Database Creation Utility displays. 

25. Enter the user’s password if any and click CreateDB button. 

In the Database Creation Status section a green message will appear: 

ScanMaster DBName created successfully. 

ScanMaster Database created successfully. 

26. Click Exit. 

The install now creates the ScanMaster Users. 

The InstallShield Wizard Complete window displays. 

27.  Select “Yes, I want to restart my computer now” and click Finish. 

 

Upgrading ScanMaster 2.05.01 on the Back Office Workstation 
Ensure that you are logged on to the back office workstation as the Administrator and 
that you have performed the upgrade to Pervasive v8.x/v9.x Workstation Engine (see 
page 47).   

1. Insert the CD labeled ScanMaster Version 2.05.01 into the Server CD-ROM drive. 

2. From the Task Bar, click Start→Run. 

The Run dialog box displays. 

3. Click Browse. 

4. Look in the CD-ROM drive. 

5. Double-click the Scan2base folder to display the contents. 
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6. Double-click SETUP.EXE and click OK to launch the ScanMaster installation 
procedure. 

An Information screen appears. 

Read screen for requirements and Click OK. 

The ScanMaster Welcome window displays 

If requirements on the Information page have NOT been met select Cancel, then select 
YES.      

7. Click Next to begin the installation. 

The Install Requirements Screen displays.   

8. Confirm the installation requirements have been met and click Next continue. 

The Enter Text dialog box appears.  

9. Confirm the currently logged on user is the Administrator, then click Next. 

The Choose Installation Type window displays.  

10. Select Back Office - Upgrade then click Next. 

Select the Currently installed version of ScanMaster window displays. 

11. Confirm version of ScanMaster upgrading from, and then click Next. 

The Confirm Selections window displays. 

12. Click Next to continue. 

ScanMaster is loaded as the progress bar appears.  After ScanMaster is finished 
loading, a Registry Editor Message box appears which says “Are you sure you want to 
add the information in C:\Grocery\V8/V9Srv.reg to the registry?” 

13. Click Yes. 

A Registry Editor message appears which says “Information in 
C:\Grocery\V8/V9Srv.reg has been successfully entered into the registry. 

14. Click OK. 

A warning message appears describing the consequences of performing a restart 
during the MS Scripting Engine and MDAC installation. 

15. Click OK. 

If the operating system is Windows XP Professional, the ScanMaster Server Database 
Creation Utility will display.  Skip to step 24. 

16. Click YES to install Windows Script 5.6. 

17. Click YES for the License Agreement for Windows Script 5.6. 

18. Click OK to finish the installation. 

Note: This next selection is extremely important as the ScanMaster 2.05.01 
Upgrade will not continue if the system is restarted now. The MDAC End User 
License screen will then display. 
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19. Click NO to not reboot at this time if prompted. 

20. Click the checkbox to accept the terms of the license agreement and click Next. 

21. If the MDAC Detecting In Use Files window displays, click Next. 

The MDAC Detecting In Use Files window displays.  If the file w3dbsmgr displays in 
the in use files box, do not shut it down.   

The MDAC Installing the Software window displays. 

22. Click Finish. 

The MDAC components are installed.   

Note:  It may take a few moments for the files to begin copying. 

After the files are copied, the Setup Complete window displays, Click CLOSE. 

23. If prompted, select “I will restart the system myself”, and Click Finish. 

If upgrading from ScanMaster 1.02.xx, 1.03.xx, 1.04.xx or 2.00.xx,  the ScanMaster 
Server Database Creation Utility will display. If not, skip to step 26. 

24. Enter the user’s password if any and click CreateDB button. 

In the Database Creation Status section a green message will appear: 

ScanMaster DBName created successfully. 

ScanMaster Database created successfully. 

25. Click Exit. 

The InstallShield Wizard Complete Screen displays with the “Yes, I want to restart 
my computer now” option selected.  

26. Click Finish to reboot the workstation. 

The Workstation restarts. 

27. Log onto the Workstation as the Administrator again.   

If upgrading from v2.05.01 then the upgrade is complete, otherwise the Welcome 
window for ScanMaster 2.05.01 Upgrade Part Two displays. 

28. Click Next. 

The Install Requirements Screen displays.   

29. Confirm the installation requirements have been met and click Next continue. 

The “Choose Installation Type” screen appears. 

30. Confirm installation type, and click Next continue. 

If upgrading from v2.01.00 or greater, the register conversion warning message 
displays. Confirm all server and back office applications are shut down, including EJ 
Processor.  Skip to step 33. 

The ScanMaster 2.05.01 File Conversion Utility window displays with the message: 

“It is required to close down all local ScanMaster applications on this workstation 
before continuing.” 
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31. Click OK. 

The Conversion Utility converts the necessary files.  The checkboxes next to these files 
get checked automatically as the conversion progresses. 
 
The application message shows at top of the screen  “Conversion completed.  Click 
Exit.” 

32. Click Exit. 

The register conversion warning message displays. Confirm all server and back office 
applications are shut down, including EJ Processor.  

33. Click OK. 

The conversion utility Part 2 screen displays briefly, processes, and then exits 
automatically. 

The ScanMaster Installation window appears stating the “Setup has finished”. 

34. Click Finish. 

35. If the old icon “Start NCR ScanMaster” does not appear on your desktop, the 
upgrade is complete.  If it still appears on your desktop, right-click the icon and 
select “Delete” from the pop-up menu. 

36. Confirm the deletion and click Yes. 

37. Right-click on the Start button and select Open All Users from the pop-up menu. 

38. Double-click on the Programs file folder. 

39. Right-click on NCR ScanMaster for Windows folder and select “Delete” from the 
pop-up menu. 

40. Confirm the deletion and click Yes. 

41. Close all open windows. 

Post Installation 

Norton AntiVirus (Windows XP Acer OEM Version) 
If your server has Norton AntiVirus installed, you will need to re-enable the Script 
Blocker.  

1. Double-click the Norton AntiVirus icon located in the system tray (to the left of 
the time). 

The Norton AntiVirus window displays 

2. Click the Script Blocking hyperlink in the middle of the window. 

3. Click the Enable button on the right of the window. 

4. Close all open windows. 
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PoS Workstation Setup 
This section describes the setup of a ScanMaster PoS Workstation.  Instructions for 
installing the operating system, all necessary prerequisite components of ScanMaster 
and the workstation, and installing or upgrading ScanMaster 2.05.01. 

Prerequisites 
• Operating System Installation CDs if system is not preloaded. 

• Pervasive v8.x/v9.x Workstation Engine CD  

• ScanMaster 2.05.01 Installation CD 

• Network access to the ScanMaster server with the ability to access the Server’s 
CD-ROM drive, if PoS Workstation is not equipped with a CD-ROM drive, 
and the ability to access the Server’s SCAN1DOS share. 

• If upgrading a 24 hour site, upgrade all PoS workstations prior to upgrading 
the Server and any Back Office Workstations. 

Fujitsu TeamPOS 3000XL PoS Workstation Combo Board Printer Jumper 
Settings 

 
Your TeamPoS 3000XL may contain the Combo Board to provide COM3, COM4 and 
six +12V USB connections pictured above 

 
The 7 connector jumper block (PRT1-7) defines the printer interface being used for 
COM3.  For Epson, Citizen, and TPG (Axiohm) printers the jumpers should be set to 
2-3, 5-6, 8-9, 11-12, 14-15, 17-18, and 20-21. 



 

2-56 Chapter 2: 2.05.01-050 Upgrade and Installation Procedures 

 

 

Fujitsu TeamPOS M PoS Workstation Switch Settings 
Before you perform any installation on the TeamPOS M PoS Workstation you must 
first set a bank of eight switch settings properly to enable the required ports. 

1. Remove the left side panel by sliding it forward. 

2. Locate the two sets of eight dip switches under the top cover of the workstation.  

3. Set the switch setting as follows on the bank to the left (nearest to the rear of the 
machine): 

Note: Switch position of “On” is down, and “Off” is up. 

• Switch 1 = ON 

• Switch 2 = OFF 

• Switch 3 = OFF 

• Switch 4 = OFF 

• Switch 5 = ON 

• Switch 6 = ON 

• Switch 7 = ON 

• Switch 8 = ON 

Note: After setting the switches on the retail I/O board, you must load 
C:\DRIVERS\PNT230.REG to install the COM ports properly within the registry.    
Do this by browsing to the directory, and double clicking on PNT230.REG, and 
clicking YES to the “Are you sure…” prompt, and OK to “…information entered…” 
prompt. 
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Operating System Installation for the PoS Workstation 
The Windows XPe operating system is preloaded on the Fujitsu TeamPOS 2000 
models M and S.  The Microsoft WePOS operating system is preloaded on the Fujitsu 
TeamPOS 3000XL and TeamPOS 3000XE models. 

Note: It is highly recommended that an image of this installation be saved prior to 
installing any software or making any changes to the workstation. 

Microsoft WePOS PoS and Windows XPe (Embedded) PoS Workstation 
Configuration  

This manual assumes that the installation of Microsoft WePOS or Windows XPe 
(Embedded) has already been performed on the PoS workstation.  Whether the 
workstation was loaded using a Ghost image or whether your workstation was 
preloaded with Microsoft WePOS / Windows XPe (Embedded), you must perform 
the following steps prior to beginning the Pervasive and ScanMaster installation: 

Note:  Turn off the windows firewall on the TP3000XL and TP3000XE so it will not 
interfere with the installation 

Note:  Change to "Classic Start menu" by right clicking on "Start" then selecting 
"Properties". 

1. Configure TCP/IP Network Protocol 

2. Join the Store Workgroup 

3. Map a network drive to the server CD-ROM drive. 

4. Installing the XPe Patch on the workstation (see page 60) 

5. Installing the OPOS Drivers (see page 63). 

Configuring TCP/IP Network Protocol  
1. Log into the workstation as the Administrator (with no password). 

2. On the PoS Workstation, press the Start  key on the keyboard. 

3. Select Settings. 

4. Select Network Connections. 

The Network Connections screen appears. 

5. Right-click on Local Area Connection. 

6. Select Properties. 

This Local Area Connections Properties Window appears. 

7. Highlight Internet Protocol (TCP/IP) and click the Properties button. 
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8. If the server is configured up for DHCP, confirm that the Obtain an IP Address 
automatically radio button is depressed. 
   
OR 
 
If the server is configured for Static IP Addressing, enter this Workstations IP 
Address, Subnet Mask and Default Gateway. 

Note: Consult your network administrator to obtain an IP Address and subnet mask. 

9. When finished select OK. 

You are returned to the Local Area Connection Properties screen. 

10. Select OK. 

11. Close all open windows. 

Joining the Store Workgroup 

1. On the PoS Workstation, press the Start  key on the keyboard. 

2. Select Settings. 

3. Select Control Panel. 

The Control Panel window appears. 

4. Double-click System. 

5. Select the Computer Name tab. 

6. Click Change. 

7. Select the Workgroup radio button. 

8. In the Workgroup field, enter Store (or the workgroup your network 
administrator has setup for your site). 

9. Click OK. 

After a few seconds, the welcome to the workgroup message displays.   

10. Click OK. 

A window that states you must restart this computer for the changes to take affect 
appears.  

11. Click OK. 

The System Properties window displays. Select OK. 

A window appears asking if you wish to restart now. 

12. Click Yes to restart the PoS Workstation. 

The system reboots. 
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Map the Network Drive  
Note: These steps assume that you have shared your server’s CD-ROM Drive with a  
Share Name of “CD_ROM”. 

1. Login as Administrator. 

Note:  Create a shortcut to the Windows Explorer on the TP3000XL/TP3000XE 
Microsoft WePOS image in the Accessories folder. 

a. Right click on "Start" 

b. Click on "Open All Users" 

c. Double click "Programs" 

d. Double click "Accessories" 

e. Right click in the white background of the "Accessories" folder and 
create a new shortcut 

f. Type C:\WINDOWS\explorer.exe in the window then click "Next" 

g. Change the name of the shortcut to Windows Explorer and click 
"Finish" 

h. Right click on the Windows Explorer just created 

i. Click on "Properties" 

j. Click on "Change Icon" 

k. Select the folder with magnifying glass Icon and then click "OK" 

l. Click "OK" to close the screen 

2. Press the Start  key on the keyboard. 

3. Select Programs →Accessories→Windows Explorer. 

The Explorer Window displays. 

4. Select Tools from the Menu bar. 

5. Select Map Network Drive from the drop-down menu. 

The Map Network Drive Window displays. 

6. Select G: in the Drive field. 

7. In the Folder field, type \\SERVER\CD_ROM. (If the server name is setup other 
than “Server” replace it here). 

8. Ensure that “Reconnect at Logon” checkbox is selected. 

9. Select Finish when done. 

You are connected to the CD-ROM drive on the server. 

Note: If prompted, enter the server Administrator user name and password. 

10. Close the window. 
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Note: If no CD is in the drive, you may receive a message that the device is not ready.  
Press Enter to clear the message. 

Disabling Windows Messenger (Does not apply to the TP3000XL/TP3000XE 
Microsoft WePOS image) 
Note: Before attempting to disable Windows Messenger, close all open windows. 

1. Double-click the Windows Messenger icon in the system tray, to the left of the 
time. 

The Windows Messenger window appears. 

2. On the Windows Messenger menu bar, select Tools, and the select Options from 
the pop-up menu. 

The Options window appears. 

3. Click the Preferences tab. 

4. Deselect the “Run this program when Windows starts.” checkbox, and then click 
OK. 

5. Close the Windows Messenger window. 

6. Click the Windows Messenger icon in the system tray, to the left of the time. 

7. Select Exit from the pop-up menu. 

8. Click OK. 

Installing Windows XPe Patch on the PoS Workstation (Does not apply to 
the TP3000XL/TP3000XE Microsoft WePOS image) 

1. Insert the CD labeled ScanMaster Version 2.05.01 into the Server CD-ROM drive. 

2. From the Task Bar, click Start→Run. 

The Run dialog box displays. 

3. Click Browse. 

4. Look in the CD-ROM drive. 

5. Double-click the XPePatch folder to display the contents. 

6. Double-click SETUP.EXE and click OK to launch the XPe patch installation 
procedure. 

The InstallShield Welcome window displays.   

7. Click Next. 

The Start Copying Files window displays. 

8. Click Next. 

The files are now installed. 
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Pervasive Installation 

Installing Pervasive Workstation Engine  
Note: For PoS Workstations running Embedded XP you must first run the patch 
located on the ScanMaster Installation CD before the Pervasive Workstation Engine.  
See page 60. 

This installation assumes you have a CD-ROM Drive in the PoS Workstation.  If you 
do not, you can run the installation over the network using the server’s CD ROM 
Drive. 

1. At the back office workstation, insert the CD labeled V8/V9 Workgroup Engine 
into the CD-ROM drive. 

Note: If the Autorun program starts, skip to step 10. 

2. Press the Start  key on the keyboard.  

3. Press <R> for Run. 

4. Press <ALT><B> for Browse. 

5. Press <ALT><I> for Look In. 

6. Press the Arrow Down key and highlight the CD-ROM drive on the server and 
press Enter. 

7. Press the Tab key until the first folder on the CD is highlighted. 

8. Press the Arrow Down key, highlight Setup and press Enter. 

9. Press Enter for OK to run Setup installation wizard. 

The Welcome screen appears. 

10. Press Enter for Next. 

The Software License Agreement Displays.  

11. Read the agreement and click “I accept….” Or press <Alt><A>then press Enter for 
Next. 

Note: You may also the up and down arrow keys. 

The Setup Type Screen Displays.  

12. Accept Complete and press Enter for Next. 

The Verification Window displays. 

13. Review the information and press Enter for Install. 

After Setup has completed copying files and starting services, the Setup Complete 
window displays. 

14. Press Enter for Finish. 
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The HTML help window displays with links to the Pervasive web site.  After closing 
this window, the Transactional Engine Test screen appears (within a few seconds). 

15.  Press Enter for Next. 

The Test Results will appear. 

16. Press Enter for Next. 

The Relational Engine Test Screen appears. 

17. Press Enter for Next. 

The Test Results will appear. 

18. Press Enter for Next. 

19. Press Enter for Finish. 
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OPOS Installation 

Installation Preparation 
Note: You should have already followed the steps outlined on page 57 to connect 
your workstation to the network. 

Note: Before beginning the OPOS installation below, you must first copy the 
\DRIVERS folder from the ScanMaster 2.05.01 Install CD to the hard drive of your 
workstation.  (You should have previously mapped a drive to the server’s CD-ROM 
drive – typically G:). 

 

OPOS Common Control (RCS) 
1. Login to the workstation as the Administrator. 

2. Using Windows Explorer, browse to the 
DRIVERS\TeamPoS3000_Software_Support\Drivers\OPOS\Common Controls 
folder on the workstation. 

3. Using Windows Explorer double-click on OposCCOs-1_10_000 file located in the 
DRIVERS\TeamPoS3000_Software_Support\Drivers\OPOS\Common Controls 
folder. 

The Welcome window displays. 

4. Click Next. 

The Readme File window displays       

5. Click NEXT. 

The Choose Destination Location window displays. 

6. Accept Default Folder and Click NEXT. 

The Backup Replaced OPOS CCO Files window displays. 

7. Verify that Yes is selected. Accept Default Backup Folder and Click NEXT. 

The Select OPOS CCO Components window displays. 

8. Verify that Both “Common Control Objects” and “OPOS Include Files” are 
selected. Click NEXT. 

The Start Installation window displays. 

9. Click NEXT. 

The Installation Complete window displays. 

10. Click FINISH. 
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FTXS OPOS (Fujitsu) 
1.   Login to the workstation as the Administrator. 

Using Windows Explorer, browse to the 
DRIVERS\TeamPoS3000_Software_Support\Drivers\OPOS\FTXSOPOS folder 
on the workstation. 

Using Windows Explorer double-click on FTXSOPOS_1_10_1 file located in the 
DRIVERS\TeamPoS3000_Software_Support\Drivers\OPOS\FTXSOPOS folder. 

The Welcome window displays. 

Click Next. 

The License Agreement window displays       

Accept the agreement and click NEXT. 

The Setup Type window displays 

Select the Platform Type that you are installing to. 

Note: Select TeamPoS 3000 for Models XL and XE.  

      Select TeamPoS 2000 for Models M and S units. 

Click NEXT. 

The Select Components window displays. 

Select (click) the following PoS devices to install, regardless of actual hardware 
configuration: 

• LineDisplay1_VF60(USB) 

• D22_25 MSR, Lock 

• ***CashDrawer (TeamPoS 2000) ***(TeamPoS 3000)  Depending on Platform 
Type 

• Keylock 133PQ 

• LineDisplay1_VF40_VF50 (Serial) 

• MSR 133PQ 

• POSKeyboard_133PQ 

• Scanner_SS1200 

• ScannerScale_Symphony_9950 

• ToneIndicator 133PQ 

Note: If using a 92M Keyboard, select “POSKeyboard_92R_92M_92U (Serial). 

      If using a 92U Keyboard, select “POSKeyboard_92U (USB). 

Click Next. 



  Chapter 2: 2.05.01-050 Upgrade and Installation Procedures 2-65 

 

If TeamPos 3000, Skip to step 12. 

The Select I/O Board Type & Base Address window displays. 

 Select “No I/O Board or no port setup required” 

Click NEXT. 

The Select OPOS Device Registry Settings Option window displays. 

Select “Customize Each Device Port Settings” 

Click NEXT. 

The Current Settings window displays. Verify Settings. 

Click NEXT. 

The Installation window displays. 

Click INSTALL. 

The Devices Logical Name window displays. 

Click NEXT. (D22_D25_MSR) 

Click NEXT. (D22_D25_KLK) 

Click NEXT. (VF60-1) 

Click NEXT. (FjMCPCD1) TeamPoS 2000, (TP3K_CD1) TeamPoS 3000 

Would you like to change secondary cash drawer settings question displays. 

      Click NO. 

Click NEXT. (fjkbdso) 

Click NEXT. (fjklkso) 

Click NEXT. (fjmsrso) 

Click NEXT. (FJPosKBTone) 

Click NEXT. (SlimScan1200) 

Click NEXT. (Fujitsu7521E_S) 

Click NEXT. (Fujitsu7521E_S_Scale) 

Click NEXT. (fjvfdso) 

If 92M Click NEXT. (ICL92RKeyboard) 

If 92M Click NEXT. (ICL92Operator) 

If 92M Click NEXT. (ICL92RKeylock) 

If 92M Click NEXT. (ICL92RTone) 

If 92M Click NEXT. (ICL92RMSR) 

The InstallShield Wizard Complete window displays. 

Click FINISH. 
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Epson OPOS (For Installations w/ Epson Printers) 
Note: Before beginning the OPOS installation below, you must first copy the 
\DRIVERS folder from the ScanMaster 2.05.01 Install CD to the hard drive of your 
workstation.  (You should have previously mapped a drive to server’s CD-ROM drive 
– typically G:). 

Note: If you are upgrading an existing Epson OPOS, Uninstall Epson OPOS ADK 
from Add/Remove Programs in Windows Control Panel before continuing. 

1. Login to the workstation as the Administrator. 

2. Using Windows Explorer, browse to the 
\DRIVERS\EpsonOPOS\OPOSADK\V250E\DISK1 folder. 

3. Double-click SETUP.EXE to launch the installation procedure.  

The Welcome Screen displays. 

4. Click Next. 

The Licensing Screen displays. 

5. Select the first radio button “I accept” and click Next. 

A confirmation screen displays. 

6. Click Yes. 

The Select Registry File screen displays. 

7. Select the first radio button “No registry file” and click Next. 

The User Information Screen displays. 

8. Fill in the Name and Company Information and click Next. 

The Destination Location Screen displays. 

9. Use the default location and click Next. 

The Select Install Module displays. 

10. Check (click) all three packages and click Next. 

The Select CO Type screen displays. 

11. Check (click) CCO (Common Control Object) and click Next. 

The Install Type screen displays. 

12. Select Full Install and click Next. 

The Select Program Folder screen displays. 

13. Accept the default and click Next. 

The Start Copying Files screen displays. 

14. Click Next. 

After file loading the Setup complete screen displays. 

15. Click Finish. 
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16. Close the readme windows. 

The “Do you want to Install TMUSB driver?” question appears. 

Note: If you are installing an Epson Printer (USB) select YES. (TeamPoS 3000                         
Models Only) 

     If you are installing an Epson Printer (Serial) select NO. 

The “Do you use Parallel I/F?” question appears. 

17. Click No. 

18. Close the Windows Explorer Window. 

19. Using Windows Explorer, browse to the 
\DRIVERS\EpsonOPOS\OPOSADK\V250E\SP6\disk1 folder. 

20. Double-click SETUP.EXE to launch the installation procedure.  

The Welcome Screen displays. 

21. Click Next. 

The Licensing Screen displays. 

22. Select the first radio button “I accept” and click Next. 

A confirmation screen displays. 

23. Click Yes. 

The Select Registry File screen displays. 

24. Select the first radio button “No registry file” and click Next. 

The Select Install Module displays. 

25. Click Next. 

The Start Copying Files screen displays. 

26. Click Next. 

After file loading the Setup complete screen displays. 

27. Click Finish. 

28. Close the readme windows. 

The “Do you want to Install TMUSB driver?” question appears. 

      Note: If you are installing an Epson Printer (USB) select YES. (TeamPoS 3000 
Models Only) 

     If you are installing an Epson Printer (Serial) select NO. 

The “Do you use Parallel I/F?” question appears. 

29. Click No. 

30. Close the Windows Explorer Window. 

The OPOS Device Screen appears. 

31. Right-click POSPrinter and select “Add new device”. 
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The Add New Device Screen appears. 

32. Select the device name (TM-H6000II or TM-H6000III) of your Epson printer and 
enter the name of “DefaultPrinter” (no spaces) in the Add New LDN field at the 
bottom of the screen. 

 Note: If using a USB Printer, select TM-H6000IIU or TM-H6000IIIU in the Select                         
detailed Model field at the top right of the screen. The used port should display USB. 

33. Click Next. 

Note: If a SetupPOS window displays stating “This setting may cause a port  
conflict if the device is not set up properly.” Click OK. 

The Communication Settings Screen appears. 

Note: If USB port is being used, click on Auto Settings and accept detected port. 

34. Configure your printer’s port setting and click Finish. 

When finished the OPOS Device Screen appears. 

35. Right-click MICR and select “Add new device”. 

The Add New Device Screen appears. 

36. Select the device name (TM-H6000II or TM-H6000III) for your Epson MICR and 
enter the name of “DefaultMICR” (no spaces) in the Add New LDN field at the 
bottom of the screen. 

Note: If using a USB Printer, select TM-H6000IIU or TM-H6000IIIU in the Select 
detailed Model field at the top right of the screen. The used port should display 
USB. 

37. Click Next. 

Note: If a SetupPOS window displays stating “This setting may cause a port 
conflict if the device is not set up properly.” Click OK. 

The Communication Settings Screen appears.  

Note: If USB port is being used, Click on Auto Settings and accept detected port. 

38. Configure your MICR port setting and click Finish. 

When finished the OPOS Device Screen appears. 

39. Right-click CashDrawer and select “Add new device”. 

The Add New Device Screen appears. 

40. Select the device name (Multi_A) for your Cash Drawer and enter the name of 
“DefaultDrawer” in the Add New LDN field at the bottom of the screen. 

Note: If using a USB Printer, Select Multi_AU in the Select detailed Model field at 
the top right of the screen. The used port should display USB. 

41. Click Next. 
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The Communication Settings Screen appears.  

Note: If USB port is being used, Click on Auto Settings and accept detected port. 

42. Configure your Cash Drawer’s port setting to the same as your printer in step 23 
and click Finish. 

43. Click OK to the warning message. 

When finished the OPOS Device Screen appears. 

44. Close the Epson OPOS Window. 

TPG OPOS (For Installations w/ TPG A760, A776, A794 Printers) 
Note: Before beginning the OPOS installation below, you must first copy the 
\DRIVERS folder from the ScanMaster 2.05.01 Install CD to the hard drive of your 
workstation.  (You should have previously mapped a drive to server’s CD-ROM drive 
– typically G:). 

1. Login to the workstation as the Administrator. 

2. Open Windows Explorer and browse to the \DRIVERS\TPG OPOS and 776 USB 
Driver folder. 

3. Double-click Install.bat 

The Printer Model Menu displays. 

4. Press the letter corresponding to the Printer Model being installed. 

Window displays asking if you are sure you wish to update the registry. 

5. Click Yes. 

Window displays stating information has been successfully entered into the registry. 

6. Click OK. 

Window displays stating DLLRestgisterServer in tpg.dll succeeded. 

7. Click OK. 

Window displays stating oposposprinter.ocx succeeded. 

8. Click OK. 

Window displays stating oposcasherdrawer.ocx succeeded. 

9. Click OK. 

Window displays stating oposmicr.ocx succeeded. 

10. Click OK. 

The TPG OPOS Printer is installed. 

Note: The configuration portion of the TPG Printer is handled by the ScanMaster PoS 
Workstation installation. 
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TPG USB Printer Driver Installation 
Note: In addition to OPOS Installation, the TPG USB Printer must have the         
Windows driver installed. 

1.  Power the Register off. 

2.  Plug in the TPG USB Printer into the red 24v USB port on the register and Start up. 

    Windows will discover the new device and attempt to install. The Hardware Update Wizard 
screen displays. 

    “Can Windows connect to Windows Update” question appears. 

3.  Select “No. Not this time” and Click NEXT. 

“What do you want the wizard to do?” question appears. 

4. Select “Install from a list or specific location (Advanced)” and Click NEXT. 

The search and installation option screen displays. 

5. Select (check) “Include this location in the search” and Click Browse. 

6. Path to C:\Drivers\TPG OPOS and 776 USB Driver and Click NEXT. 

A Hardware Installation warning displays. 

7.   Click Continue Anyway. 

Windows will install the Printer 

8. Click Finish. 
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Configuring Digital Video on TeamPoS M unit 
The TeamPoS 2000 M unit has three video ports on the back of the unit: 

 

 

Only two of these three ports can be used at one time: 

• Analog (Standard VGA) and DVI 

• Analog (Standard VGA) and FJLCD  

 

The DVI port can be used with the Fujitsu D15 monitor with a DVI cable. The FJLCD 
port can be used with the Fujitsu D12 monitor.  The D15 monitor can also be used 
with the standard VGA (Analog) port with a VGA cable instead of DVI. 

Units are preconfigured for either DVI or FJLCD.  This section will describe the 
process to switch between one set of ports to the other. 

Switching TeamPoS 2000 M from DVI to FJLCD 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

The Display Properties window displays.  

2. Click Settings tab. 

3. Select “1. Default Monitor…” from the Display drop-down.   

4. Click Advanced button. 

5. Click Adapter tab. 

6. Click Properties button. 

7. Click Driver tab. 

8. Click Update Driver… button. 

9. Select “Install from a list or specific location…” radio-button and click Next. 

10. Select “Don’t search. I will choose the driver to install” radio-button and click 
Next.. 

11. Click Have Disk… button. 
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12. Click Browse button. 

13. Browse to the “C:\DRIVERS\Win XP\VIDEO\LCD + Analog” directory, and 
click Open. 

14. Click OK. 

15. Click Next. 

A Hardware Installation window will display stating that the driver you are 
installing has not passed Windows Logo testing to verify its compatibility 
with Windows XP. 

16. Click Continue Anyway button. 

The driver will install as the progress bar appears.  When installation is complete the 
Completing the Hardware Update Wizard window appears. 

17. Click Finish. 

18. Click Close. 

A System Settings Change message appears asking if you wish to restart your 
computer now.  

Note: It is very important that the system is NOT restarted at this point.  The 
driver must be installed for the second display before restarting the system. 

19. Click No. 

20. Click OK. 

The Display Properties window displays, with the Settings Tab active.  

21. Select “2. Plug and Play Monitor…” from the Display drop-down.   

22. Click Advanced button. 

23. Click Adapter tab. 

24. Click Properties button. 

25. Click Driver tab. 

26. Click Update Driver… button. 

27. Select “Install from a list or specific location…” radio-button and click Next. 

28. Select “Don’t search. I will choose the driver to install” radio-button and click 
Next.. 

29. Click Have Disk… button. 

30. Click Browse button. 

31. Browse to the “C:\DRIVERS\Win XP\VIDEO\LCD + Analog” directory, and 
click Open. 

32. Click OK. 

33. Click Next. 
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A Hardware Installation window will display stating that the driver you are 
installing has not passed Windows Logo testing to verify its compatibility 
with Windows XP. 

34. Click Continue Anyway button. 

The driver will install as the progress bar appears.  When installation is complete the 
Completing the Hardware Update Wizard window appears. 

35. Click Finish. 

36. Click Close. 

A System Settings Change message appears asking if you wish to restart your 
computer now.  

37. Click Yes. 

System reboots, and the monitor attached to the FJLCD port will become active.  You 
can now disconnect the monitor connected to the DVI port when the TeamPoS unit is 
powered down. 

Switching TeamPoS 2000 M from FJLCD to DVI 
1. Right-click on the Windows Desktop and select Properties from the pop-up menu. 

The Display Properties window displays.  

2. Click Settings tab. 

3. Select “1. Default Monitor…” from the Display drop-down.   

4. Click Advanced button. 

5. Click Adapter tab. 

6. Click Properties button. 

7. Click Driver tab. 

8. Click Update Driver… button. 

9. Select “Install from a list or specific location…” radio-button and click Next. 

10. Select “Don’t search. I will choose the driver to install” radio-button and click 
Next.. 

11. Click Have Disk… button. 

12. Click Browse button. 

13. Browse to the “C:\DRIVERS\Win XP\VIDEO\DVI + Analog” directory, and 
click Open. 

14. Click OK. 

15. Click Next. 

A Hardware Installation window will display stating that the driver you are 
installing has not passed Windows Logo testing to verify its compatibility 
with Windows XP. 
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16. Click Continue Anyway button. 

The driver will install as the progress bar appears.  When installation is complete the 
Completing the Hardware Update Wizard window appears. 

17. Click Finish. 

18. Click Close. 

A System Settings Change message appears asking if you wish to restart your 
computer now.  

Note: It is very important that the system is NOT restarted at this point.  The 
driver must be installed for the second display before restarting the system. 

19. Click No. 

20. Click OK. 

The Display Properties window displays, with the Settings Tab active.  

21. Select “2. Plug and Play Monitor…” from the Display drop-down.   

22. Click Advanced button. 

23. Click Adapter tab. 

24. Click Properties button. 

25. Click Driver tab. 

26. Click Update Driver… button. 

27. Select “Install from a list or specific location…” radio-button and click Next. 

28. Select “Don’t search. I will choose the driver to install” radio-button and click 
Next.. 

29. Click Have Disk… button. 

30. Click Browse button. 

31. Browse to the “C:\DRIVERS\Win XP\VIDEO\DVI + Analog” directory, and 
click Open. 

32. Click OK. 

33. Click Next. 

A Hardware Installation window will display stating that the driver you are 
installing has not passed Windows Logo testing to verify its compatibility 
with Windows XP. 

34. Click Continue Anyway button. 

The driver will install as the progress bar appears.  When installation is complete the 
Completing the Hardware Update Wizard window appears. 

35. Click Finish. 

36. Click Close. 
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A System Settings Change message appears asking if you wish to restart your 
computer now.  

37. Click Yes. 

System reboots, and the monitor attached to the DVI port will become active.  You can 
now disconnect the monitor connected to the FJLCD port when the TeamPoS unit is 
powered down. 
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Configuring Digital Video on the TeamPoS 3000XL PoS 
The TeamPoS 3000XL has two video ports on the back of the unit: 

 

Setting up the TeamPoS 3000XL with dual monitors 
1. Click on "Start / Settings / Control Panel" 

2. Double click on Intel Extreme Graphics 2 M 

3. Click on the left tab (Display Devices) 

• Under the section "Multiple display" 

i.  Click "Extended Desktop" 

ii. Primary Device – select dropdown "Digital Display" 

iii. Secondary Device – select dropdown "Monitor" 

4. Click on the left tab (Display Settings) 

• Click on the top tab (Digital Display) 

i. Select Screen Resolution 800 x 600 

• Click on the top tab (Monitor) 

i. Select Screen Resolution 800 x 600 

• Click "OK" 

5. Click "OK" to confirm the desktop change 

NOTE:  The following step must be done to write the monitor configuration to the 
registry.  

1. Click on "Start / Programs / Display_Select" and click on Display_Select 

2. The Display Selector displays 

• Under the section "Extended Mode (Independent Screen)" 

i. Click "Primary: Digital Monitor / Secondary: Analog Monitor" 

• Click "Register" 
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Touch screen Driver Installation 
This section describes the steps to configure “Touch” on the Fujitsu D25, D15, D12, 
and A12 Flat panel displays. 

Fujitsu D25 Touch Screen Drivers 
The D25 monitor is a 15” flat panel display that can connect to a TeamPoS 2000 M unit 
or TeamPoS 3000 XL with either a DVI or VGA cable, and to the TeamPoS 2000 S or 
TeamPoS 3000 XE unit with a VGA cable. 

NOTE:  The display configuration must be complete before installing the ELO touch 
drivers. 

Installing the ELO Touch Driver 

1. Login to the workstation as Administrator 

2. Power for the D25 monitor is from the 12V powered USB which also provides the 
touch capability. 

3. Open Windows Explorer and browse to the C:\Drivers\TeamPoS 
3000_Software_Support\Drivers\LCD Display Touch\TeamPoS 3000 
D25\Driver folder. 

4. Double click "EloSetup.exe" 

5. Click "Install USB Touchscreen Drivers" then click "Next" 

6. The License Agreement displays.  Click "Yes" 

7. The Elo Touchscreen install finishes and is checked to "Calibrate Elo Touchscreen 
monitors".  Click "Finish" 

8. The Elo touchscreen is intelligent and calibrates either one monitor or two 
monitors if you have the display configuration setup for two monitors. 

9. Turn off the touch on the customer Monitor when using two touch monitors by 
doing the following. 

a. Click the Elo Icon in the desktop system tray. 

b. Click the tab "Properties 1 or 2" and click "Identify Monitor" to find out 
which monitor is the customer. 

c.  Click on "Advanced" in the Properties tab for the customer Elo touch . 

d. Click the box under "Options" to "Disable touch" and click "OK". 

e. Click "OK" to exit the Elo Properties screen. 

 

Fujitsu D15 Touch Screen Drivers 
The D15 monitor is a 15” flat panel display that can connect to a TeamPoS 2000 M unit 
with either a DVI or VGA cable, and to the TeamPoS 2000 S unit with a VGA cable. 
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Note: Before beginning the driver installation below, you must first copy the 
\DRIVERS folder from the ScanMaster 2.05.01 Install CD to the hard drive of your 
workstation.  (You should have previously mapped a drive to server’s CD-ROM drive 
– typically G:). 

Setting up the Fujitsu D15 monitor requires the following processes to be done: 

• Install the driver 

• Install the driver utility and calibrate the touch 

• Setup the driver for use with ScanMaster 

Install the 3M TouchWare driver 
1. Login to the workstation as the Administrator. 

2. If the D15 USB connection was not plugged in, before Windows was started on the 
PoS Workstation, then plug the USB cable from the D15 monitor into the USB port 
on the back of the PoS Workstation. 

If the Found New Hardware Wizard window displays, skip to step 5. 

3. From the Windows XP task bar, click on Start → Settings  Control Panel → 
Administrative Tools → Computer Management. Select Device Manager from 
the Tree. 

4. Right click on the “3M USB TouchScreen – EX II” from the list of devices under 
“Other Devices” on the right, and select “Update Driver…” from the pop-up 
menu. 

The Hardware Update Wizard screen appears, and prompts to connect to Windows 
Update. 

5. Select “No, not this time” and click Next to continue. 

6. Select the “Install from a list or specific location…” checkbox and click Next to 
continue. 

7. Uncheck the “Search removable media…” checkbox. 

8. Check the “Include this location in the search…” checkbox, and click Browse. 

The Browse for Folder window displays. 

9. Browse to the C:\DRIVERS\D15\DISK1 folder and click OK. 

10. Click Next. 

11. The “Completing the Hardware Update Wizard” window displays.  Click Finish. 

12. Close all open windows. 

Install 3M TouchWare Driver Utility on a Single monitor system. 
Note: Only use this section if you have only a cashier display on the PoS 
Workstation.  If the workstation has a Cashier and Customer display then skip to the 
next section. 
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1. Login to the workstation as the Administrator. 

2. Using Windows Explorer, browse to the DRIVERS\D15\DISK1 folder on the 
workstation: 

3. Double-click SETUP.EXE. 

The TouchWare 5.64 SR5a setup screen displays 

4. Click Next. 

5. Select “I Accept – TouchWare installation will continue” radio-button, and click 
Next. 

6. Select “USB” radio-button, and click Next. 

7. Select “Express Install…” radio-button and click Next. 

After the utility is installed, the Setup Complete window displays 

8. Uncheck the “Yes, I want to view the readme file” checkbox, and click Finish. 

If the PoS Workstation only has one monitor for Cashier display skip to step 10  

A TouchWare monitor message appears stating that the “Touch Screen mapping for 
your system is incorrect. “ 

9. Click OK. 

The Touch Screen Calibration Needed window displays. 

10. Ensure the “Do not remind me…” check box is not selected, and click Calibrate.   

11. Calibrate the touch screen by touching and holding the indicated spots on the 
display, until it displays “Touch Enable” at each location.   

12. Drag your finger over the display and ensure the cursor follows.  If correct click 
Done, otherwise click Calibrate, and repeat the previous step. 

Install 3M TouchWare Driver Utility on a Dual monitor system   
Note: Only use this section if you have both a cashier and customer display on the 
PoS Workstation.  If the workstation has only a Cashier display then skip to the 
previous section. 

1. Login to the workstation as the Administrator. 

2. Using Windows Explorer, browse to the DRIVERS\D15\DISK1 folder on the 
workstation: 

3. Double-click SETUP.EXE. 

The TouchWare 5.64 SR5a setup screen displays 

4. Click Next. 

5. Select “I Accept – TouchWare installation will continue” radio-button, and click 
Next. 

6. Select “USB” radio-button, and click Next. 
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7. Select “Express Install…” radio-button and click Next. 

After the utility is installed, the Setup Complete window displays 

8. Uncheck the “Yes, I want to view the readme file” checkbox, and click Finish. 

A TouchWare monitor message appears stating that the “Touch Screen mapping for 
your system is not correct. “ 

9. Click OK. 

10. Close all open windows. 

11. Double-click the TouchWare icon on the desktop. 

A Monitor Setup message appears stating that the “Touch Screen mapping for your 
system is not correct.” 

12. Click OK. 

A Monitor Setup message appears stating that the “During the mapping process…” 

Note: Important!! Steps 14 and 15 are timed, so read the instructions first and 
respond appropriately. If you do not respond appropriately before the system times 
out, configuration will not be correct. 

13. Read all the instructions on the message and Click OK.   

14. A large numeral “1” will appear on one of the screens.   

• If the “1” appears on the D15 monitor touch the screen.  The message “Touch 
screen mapped successfully to monitor 1” will display.   

• If the monitor that is displaying the “1” is NOT the D15 monitor wait until the 
message “No touch screen mapped” message appears, and click OK. 

15. A large numeral “2 will appear on one of the screens.   

• If the “2 appears on the D15 monitor touch the screen.  The message “Touch 
screen mapped successfully to monitor 2 will display.   

• If the monitor that is displaying the “2 is NOT the D15 monitor wait until the 
message “No touch screen mapped” message appears, and click OK. 

16. Click Close. 

The Touch Screen Calibration Needed window displays. 

17. Ensure the “Do not remind me…” check box is not selected, and click Calibrate.   

18. Calibrate the touch screen by touching and holding the indicated spots on the 
display, until it displays “Touch Enable” at each location.   

19. Drag your finger over the display and ensure the cursor follows.  If correct click 
Done, otherwise click Calibrate, and repeat the previous step. 
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Fujitsu D12/A12 Touch Screen Drivers 
The D12 monitor is a 12” flat panel display that connects to a TeamPoS 2000 M unit in 
the FJLCD port on the back of the unit.  The A12 monitor is a 12” flat panel display 
that can connect to both the TeamPoS 2000 M and S units in the standard VGA port 
on the back of the unit. 

Note: Before beginning the driver installation below, you must first copy the 
\DRIVERS folder from the ScanMaster 2.05.01 Install CD to the hard drive of your 
workstation.  (You should have previously mapped a drive to server’s CD-ROM drive 
– typically G:). 

1. Login to the workstation as the Administrator. 

2. Using Windows Explorer, browse to the DRIVERS\TOUCHDRIVER folder on the 
workstation: 

3. Double-click SETUP.EXE. 

The Fujitsu Touch Panel Setup Screen displays. 

4. Select “1. Non Plug and Play Device”, and click OK. 

When finished the “Install is now complete..” screen displays. 

5. Click OK. 

The Touch Panel Settings screen displays and the COM1 will be selected. 

6. Click OK. 

7. Click Yes to restart the workstation. 

Dual Screen Installations 
Note: The following section is for dual display installs only. 

1. After reboot, logon as Administrator  

2. Do the following if the Windows desktop (Icons, and task bar) is on the monitor 
used for the Customer display. 

3. Right click on an unused space on the desktop and select Properties from the pop-
up menu. 

The display properties window appears. 

4. Select display number 1, from the Display drop down combo-box. 

5. Check the “Use this device as the primary monitor” checkbox. 

6. Click Apply. 

7. Select display number 2, from the Display drop down combo-box. 

8. Uncheck the “Extend my Windows desktop onto this monitor.” 

9. Click Apply. 

The windows desktop moves to the cashier display monitor. 
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10. Check the “Extend my Windows desktop onto this monitor.” 

11. Click OK. 

Calibrating the Fujitsu D12 or A12 Touch Screen 
1. From the Windows Taskbar, click Start→Settings→Control Panel. 

2. (Optional) Click Switch to Classic View. 

3. Double-click Touch Panel. 

4. Click the Calibration Tab. 

5. Select “20 Point Calibration (5 x 4 Matrix)” in the “Accuracy Required” section. 

6. Click Apply. 

7. Click Calibrate Now. 

8. With a pointed instrument click the red x location on the screen.  The x location 
will move around the screen, repeat at each location (20 times). 

9. Click Update. 

10. Click Audible Feedback Setup tab. 

11. Enable the Sounds Enabled checkbox. 

12. Select the Sound When Pressed radio button. 

13. In the “Tone Setting” box, set the frequency to 800Hz. 

14. Click OK. 

15. Close all open windows. 

Fujitsu D22_D25 TeamKey 32-Key Mapping Utility 
Note: The following steps are only required if the workstation is running a Fujitsu 
Touch with D22_D25 TeamKey (32-key) keyboard. 

1. Login to the workstation as the Administrator. 

2. Using Windows Explorer, browse to the C:\Drivers\TeamPoS 
3000_Software_Support\Drivers\Keyboards\D22 and D25 Keypad_MSR\KB 
ReMapper. 

3. Double-click KeyEdit.exe. 

The "Team Keymap Edit" displays. 

4. From the toolbar, select File followed by Open.  

5. The file "Keypad32SM-TP3k.DAT" should show in the window.  If not, browse 
(using "Look in:" at the top) to the C:\Drivers\TeamPoS 
3000_Software_Support\Drivers\Keyboards\D22 and D25 Keypad_MSR\KB 
ReMapper folder of the PoS Workstation and click the KEYPAD32SM-TP3k.DAT 
file. 
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6. Click Open. 

The keymap screen displays. 

 
7. From the toolbar, click Keyboard followed by Keymap Change. 

8. Keymap change is started. Is it OK? displays.  Click YES. 

9. Keymap change ended normally. Displays.  Click OK 

10. Close the open window. 

11. Contents of editing are lost. Is it OK? displays. Click YES 

12. Close all open windows. 

 

Fujitsu TeamKey 32-Key Mapping Utility 
Note: The following steps are only required if the workstation is running a Fujitsu 
Touch with TeamKey (32-key) keyboard. 

13. Login to the workstation as the Administrator. 
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14. Using Windows Explorer, browse to the DRIVERS\32KEYMAP folder on the 
workstation. 

15. Double-click SETUP.EXE. 

The mapping utility setup screen displays. 

16. Click OK. 

17. Click the large install button. 

18. Click Continue. 

Note: If any file version conflict messages appear, click YES to keep the file. 

19. Click OK when finished installing. 

20. From the Task Bar, click Start→Programs→Fujitsu 32-key Keypad Mapping 
Utility→ Fujitsu 32-key Keypad Mapping Utility. 
The Fujitsu 32-Key Keypad Mapping Utility screen appears. 

21. From the toolbar, select File followed by Open.  

22. Browse to the C:\DRIVERS\32KEYMAP folder of the C:\ of the PoS Workstation 
and click the KEYPAD32SM.DAT file. 

23. Click Open. 

The colored key mapping screen displays. 

 
24. From the toolbar, click Keypad followed by Flash Keymap to Memory. 

25. An “Are you ready…” window displays, click YES. 

26. A “Flashing Keypad memory completed” window displays, click OK. 
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27. When finished, close the Fujitsu 32-Key Keypad Mapping Utility window. 

28. A “Scratch current work area without saving modifications” window displays, 
click Yes. 

29. Close all open windows. 

Disabling Windows Messenger 
Note: Before attempting to disable Windows Messenger, close all open windows. 

1. Double-click the Windows Messenger icon in the system tray, to the left of the 
time. 

The Windows Messenger window appears. 

2. On the Windows Messenger menu bar, select Tools, and the select Options from 
the pop-up menu. 

The Options window appears. 

3. Click the Preferences tab. 

4. Deselect the “Run this program when Windows starts.”checkbox, and then click 
OK. 

5. Close the Windows Messenger window. 

6. Click the Windows Messenger icon in the system tray, to the left of the time. 

7. Select Exit from the pop-up menu. 

8. Click OK. 

 



 

2-86 Chapter 2: 2.05.01-050 Upgrade and Installation Procedures 

ScanMaster 2.05.01 

Full Installation ScanMaster 2.05.01 on the PoS Workstation  
Follow this procedure for all ScanMaster PoS Workstations. This section assumes that 
the prerequisite software has been installed and the ScanMaster server’s shared drive 
has been mapped as drive F: on the PoS Workstation.  

1. At the PoS Workstation, press the Start  key on the keyboard. 

2. Press <R> for Run. 

3. Type the following path: F:\WinReg\Install\Setup.exe. 

4. Press Enter for OK to run the setup executable. 

The Installation Wizard Welcome window displays. 

5. Press Enter for Next to continue. 

The Setup Type window displays. 

6. Select New Installation and press Enter for Next to continue. 

The Register Number window displays. 

7. Enter the register number and Press Enter for Next. 

8. If installing to an NCR terminal, the question “Does this POS have a DVI 
DynaKey Attached?” appears.  Select appropriate response and press Enter for 
Next to continue. 

The Start Copying Files window displays. 

9. Review the information to ensure that it matches your configuration and Press 
Enter for Next. 

After the files are copied, the ScanMaster MakePOS window appears with a warning 
about COM Port settings. 

Note: Make sure you do not use the same COM Port below for different devices.  In 
addition, some of the field availability is dependent on other settings on the screen.  

10. Press Enter for OK to clear the message. 

Note: After each of the following steps (11 through 47), move to the next field and 
step by using the Tab or Enter keys.  Move to the next “tab” by clicking on the 
appropriate tab with a mouse, or selecting the tab by holding down the ALT key 
and the appropriate hotkey for the tab. 
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11. Enter the Store Number. 

12. Enter the 2-digit Workstation Number. 

13. Enter the ScanMaster Server Name or accept the default. 

Note: Select a specific Radio-button option without a mouse by using the up/down 
or left/right arrow keys.  Once a selection is made, use the TAB button to move to the 
next step, or set of options. 

If installing to NCR hardware refer to Appendix D for steps. 

14. Select whether to reboot the workstation after end-of-day processing.  Change the 
selection by using the arrow keys, or selecting with the mouse. 

15. Change to the “Devices” tab by holding down the ALT key and tapping the “D” 
key, or selecting with the mouse. 
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16. Select the workstation’s printer type. 

17. Select the printer’s COM Port. 

18. Select the printer’s Baud Rate. 

19. Select whether Portrait Check Writing is being used. 

20. Select whether to enable MICR (Magnetic Ink Character Recognition) on the 
printer. 

21. Select the workstation’s keyboard type. 

22. If 92M or Partial touch with TeamKey is selected, then select if the Keyboard MSR 
is installed. 

23. If 92M keyboard is selected, then select the keyboard’s COM Port. 

24. Select the type of Scanner/Scale being used. 

25. If a scanner/scale other than “None” is selected then select the Scanner/Scale’s 
COM Port.  

26. If a scanner/scale other than “None” is selected then select the Scanner/Scale’s 
Baud Rate.  

27. Select the cash drawer open sensor setting for normally low or high.  (OPOS 
printers typically use LOW setting.  

28. Select whether the workstation’s sound card will be used for error tones. 
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29. Select the Customer Information Display (CID) mode being used (Mode 40 = 40 
Columns, Mode 80 = 80 Columns). 

30. Select the CID Screen Resolution. 

31. Select whether a 2x20 Customer Display is attached.   

32. If 2x20 is attached, select the COM Port it is attached to. 

33. Change to the “Payment System” tab by holding down the ALT key and tapping 
the “P” key, or selecting with the mouse.  

 
34. Select the workstation’s payment system. 

If “None” is selected skip to step 38. 

35. Select whether the payment terminal is attached. 

36. Select the baud rate of the payment terminal. 

37. Select the COM Port of the payment terminal. 

38. Select whether an S&H Greenpoints System is attached.   

If “S&H Terminal is set to “No” skip to step 43. 

39. Select the Baud Rate for the S&H terminal.  

40. Select the COM Port of the S&H terminal. 

41. If XINETIX is used, select the version being used. 

42. If XINETIX is used, select whether or not to set the Customer Level to 1. 
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43.  If S&H Greenpoints TCP/IP Interface is attached CLICK on the box to Enable 
TCP\IP Interface. 

•  Enter the TCP\IP address to connect to the S&H GreenPoints server. 

•  Enter Port Address for the S&H GreenPoints server connection. 

44. When finished, Click Save (or press <ALT><A>). 

A message box displays saying “Are you sure you want to add the information … to 
the registry?”  

45. Press Enter for Yes. 

A message box displays confirming that the information has been successfully entered 
into the registry. 

46.  Press Enter for OK. 

The PoS workstation reboots. 

47. If installing a Fujitsu register with full touch, after rebooting the system will 
prompt “Is the Touch Screen a D15”.  Press Y to accept Yes, or press N to select 
No.   
 
If this prompt does not appear, or if No is selected the installation is complete. 

Setup 3M TouchWare driver to work with ScanMaster PoS 
48. The TouchWare Properties window displays. 

Note: If at any time the Point of Sale appears before the TouchWare setup is 
completed, use “Alt-Tab” to return the “TouchWare Properties” screen to the 
foreground. 

49. Press Alt-C to activate the Calibrate button. 

50. Touch and hold the touch point displayed on the bottom left of the screen until it 
says “Touch Enable”.  Repeat on the touch point on the top right. 

51. Wait for the “Calibration Complete” screen to appear, and then drag your finger 
around the screen and insure that the cursor follows properly.  If correct click or 
touch the DONE button.  To correct the calibration, click the Calibrate button and 
repeat the last two steps. 

52. Touch the Touch Settings tab. 

53. Touch the Drawing button in the Touch Mode section at the top of the screen. 

54. Touch the Beep button in the Touch Sound section in the middle right of the 
screen, and the text below the button should change to “System Beep on  
touchdown” 

55. Touch the Tools tab. 

56. Touch the Options button. 

57. Change the slider control for Frequency to approximately 800 Hz (right and left 
arrow keys are more accurate than using the mouse). 
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58. Change the slider control for Duration to 100 ms. 

59. Touch Close. 

60. Touch Close. 

THIS CONCLUDES THE POS WORKSTATION INSTALLATION SECTION.  
REPEAT THE ENTIRE SERIES OF STEPS FOR EACH POS WORKSTATION!!   

 

Upgrading ScanMaster 2.05.01 on the PoS Workstations 
Follow this procedure for all ScanMaster PoS Workstations. 

1. Exit from the PoS software. 

2. At the PoS Workstation, press the Start  key on the keyboard. 

3. Press <R> for Run. 

4. Type the following path: F:\WinReg\Install\Setup.exe. 

5. Press Enter for OK to run the setup executable. 

The Installation Wizard Welcome window displays. 

6. Press Enter for Next to continue. 

The Setup Type window displays. 

7. Confirm the appropriate setup type for your upgrade.  Use the arrow keys to 
change the highlighted choice. 

8. Press Enter for Next to accept. 

9. If installing to an NCR terminal, the question “Does this POS have a DVI 
DynaKey Attached?” appears.  Select appropriate response and press Enter for 
Next to continue. 

The Start Copying Files window displays. 

10. Review the information to ensure that it matches your configuration and press 
Enter for Next. 

After the files are copied, the “Question” window displays asking whether hardware 
has changed. 

11. Select appropriate response to hardware change question. Press Y for “Yes”, or N 
for “No”.  If “Yes” is selected, complete steps (11 through 47) in the Workstation 
Installation section above. 

If this is the first register to be upgraded, the ScanMaster v2.05.01 Register File 
Conversion Utility appears, with a message box stating that it is recommended that all 
Server and B/O workstation applications including the EJ processor are closed during 
the conversion. 

If this is not the first register to be upgraded, skip to step 16. 
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12. After shutting down ScanMaster on all back office machines, including the EJ 
processor, press Enter to accept Ok. 

If this is an upgrade from a version v2.01.00 or greater, skip to step 16. 
 

The conversion utility will read each of the files necessary to convert, and display the 
number of records currently in the files. 

13. Press Alt-P to activate the Process button 

14. After the conversion is complete, press Alt-X to activate the Exit button 

15. After reviewing the Register Conversion log, close it by pressing Alt-F4. 

A Registry Editor Message box appears which says “Are you sure you want to add the 
information to the registry?” 

16. Press Enter to accept Yes. 

17. Press Enter to accept Ok. 

18. The installation is now complete. 

The PoS workstation reboots. 

Note: Once rebooted, the PoS Workstation comes up in “Offline Mode”.   You may 
now move a cashier to this lane and move to another PoS Workstation to upgrade. 

THIS CONCLUDES THE POS WORKSTATION UPGRADE SECTION.  REPEAT 
THE ENTIRE SERIES OF STEPS FOR EACH POS WORKSTATION!!   

 

Note:  After all PoS Workstations have been upgraded, install Pervasive Server 
Engine on the ScanMaster server, and begin the ScanMaster Server upgrade. 
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Uninstalling ScanMaster on the Server and Back Office 
Workstations 

To completely uninstall ScanMaster, manual operations are required both before and 
after using the Windows’ Add or Remove Programs function. The following details 
the steps required to totally uninstall ScanMaster from a system. 

1. If the EJ Processor or ESL Monitor is running on the Server or Back Office 
computers double click the application icon on the taskbar and click on the 
appropriate button to stop the tray application(s). 

2. If the Connected Services StartASP application is in the taskbar, use the Windows 
Task Manager to End Task on the StartASP. 

3. Remove ScanMaster created users: On each PC run  
<Def Drive>:\Grocery\Makeuser /REMOVE. 

4. Remove Hasp and ESL Services - v1.3.x thru v2.00.xx - On the Server PC run: 
<Def Drive>:\Grocery\Smwsssvc -u 
<Def Drive>:\Grocery\Smwelsvc -u 
 
ScanMaster v2.01.02 and above - On the Server PC run: 
<Def Drive>:\Grocery\Sm2sssvc -u 
<Def Drive>:\Grocery\Sm2elsvc -u 
 
If the Crypkey service is still running on the Server, run: 
<Def Drive>:\Grocery\setupex -u 
(Do not reboot until the entire uninstall is completed). 
 

5. If ScanMaster FM is installed, run one of the following from  
<Def Drive>:\Grocery on the PC with the FM service installed (depending on 
whether this is a [V1] or [V2] installation). 
 
Telxon 
[V1] FMTelxon.exe -u 
[V2] Sm2fmtel.exe -u 
 
Norand 
[V1] FMNorand.exe -u 
[V2] Sm2fmnor.exe -u 
 
Symbol 
[V1] FMAnsi.exe -u 
[V2] Sm2fmans.exe -u 
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6. Under Start → Settings → Control Panel → Add or Remove Programs, select 
each    ScanMaster entry (ScanMaster ASP,  ScanMaster Register Installation 
Package, ScanMasterFM(V1) or RetalixMobilFM(V2), ScanMaster, etc.) and 
select Remove. Remove the main “ScanMaster” entry last. Entries that have 
“Register Install for v1.xx.xx” will not uninstall the register installation on the 
<LAN Drive>. These installation files will be removed in step 9. If you wish to 
remove these entries from the Add/Remove screen, use REGEDIT and look for 
these entries under HKLM\Software\Microsoft\Windows\Current 
Version\Uninstall. Open the folders with the long GUID numbers until you find 
the Register install entries listed on the Add/Remove screen and delete these 
keys. Always use caution when editing/deleting registry entries! 

7. On ScanMaster V2 installs (v2.01.00 and higher) - Select to remove the Pervasive 
installs (Pervasive System Analyzer first, then Pervasive SQL). 

8. If this is a typical install, disconnect the mapped F: drive. If a custom install, then 
delete the SCAN1DOS share on the physical drive. When uninstalling a 
BackOffice PC, only delete folders local to that PC. 

9. If only uninstalling or removing a Back Office Workstatioin, manually remove the 
machine name from <LAN Drive>:\Grocery\Boff.tbl. 

10. Using Windows Explorer, manually delete all of the ScanMaster created folders. 
Depending on whether it is a V1 or V2 install and system usage, some of the 
folders listed below may not be present: 
 
Btrieve 
CID 
Docs 
Grocery 
History 
Journal 
Regfiles 
Scan1Dos (If typical installation) 
Till 
Update 

11. If this is a custom install, delete the same folders on the <LAN Drive>. 

12. Delete any Patch install folders as well as the WinReg and/or Reginstl folders if 
present. 
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Appendix A – Configuring Fujitsu Scanner/Scales 

Configuring the Fujitsu Symphony 9900 Scanner/Scale 
1. Scan the Enter Programming Mode tag. 

0   1 2 3 4 5  0 0 0 4 5   4

ENTER THE PROGRAMMING MODE

 
2. Scan the Restore All Defaults tag 

0   1 2 3 4 5  1 3 0 6 1   8

Restore All Defaults

 
3. Scan the Default Cable Magellan Configuration Tag. 

0   1 2 3 4 5  6 8 3 0 1   5

Default Single Cable Magellan Configuration

 
4. Scan the UPC-E Expanded To UPC-A Enabled Tag. 

 



 

2-96 Chapter 2: 2.05.01-050 Upgrade and Installation Procedures 

5. Scan the Weight Data Received Good Beep Enabled Tag.  

 
6. Scan the Exit Save and Reset Tag 

 

Configuring the Fujitsu SlimScan 1200 Scanner 
1. Scan the Enter Programming Mode tag. 

 
2. Scan the Restore All Defaults tag 
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3. Scan the UPC E Expanded To UPCA Enabled Tag. 

 
4. Scan the Exit Save and Reset Tag 

 
 

Note: All NCR Scanner/Scales must be programmed for Magellan Single-Cable 
Emulation. 
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Appendix B -  Building the ScanMaster database manually 
in Pervasive SQL 

This process is done as part of the normal installation of ScanMaster 2.05.01, and is 
necessary only if the SQL Database connection is incorrect, or otherwise needs to be 
redone.   

1. From the Task Bar, click Start→Programs→Pervasive.SQL V8/V9→Control 
Center. 

The Pervasive Control Center will display. 

2. Click the “+” next to Pervasive.SQL Engines. 

3. Click the “+” next to SERVER. 

4. Click the “+” next to Databases. 

5. If ScanMaster database name does not display, right click on Databases and select 
“New Database”. 

The Create Database Wizard begins and the Specify Database Information screen 
displays. 

6. In the Name field, type ScanMaster. 

7. In the Directory field type F:\Grocery\Files, or select this directory using the 
browse button. 

8. Check Use advanced Settings checkbox only. 

9. Click Next. 

The Specify Advanced Database Options screen displays. 

10. Do not change the defaults shown in the first three fields but edit the fourth field, 
the Database Name field, with ScanMaster. 

11.  Click Next. 

The Completing Create Database Wizard screen displays. 

12. Click Finish. 

You will be notified that the ScanMaster database was created successfully. 

13. Click Close. 
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Appendix C - Disk Mirroring 
The Disk Mirroring option uses a back-up hard drive in the event the primary hard 
drive fails.  This backup security measure is highly recommended to minimize 
downtime in the event of a hard drive failure. An additional hard drive that is at least 
the size of the primary disk being mirrored must first be installed in the file server.  
Follow the hard drive manufacturer’s installation instructions.   

Disk mirroring is recommended for the ScanMaster Server only. 

 

For SCSI drives, be sure that jumpers are set to uniquely identify each SCSI device, 
i.e.: Device #3, Device #4. The first bootable device is always device #0. The 
controller card is always device #7. For IDE drives sharing the same controller 
cable, be very careful to set up the original primary hard disk as the “Master” drive 
in an IDE “Master-Slave” relationship.  The second hard drive is known as the 
“Slave drive”. 

Failure to properly define these relationships can lead to drive failure.  Check the 
hard drive manufacturer instructions.  If the manuals are not readily accessible, 
these settings are often available in the Support or Technical Specifications areas of 
the manufacturer’s web site. 

Setting Up Disk Mirroring in Windows NT 
Follow the steps below to set up Disk Mirroring on the system: 

1. From the Windows NT Server Task Bar, click on Start → Programs → 
Administrative Tools → Disk Administrator to display the Disk Administrator 
dialog box. 

2. Click on the partition to mirror.  A border surrounds the selection. 

Note: Drive #0 and Drive #1 hard drives display.  Partitions display on the primary 
hard drive, while the secondary hard drive displays as empty space. If drive #1 
doesn’t display free space, delete the partition. You can not mirror a drive until drive 
#1 is all free space. 

Deletion of a partition erases all data in the partition area.  Be sure to have a 
backup of any data you want to save that might be stored in the partition area to 
be deleted.   

3. Hold down the CTRL Key and click on the empty space of the secondary hard 
drive to highlight the border around the target partition. 

4. From the Disk Administrator menu bar, click Fault Tolerance → Establish 
Mirror. 
After a series of prompts, the server restarts 

5. Login as Administrator. 
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Setting Up Disk Mirroring in Windows 2000 
1. Start → Programs → Administrative Tools → Computer Management. 

2. Right-click on the unallocated space on one of the disks where you want to create 
the mirrored volume and select Create Volume from the pop-up menu. 

The Create Volume wizard displays. 

3. Follow the instructions and prompts that display in the windows. 

4. Click Finish when you have completed mirroring the disks. 

If the Primary Hard Drive Fails 
Follow the steps below if the primary hard drive fails.  A message box displays 
indicating one of the hard disks has failed.   

1. Click OK.  

2. Check the event viewer (system log) for more info about which drive had failed. 

From the NT Server Task Bar, click on Start → Programs → Administrative 
Tools → Disk Administrator to display the Disk Administrator dialog box. 
 
From the Windows 2000 or XP task bar, click on Start → Programs → 
Administrative Tools → Computer Management. Select Disk Management 
from the Tree. 

3. Identify the hard drive that has failed.  If it is the primary hard drive, shut down 
and power off the system. 

4. Remove the outer cabinet of the File Server and remove the damaged primary 
hard drive. 

5. Change the secondary hard drive (the mirror drive) to the primary drive. 

6. Install a replacement mirror drive for the secondary drive. 

For SCSI drives, be sure the new drive is uniquely identified with its own device 
number. For IDE drives sharing the same controller cable, be sure to properly re-set 
the Jumper pin settings on each hard drive unit to define the proper “Master-Slave” 
relationship. Set up the primary drive as “Master” and the secondary drive as 
“Slave”.  

In Windows NT, assign drive letters using Disk Administrator → Tools → 
Assign Drive Letter. Do not assign a drive letter for a mirrored drive. 
 
In Windows 2000, assign drive letters using Computer Management → Disk 
Management. Right-click on the primary drive and select Change Drive Letter 
and Path… Do not assign a drive letter to the mirrored drive. 

7. Perform the Setting Up Mirror Drive procedure documented earlier in this section. 
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Appendix D -  Configuring NCR Hardware using MakePOS 
This process is used in place of steps 14 through 47 in the POS Workstation 
Installation when installing with NCR hardware. 

1. Change to the “Devices” tab by holding down the ALT key and tapping the “D” 
key, or selecting with the mouse. 

 
2. Select the CID mode. 

3. Select whether the operator display is Black/White or Color. 

4. If the CID mode was set other than none select the CID Screen Resolution. 

5. Under Operator Display Select Yes if using a Dynakey (other than 12.1/DVI). 

6. If using a 12.1/DVI Dynakey  Select that option 

7. If using a TouchScreen select that option. 

8. Select the Scanner Type.  If “None” is selected skip to step 11. 

9. Select the baud rate for the scanner.  

10. Select the COM Port to which the scanner is connected. 

11. Select whether or not the 4100 scale is being used. 

12. If 4100 is selected, then select the scale’s COM Port. 

13. Select whether or not the 2010 Coin Dispenser is being used. 
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14. If 2010 is selected, then select the dispenser’s COM Port. 

15. If CID mode is set to “None” then select whether a 2x20 Customer Display is 
attached.   

16. Select whether to enable MICR (Magnetic Ink Character Recognition) on the 
printer. 

17. Select whether Portrait Check Writing is being used. 

18. Change to the “Payment System” tab by holding down the ALT key and tapping 
the “P” key, or selecting with the mouse.  

 
19. Select the workstation’s payment system. 

If “None” is selected skip to step 23. 

20. Select whether the payment terminal is attached. 

21. Select the baud rate of the payment terminal. 

22. Select the COM Port of the payment terminal. 

23. Select whether an S&H Greenpoints System is attached.   

If “S&H Terminal is set to “No” skip to step 28. 

24. Select the Baud Rate for the S&H terminal.  

25. Select the COM Port of the S&H terminal. 

26. If XINETIX is used, select the version being used. 
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27. If XINETIX is used, select whether or not to set the Customer Level to 1. 

28. If S&H Greenpoints TCP/IP Interface is attached CLICK on the box to Enable 
TCP\IP Interface 

•  Enter the TCP\IP address to connect to the S&H GreenPoints server. 

•  Enter Port Address for the S&H GreenPoints server connection. 

29. When finished, Click Save (or press <ALT><A>). 

A message box displays saying “Are you sure you want to add the information … to 
the registry?”  

30. Press Enter for Yes. 

A message box displays confirming that the information has been successfully entered 
into the registry. 

31.  Press Enter for OK. 

The POS workstation reboots.





Chapter 3: Customizing Your System 

Customizing Your System 
After loading the ScanMaster software, log on to a ScanMaster Back Office 
Workstation or the ScanMaster Server to configure the system to suit the store’s 
business needs.  

This chapter outlines the steps for customizing the ScanMaster system.   

Note: It is highly recommended that a business interview be conducted first to 
discuss the possibilities and to establish the desired business practices.  Use the 
Personalization Survey & Setup Guide from the ScanMaster User Guide – Appendix 
A to survey all of the possible choices and record the store’s choices. 

3 
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ScanMaster Back Office Workstation Configuration 
The following steps, in this order, are required for basic configuration. 

1. Set Date and Time 

2. Configuring ScanMaster Security 

3. Log on to the ScanMaster Back Office Workstation. 

4. Enter Employees into the database. 

5. Set up Departments and Subdepartments. 

6. Set up Customer Maintenance options, if needed. 

7. Set up the Item File. 

8. Set up the Customer File. 

9. Set up the Tax table. 

10. Set up Security. 

11. Define Receipts  

12. Define the SRR Editor 

13. Configure the ScanMaster Back Office Workstation and POS Workstation 
(Register) Control Files. 

14. Configure Media. 

15. Configure Keyboards 

Additional Recommended Setup: 
Set up:  

Tare Tables 
Mix N Match 
Flip Chart Maintenance (DynaKey installations) 
Bottle Links 
Report Codes 

Define the customer file: 
Negative Check 
Frequent Shopper Matrix 
In-store Charges 

Personalize the system. 
Note: See the ScanMaster User Guide – Chapter 8 for instructions on how to set up these features. 

Setting Date and Time 
Follow this procedure to set the date and time.  

From the Back Office Workstation or ScanMaster Server NT Task Bar, click 
Start→Settings→Control Panel→Date/Time.   

Double-click on the Date/Time icon to access the Date and Time dialog box. 
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The Time Zone option box was pre-set at installation.  Do Not Change this setting.  
Enter the preferred date and time.  Click OK to accept the changes. 

Note: Windows anticipates seasonal time changes such as Daylight Savings Time 
and handles the change automatically as it occurs.   

ScanMaster Software Registration 
The ScanMaster base application and its available options are enabled through the 
HASP plug attached to the USB port of the back office workstation.  The ScanMaster 
Software Registration program (SM2SSDSP.exe located in the Grocery directory) 
displays the store’s licensed options, in addition to the: 

• Customer Number 

• Number of enabled POS Workstations 

• Number of enabled Back Office Workstations 

• Number of enabled Retalix Pocket Office (RPO) units 

 
 

Logging on to the ScanMaster Back Office Workstation 
1. Enter your 3-digit employee number at the Login Screen. 

2. Enter your password. 
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The ScanMaster Main Menu now displays. 

You are now ready to build your Employee File by entering all employees into the 
database. 

Note: After setting up departments (below) please assign a default electronic coupon 
department number within the Back Office Settings to avoid receiving the “Invalid 
Default Electronic Coupon Department” error message each time you log in. 

Entering Employees into the Database 
Create the employee file first.  Establishing employee numbers and passwords enable 
employees to log into ScanMaster.  

1. From the ScanMaster Main Menu, select Employee Maintenance to display the 
Employee Menu. 

2. Select Employee Maintenance on the Employee Menu. 
 
The Employee Maintenance Screen displays with a form to complete for each employee, 
including yourself. 

For detailed instructions on entering employees into the Employee File, see Chapter 2, 
“Maintaining Employee Data,” in the ScanMaster User Guide. 

Setting Up Departments and Subdepartments 
After completing the Employee File, set up departments. You can also create 
subdepartments under each department. 

To enter departments into the database:  

1. From the ScanMaster Main Menu, select Department/Subdept Maintenance to 
display the Group/Department/Subdepartment Menu. 

2. Select Department Maintenance.  The Department Maintenance screen displays 
with a form to complete for each department.  Up to 99 departments can be 
created. 

For detailed instructions on setting up departments, see Chapter 3, “Performing 
Department/Subdepartment Maintenance,” in the ScanMaster User Guide. 

To enter subdepartments into the database:  

1. From the ScanMaster Main Menu, select Department/Subdept Maintenance to 
display the Group/Department/Subdepartment Menu. 

2. Select Subdepartment Maintenance then press Enter. 
 
The Subdepartment Maintenance Screen displays with a form to complete for each 
subdepartment.  Up to 999 subdepartments can be created. 

For detailed instructions on setting up subdepartments, see Chapter 3, “Performing 
Department/Subdepartment Maintenance,” in the ScanMaster User Guide. 
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Setting up Customer Maintenance Options 
Before creating the Customer File, it is recommended that you select the Customer 
Maintenance Menu to enter information concerning customers with negative check 
and charge ratings.  It is also suggested that you build the table of reason codes 
pertaining to the Negative Check File. 

To access Customer Maintenance options:  

1. From the ScanMaster Main Menu, select Customer Maintenance to display the 
Customer Maintenance Menu. 

2. Select Negative Check File Maintenance or Check/Charge Reason Code 
Maintenance then press Enter. 

The ScanMaster Negative Check Maintenance or the Customer Reason Maintenance screen 
displays. 

For detailed instructions on completing the Negative Check Maintenance or the 
Customer Reason Maintenance Screen, see Chapter 5, “Maintaining Customer Data,” 
in the ScanMaster User Guide. 

Setting up the Item File 
Set up the Item File to incorporate the PLU code of each item into the database.   If 
batches have been created at the Host level, you could incorporate these into the 
system, thus saving the time of manual entry.  Create local batches for those items 
that have not been previously entered. 

To access the Item File: 

1. From the ScanMaster Main Menu, select Item Maintenance to display the Item 
File Menu. 

2. Select Direct Item Maintenance to manually key item information. 

For more information about the Item Maintenance Menu, see Chapter 4, “Performing 
Immediate and Batch Item Maintenance,” in the ScanMaster User Guide. 

Setting up the Customer File 
Create the Customer File.  This file provides information about customers who have 
accounts with your store. 

To create the Customer File:  

1. From the ScanMaster Main Menu, select Customer File Maintenance to display the 
Customer Maintenance Menu. 

2. Select Customer File Maintenance to display the Customer Maintenance screen. 

For detailed instructions on about Customer Maintenance, see Chapter 5, 
“Maintaining Customer Data,” in the ScanMaster User Guide. 



3-6 Chapter 3: Customizing Your System 

Setting up the Tax Table 
Create the Tax Table.  This file provides information about 3 levels of Tax, 
descriptions,  and various tax break points and exceptions. 

To create the Tax Table:  

1. From the ScanMaster Main Menu, select System Personalization to display the 
Personalization Menu. 

2. Select Tax Table Maintenance to display the Tax Table Maintenance screen. 

For detailed instructions on about Tax Table Maintenance, see Tax Table Maintenance 
in Chapter 8, “Personalizing Workstations” in the ScanMaster User Guide. 

Setting up Security 
Establish the employee security settings.  Security settings enable various privileges 
by employee to perform different ScanMaster functions.  

To set Security for Employees:  

1. From the ScanMaster Main Menu, select Employee Maintenance to display the 
Employee Menu. 

2. Select Enhanced Security to display the Enhanced Security screen. 

For detailed instructions on about Enhanced Security, see Enhanced Security in 
Chapter 2, “Maintaining Employee Data” in the ScanMaster User Guide. 

Define Receipts 
Use Appendix A of the ScanMaster User Guide to determine the various choices 
possible for formatting a register receipt tape.    

To define the Register Receipt:  

1. From the ScanMaster Main Menu, select System Personalization to display the 
Personalization Menu. 

2. Select System Configuration to display the System Configuration Editor screen. 

For detailed instructions about “Defining Receipts”, see the Functional Group for 
“Customer Receipt and Display” in Chapter 8 of the ScanMaster User Guide.  

 

Setting up the SRR Editor 
Customize the SRR Editor.  The SRR Editor enables you to develop a customized 
reconciliation report that displays all pertinent accounting information for Paidouts, 
Receipts and Memos. 

To edit reconciliation reports:  
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1. From the ScanMaster Main Menu, select System Personalization to display the 
Personalization Menu. 

2. Select SRR Editor to display the Reconciliation Report Editor screen. 

For detailed instructions about “SRR Editor”, see the “SRR Editor” section of Chapter 
8 of the ScanMaster User Guide. 

Configuring Setting Files (Back Office & POS Workstation) 
Configure the Back Office and POS Workstation Settings to make ScanMaster 
operational. 

To access the Back Office or POS Workstation Settings: 

1. From the ScanMaster Main Menu, select System Personalization to display the 
Personalization Menu. 

2. Select System Configuration to display the System Configuration Editor screen.    

Note: Please assign a default electronic coupon department number on the 
Global/Store Tab to avoid receiving an error message each time you log in. 

3. The many options are uniquely grouped under each tab.  Click one of the 18 tabs 
to see the group of related settings.  Double click on a cell to display an edit area 
where changes can be made.  Save the changes to designated lanes. 

For detailed instructions and definitions for all Back Office and POS Workstation 
Settings, see Chapter 8: Personalizing Workstations in the ScanMaster User Guide. 

Configuring Media 
Configure the supported media types and their related settings. 

To access the Media Configurator: 

1. From the ScanMaster Main Menu, select System Personalization to display the 
Personalization Menu. 

2. Select Media Configurator to display the Media Maintenance Menu.  Select 
Media Configurator to display the Media Configurator screen.  Select the 
Register Number and Media Type to edit.   

For detailed instructions and definitions for all Media Configurator settings, see 
Chapter 8: Personalizing Workstations in the ScanMaster User Guide. 

Configuring Keyboards 
Configure the keyboard layouts for each register. 

To access the Keyboard Configurator: 

1. From the ScanMaster Main Menu, select System Personalization to display the 
Personalization Menu. 
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2. Select Keyboard Configurator to display the Keyboard Config. Menu.  Select the 
menu associated with the keyboard type you are configuring to display the 
Keyboard Configurator Screen.  Select the Register Number to edit.   

For detailed instructions for on Keyboard Configurator settings, see Chapter 8: 
Personalizing Workstations in the ScanMaster User Guide. 



  

 Chapter 4: File Structure and Description 

Software files on ScanMaster are divided into two sets of folders and subfolders: those 
for the back office, and those for the file server. File server folders are: a local program 
file drive (typically C:\) and a shared Local Area Network (LAN) drive (typically 
F:\).  If there is an additional Back Office Workstation, much of the folder structure is 
also similar, especially the subfolders in the \GROCERY folder.   

This chapter shows the folder structures for the file server, additional ScanMaster 
Back Office workstations, and a POS workstation. The files in the folders are listed 
with a brief description of their functions.  
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Workstation/Server Folder Structure 

Folder Structure 
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Workstation/Server Folders 
GROCERY   ScanMaster Executables, .DAT and .BAT files 

     

 FILES    Btrieve Data Files 

  BLANK Blank Btrieve Data Files 

  CTL  Btrieve Control Files 

  LOG  Error Logs 

  ASC   ASCII Files, Cashier Logs 

  SCRIPTS SQL Script Files 

  MEDIA 

                                             IMAGES Multimedia Images 

                                                        MOVIES Multimedia Movies 

 HOST   Host Batches           CUSTOMER Customer pictures 

 LOCAL   Local Batches         

 OFFSALE   Sales Batches         

 SRR    Spreadsheet data files 

  

ASP    ScanMaster ASP Report and Export Files 

HISTORY    Archived Records 

JOURNAL   Electronic Journal 

REGFILES   POS Workstation (Register) Personalization Files 

TELXON    FM Software (Optional) 

TILL     Settled Transaction Logs (TLOGS) 

UPDATE  Updates from the Back Office Workstation to the POS workstations 
(new POS Workstation Setting changes) 

EFT HIST   Archived EFT communications records 

SCAN1DOS   (LAN drive for data collection). 

 

Note: The local drive contains ScanMaster’s executable files, while the LAN drive 
contains the system’s data collection files. 
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ScanMaster Executable Files 

GROCERY - Grocery Folder 
All file server executables are located in the \GROCERY folder. 

SM2LOGIN.EXE Security Login 

SM2MENU.EXE Back Office Workstation Main Menu 

 

Item Maintenance 
 

SM2BMENU.EXE Item Maintenance Menu 

SM2ASC2B.EXE Host to Batch 

SM2BAPLY.EXE Apply Batch Files 

SM2BATCH.EXE Print Batch Files   

SM2F2BAT.EXE Convert PLU Report to Batch 

SM2FLIP.EXE Flip Chart Maintenance 

SM2ITEM.EXE Item Maintenance 

SM2MASS.EXE Mass Attribute Change Utility 

SM2MIX.EXE Mix and Match Maintenance 

Miscellaneous Item Maintenance 
 

SMW2MENU.EXE    Miscellaneous Maintenance Menu 

SM2WAJTPR.EXE Adjective Price Maintenance 

SM2BLINK.EXE Bottle Link Editor 

SM2BUNDL.EXE  Bundle File Maintenance 

SM2COUP.EXE Promotion/Coupon Editor 

SM2ECPN.EXE Electronic Coupon 

SM2LIKE.EXE Like Code Editor 

SM2PMM.EXE Multi-Media Promotions Editor 

SM2RCODE.EXE Report Code Editor 

SM2VTARE.EXE  Variable Tare Maintenance 

SM2TARE.EXE Tare Table Maintenance 

SM2UMTBL.EXE Unit of Measure Table Editor 
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Employee Maintenance 
 

SM2EMENU.EXE    Employee Menu 

SM2ACEMP.EXE Active Employee List 

SM2CMON.EXE Cashier Monitoring 

SM2CSACT.EXE Active Cashier Status 

SM2EMP.EXE Employee Maintenance File 

SM2EMPLS.EXE Employee List 

SM2FRLOG.EXE Force Cashier Logoff 

SM2MSG.EXE Cashier Messaging  

SM2SECUR.EXE Enhanced Security 

Department Maintenance 
 

SM2DMENU.EXE    Department/Subdepartment Menu 

SM2DEPT.EXE Department Maintenance 

SM2GRMNT.EXE Group Descriptor Maintenance 

SM2MATRX.EXE Department Restriction Matrix 

SM2SUBD.EXE Subdepartment Maintenance 

Customer Maintenance 
 

SM2CMENU.EXE     Customer Maintenance Menu 

SM2CREAS.EXE  Customer Reason Maintenance 

SM2CSCLR.EXE  Clear Customer Totals 

SM2CUST.EXE  Customer Maintenance 

SM2FSHOP.EXE  Frequent Shopper Discount Table 

SM2FSHRP.EXE  Customer / Frequent Shopper Report 

SM2H2CFG.EXE  Customer Host Configuration 

SM2LDESC.EXE  Frequent Shopper Level Code Maintenance 

SM2NCHK.EXE  Negative Check Maintenance 

SM2NCRPT.EXE  Negative Check Report 

Accounts Receivable 
 

SM2AMENU.EXE    Accounts Receivable Menu 

• SM2AGRPT.EXE A/R Aging Report 
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• SM2ARACT.EXE A/R Activity Report 

• SM2ARPST.EXE Post A/R Payments and Adjustments 

• SM2FCHRG.EXE Post A/R Finance Charges 

• SM2MOEND.EXE A/R Month-End Close 

• SM2STMNT.EXE A/R Statement Printing 

System Personalization 
 

SM2PMENU.EXE     System Personalization Menu 

• SM2BANR.EXE Banner File Maintenance 

• SM2BSRR.EXE Reconciliation Report Editor 

• SM2CCRT.EXE Customer CRT Promo Editor 

• SM2COMCF.EXE Communications Control File Editor 

• SM2FRATE.EXE Foreign Currency Rate Editor 

• SM2REAS.EXE Reason Code Maintenance 

• SM2SYSCF.EXE System Configuration Editor 

• SM2TAX.EXE Tax Tables Maintenance 

• SM2TCODE.EXE Tax Code Editor 

 

Media Configurator  
 

SM2NMENU.EXE   Media Configurator Menu 

SM2MEDIA.EXE  Media Configurator 

SM2MDFEE.EXE  Media Cashing Fee Editor 

 

Keyboard Configurator 
 

SM2KMENU.EXE Keyboard Menu 

• SM2K7450.EXE  DynaKey Keyboard Configurator 

• SM2KFLCN.EXE Falcon Keyboard Configurator 

• SM2KNCR.EXE  Keyboard Configurator for 56 & 64 key NCR 

Communications 
 

SM2TMENU.EXE    Communications Menu 
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Reports 
 

SM2RMENU.EXE    Reports Menu 

• SM2SJRPT.EXE Electronic Journal Reports 

• SM2ECDEL.EXE  Electronic Coupon Delete 

• SM2ECRPT.EXE  Electronic Coupon Reporting 

• SM2EODPR.EXE Print End-of-Day Reports 

 

Financial Reports 
 

SM2FMENU.EXE Financial Reports Menus 

• SM2ACTRP.EXE Hourly Activity Report 

• SM2AUDRP.EXE Summary Audit Trail Reports 

• SM2CARPT.EXE Consolidated Transaction Log (TLOG) Reports 

• SM2CPRPT.EXE Enhanced Dept. Report 

• SM2CSHRP.EXE Cashier Report 

• SM2DAUD.EXE Detailed Audit Report 

• SM2DEPT1.EXE Department Flash Report 

• SM2DEPT2.EXE Department Historical Report 

• SM2DPACT.EXE Department Activity Report 

• SM2DPTEC.EXE Electronic Coupon by Dept. Report 

• SM2NRTRP.EXE Non-Resettable Totals Report 

• SW2PRODR.EXE Lane Productivity Report 

Item File Reports 
 

SM2UMENU.EXE  Item File Reports Menu 

• SM2ADMV.EXE Ad Movement/Loss Report 

• SM2LRMV.EXE Clear Movement Report 

• SM2PDIMR.EXE PLU File and PLU Movement Reports 

End-of-Day Procedure 
 

SM2EOD.EXE    Starts End-of-Day  

• SM2ACTVT.EXE Compiles Activity Information 
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• SM2ARC.EXE General System File Archiving 

• SM2BAPLY.EXE Applies Automatic Batch Activation 

• SM2CDEPT.EXE Compiles Department Sales Figures 

• SM2CTLOG.EXE Consolidated TLOG 

• SM2CSHPR.EXE Compiles Cashier Productivity 

• SM2EODAC.EXE Prepares for Automatic EOD Batch Activation 

• SM2NRT.EXE Compiles Non-Resettable Totals for Reporting 

• SM2TLRPT.EXE Compiles TLOG for Cashier Productivity 

Office Procedures 
 

SM2OMENU.EXE  Office Procedures Menu 

• SM2ACEMP.EXE Active Cashier List 

• SM2ADJST.EXE Adjust Settled Cashiers 

• SM2DELAY.EXE Cashier Delays 

• SM2DPSIT.EXE Deposits 

• SM2OFREC.EXE Office Reconciliation 

• SM2OFUND.EXE Media Flash Report 

• SM2ORCPT.EXE Office Adjustments 

• SM2PCKUP.EXE Pickups & Loans 

• SM2SETTL.EXE Cashier Settlements 

• SM2SRR.EXE Scan Master Reconciliation Report 

System Services 
 

SM2SMENU.EXE   System Services Menu 

• SM2BCOD1.EXE Label Printing 

• SM2BCKUP.EXE Tape Backup Utility 

• SM2LMENU.EXE Delete not found.Dat 
Delete Randon.Hld 
Delete Pickup.Dat 
Delete Err Log 

• SM2EJBKP.EXE Electronic Journal Back-up 

• SM2KSUS.EXE View/Delete Suspend.Dat 
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• SM2VIEW.EXE View/Print Error Log 
View Back Office Workstation Log 
View Security Log 

• SM2IMENU.EXE Third Party Menu 

• SM2SIL.EXE SIL Interface 

• SM2XMENU.EXE  User-Defined Menu 

 

General system log 
 

• SM2ARC.EXE Part of End-Of-Day – General System File Archiving 

 

Standalone Utilities (and DOS Applications)  
 

SM27800.EXE NCR Price Verifier Software 

SM2CSTDL.EXE Customer Range Delete 

SM2H2CCF.EXE Customer File Hosting Configuration 

MAKEUSER.EXE Sets Up User & POS Workstation NT Accounts (during 
installation) 

SM2AGE.EXE Nightly Accounts Receivable Aging  

SM2ARDFX.EXE Accounts Receivable Date Fix Program 

SM2ASYNC.EXE Synchronizes A/R History and Charges 

SM2CHFIX.EXE A/R History Date Repair Utility 

SM2CLNEC.EXE Electronic Journal Electronic Coupon clearing for expired 
coupons 

SM2CLR.EXE Financial File Clearing Program to be used before a store 
goes live 

SM2CT2EJ.EXE Converts Tlog Files to EJ files for processing in a lab 
environment 

SM2EJ.EXE Electronic Journal Processor 

SM2ESL.EXE Price ESL (Electronic Shelf Interface) interface file generator 

SM2FCFIX.EXE Finance Charge Undo 

SM2WH2CUS.EXE Customer Hosting Update Program 

SM2INSTL.EXE Installation Customization Screen 

SM2LGOFF.EXE ScanMaster Auto-Logoff Utility 

SM2MDFEE.EXE Media Fee Link Editor 
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SM2RPAIR.EXE Repairs item file, Repairs batch file, Repairs Movement File, 
Repairs Electronic Coupon File, Repairs Customer File, 
Repairs Customer Demographics File, Repairs Negative 
Check File, Repairs Charge File -- Repairs/Deletes Key 
Fields with invalid data (nulls).  Fills invalid non-key fields 
with appropriate default data. 

SM2SFUPD.EXE Software Update Editor 

SM2SIL.EXE SIL Configurator 

SM2SILPR.EXE SIL Processor 

SM2SSDSP.EXE ScanMaster Software Registration Display 

SM2WSTATS.EXE Status Editor Program 

SM2TLOGX.EXE TLOG Cashier Extract Program 

SM2WAIT.EXE Wait Utility for End-of-Day Processing 

SM2XFER.EXE A/R Finance Charge Deletion and Balance Forward Utility 

SM2XPORT.EXE Data Export Utility (See Using SM2EOD.SCR below for 
adding this executable to your End of Day script) 

SM2XTRCT.EXE TLOG Extract Utility 

SRV2CONV.EXE ScanMaster v1.1.5+ to 1.2 Batch Conversion Program 

VIEWHOST.EXE ASCII Host File Viewer 

 

 

Installation Utilities 
 

ALTREGLD.EXE Utility designed to copy required offline files from the 
server to a pre-loaded register. Designed to allow registers 
to be loaded prior to installation and run after the 
ScanMaster server is loaded/converted.  

COPYPARM.EXE Installation utility that is called by a register upgrade. It gets 
a register number from the installer and copies any 
appropriate existing personalization files from the server. 

FONTINST.EXE  GUI or command line utility that can install MS 
Linedraw.ttf on a Server or BackOffice workstation or the 64 
key Courier double high and double wide fonts on the POS. 
This is called on the Server/BackOffice installs. The POS 
fonts are installed by the MakePos program. The font files 
are put in place by the installation process but must be 
added as a resource by our utilities. 

MAKEPOS.EXE  Installation utility that allows the installer to configure the 
rlaunch2.dat file and appropriate control file. 
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MAKEUSER.EXE Utility to build users on the ScanMaster server or on the 
individual POS workstations. It is called by the Server and 
POS install. It supports the following command line 
parameters. /AUTO – Used to run in “silent” mode on the 
server during the install. /REMOVE – Used to remove users 
created on the server during install . /POS – Used to build 
the Wrkstnxx user on each POS. POS COMPUTER NAME 
SHOULD BE POSxx OR THIS UTILITY WILL FAIL TO 
MAKE THE USER PART OF THE ADMINISTRATOR 
GROUP. 

REG2CONV.EXE v2.03.00 register conversion utility. Designed to allow 
upgrade to v2.03.00 from v1.02.xx and above while store is 
open. On the first register to run the program, the utility 
will copy and convert the required offline files to the 
v2.03.00 file formats and to Pervasive v8 file formats on it’s 
local drive. After conversion the files are copied to the 
server where each subsequent register running the utility 
will copy the converted files to it’s local drive. 

SM2BLDDB.EXE  Utility to build the Pervasive ScanMaster database on the 
server. 

SM2CLTDB.EXE Utility to build the Pervasive ScanMaster database access on 
BackOffice workstations. 

SRV2CONV.EXE  Server/BackOffice conversion utility. This utility converts 
all of the database files to the appropriate v2.03.00 and V8 
formats. It also deletes previous smw*.exe and grc*.btr files. 

TASKUTIL.EXE  POS utility to restore/hide the taskbar which is hidden by 
rlaunch2.exe. 

 

 

 

Btrieve Data Files 
ScanMaster uses Btrieve for File Record Management. The Btrieve data files are 
always located in the <LAN Drive>:\GROCERY\FILES subdirectory. Below is a list 
of the Btrieve data files, a brief description of the files and the hardware on which 
these files must reside. 
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File Name Description File 

Server 
POS 

Workstation 

EBACCT.BTR       Restored Accounts 
Tables ‐ Stores account 
numbers for 
checks/instore 
charges/etc 

X   

EBASSOC.BTR      Restored Associated 
Files Table ‐ stores 
locations of the Check 
Images, and the 
Receipt Captures 

X   

EBCUST.BTR       Restored Customer 
Table ‐ Information 
about customers 

X   

EBDISC.BTR       Restored Discount 
Table ‐ Discounts in 
transactions 

X   

EBITEM.BTR       Restored Item Table ‐ 
Items in transactions 

X   

EBMGR.BTR        Restored Manager 
Table ‐ This is the 
managers id/names in 
transactions 

X   

EBNRT.BTR        Restored NonResetable 
Totals Table ‐ NRTs in 
Transactions 

X   

EBPROMO.BTR      Restored Promotions 
Table ‐ Electronic 
Promotions and 
Receipts on Coupons 
in transactions 

X   

EBTAX.BTR        Restored Tax Table ‐ 
Tax amount/exempted 
in Transactions 

X   

EBTENDER.BTR     Restored Tender Table 
‐ Type and amount of 
tender in Transactions 

X   
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File Name Description File 
Server 

POS 
Workstation 

EBTRANS.BTR      Restored Transaction 
Table ‐ Primary 
transaction information 
table  

X   

EJACCT.BTR       Accounts Tables ‐ 
Stores account 
numbers for 
checks/instore 
charges/etc 

X   

EJASSOC.BTR      Associated Files Table ‐ 
stores locations of the 
Check Images, and the 
Receipt Captures 

X   

EJCUST.BTR       Customer Table ‐ 
Information about 
customers 

X   

EJDEPTNM.BTR     Department Name 
Table ‐ Where the EJ 
reports gets the names 
for the departments ‐ 
Updated by the EJ 
processor whenever 
the ScanMaster 
Department file is 
changed. 

X   

EJDISC.BTR       Discount Table ‐ 
Discounts in 
transactions 

X   

EJITEM.BTR       Item Table ‐ Items in 
transactions 

X   

EJITMTYP.BTR     Item Type Table ‐ This 
is the Item Type list 
used by the EJ reports.  
This is a Fixed table, 
and is only updated by 
the installation scripts 

X   

EJMGR.BTR        Manager Table ‐ This is 
the managers id/names 

X   
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File Name Description File 
Server 

POS 
Workstation 

in transactions 

EJNRT.BTR        NonResetable Totals 
Table ‐ NRTs in 
Transactions 

X   

EJPROMO.BTR      Promotions Table ‐ 
Electronic Promotions 
and Receipts on 
Coupons in 
transactions 

X   

EJTAX.BTR        Tax Table ‐ Tax 
amount/exempted in 
Transactions 

X   

EJTENDER.BTR     Tender Table ‐ Type 
and amount of tender 
in Transactions 

X   

EJTENDNM.BTR     Tender Name Table ‐ 
This is where the EJ 
reports gets the names 
for the media.   ‐ 
Updated by the EJ 
processor whenever 
the ScanMaster Media 
Configuration file is 
changed. 

X   

EJTRANS.BTR      Transaction Table ‐
 Primary transaction 
information table  

X   

EJTRNTYP.BTR     Transaction Type 
Table  ‐ This is 
the Transaction Type 
list used by the EJ 
reports.  This is a  
Fixed table, and is only 
updated by the 
installation scripts. 

X   

GR2AMDIA  Active Multimedia File  X   

GR2BATCH.BTR Batch File X  
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File Name Description File 
Server 

POS 
Workstation 

GR2BEXP.BTR Batch Export File X  

GR2BIMP.BTR Batch Import File X  

GR2BTSVC.BTR Batch Service Monitor 
File 

X  

GR2BUNDL.BTR Bundle Code File X * 

GR2CHARG.BTR Accounts Receivable 
Charge File 

X * 

GR2CHIST.BTR In-Store Charge 
History File 

X * 

GR2CPLNK.BTR Coupon Link File X * 

GR2CPN.BTR Receipt Coupon Print 
File 

X * 

GR2CPRMO.BTR CID Promo File X * 

GR2CUST.BTR 

GR2CUSTX.BTR 

Customer File 

Extended Customer 
File 

X 

X 

* 

* 

GR2DEPT.BTR Department File X * 

GR2DPT15.BTR Hourly Activity By 
Department 

X * 

GR2DPTRG.BTR Active Department 
Totals (if 
Accountability by Lane 
is active) 

X * 

GR2DPTTL.BTR Active Department 
Totals  

X * 

GR2DTILL.BTR Department Totals (for 
settled or delayed 
cashiers) 

X  

GR2EJSTA.BTR Electronic Journal 
Status File 

X  

GR2FINAL.BTR Finalized Totals Report 
File 

X  

GR2FITAB.BTR Future Items to be 
Applied Batch 

X  

GR2FMDTL.BTR FM Template Detail 
File 

X  
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File Name Description File 
Server 

POS 
Workstation 

GR2FMEMP.BTR FM Employee File X  

GR2FMHDR.BTR FM Template Header 
File 

X  

GR2FMPFL.BTR FM User Profile File X  

GR2FMSEC.BTR FM Security Settings 
File 

X  

GR2FMTMP.BTR FM Manager’s 
Template List 

X  

GR2FOFSL.BTR Future Offsale Batch 
for Label Printing 

X  

GR2FRATE.BTR Foreign Currency File X * 

GR2FSTG.BTR Staging File for Future 
Batches when printing 
Labels 

X  

GR2GROUP.BTR Department Group File X  

GR2GMDIA.BTR Group Multimedia File X  

GR2HEADR.BTR Batch Header File X  

GR2HEXP.BTR Batch Header Export 
File 

X  

GR2HIMP.BTR Batch Header Import 
File 

X  

GR2HOUR.BTR Hourly Activity Report 
File 

X * 

GR2IREAS.BTR Instore Charge Reason 
Codes File 

X  

GR2ITAB.BTR Items To Be Applied 
Batch 

X  

GR2ITEM.BTR Item File X * 

GR2ITGOS.BTR Batch for Items Going 
Offsale Used by the 
Batch Staging Process 

X  

GR2LABEL.BTR Label File X  

GR2LASTZ.BTR End of Day History 
File 

X  

GR2LIKE.BTR Like Code File X * 

GR2LNTST.BTR Test File for Register X  
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File Name Description File 
Server 

POS 
Workstation 

GR2MDFEE.BTR Media Fees File X * 

GR2MIX.BTR Mix and Match File X  

GR2MRPRT.BTR Interim Movement 
Criteria File 

X  

GR2MVMNT.BTR Item Movement X  

GR2NCHEK.BTR Negative Check File X * 

GR2NREAS.BTR Negative Check 
Reason Code File 

X  

GR2NRGT.BTR Non-resettable Totals 
File 

X  

GR2OLDDT.BTR Previous Day’s 
Department Totals 

X  

GR2OLDPT.BTR Previous Day’s Cashier 
Totals Report 

X  

GR2PMM.BTR Multi Media File X  

GR2POINT.BTR Electronic Coupon File X * 

GR2PREAS.BTR Positive Check Reason 
Code File 

X  

GR2PRICE.BTR Adjective Price File X * 

GR2PROD.BTR Cashier Productivity 
File 

X  

GR2PRODRG.BTR Lane Productivity File X  

GR2PRS.BTR Employee File X * 

GR2PRSRG.BTR Lane Totals Report (if 
Accountability by Lane 
is Active) 

X * 

GR2PRSTL.BTR Cashier Totals Report  X * 

GR2PSTXX.BTR Department Flip 
Charts xx is dept 
number 

X * 

GR2RCODE.BTR Report Code File X  

GR2RECON.BTR Reconciled Total 
Report File 

X  

GR2REGTL.BTR Register Total File  * 

GR2RGPRD.BTR Lane Productivity X  



4-18 Chapter 4: File Structure and Description 

File Name Description File 
Server 

POS 
Workstation 

Report File 

GR2RMDIA.BTR Register Multimedia 
File 

X  

GR2RSTCT.BTR Department Sales 
Restriction File 

X * 

GR2SECUR.BTR Enhanced Security File X  

GR2SFUPD.BTR Software Update File  * 

GR2SILMP.BTR Current ScanMaster 
SIL Mapping fields 

X  

GR2SILSP.BTR Supported (available) 
ScanMaster SIL 
Mapping fields 

X  

GR2SSTAT.BTR Last Staging Date & 
Time File 

X  

GR2STAGE.BTR Items To be Applied 
after Staging 

X  

GR2STORE.BTR Store Totals Historical 
File 

X  

GR2SUBD.BTR Subdepartment File X * 

GR2TILL.BTR Delayed Totals Report 
File 

X  

GR2TLDPT.BTR Yesterday’s 
Department  Totals File 

X  

GR2TLPRS.BTR Yesterday’s Cashier 
Totals File 

X  

GR2TRANS.BTR Backoffice Transaction 
Number File 

X  

GR2UCI.BTR Universal Credit 
Insertion File 

X  

GR2UMTBL.BTR Unit Of Measure Table X  

GS2ESL.BTR Pricer ESL Data 
Storage File 

X  

SNHDATA2.BTR S&H Green Points Live 
Auto Redemption File 

X  

SNHPEND.BTR S&H Green Points 
Pending Auto 

X  
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File Name Description File 
Server 

POS 
Workstation 

Redemption File 

 
* These files are used on the POS workstation only when it is in Off-Line Mode. 

Note: These files may also reside on a BackOffice workstation(s) but are not used by 
ScanMaster.  As a backup, the End of Day Process copies these files from the server to 
the root drive of the machine running the EOD process. 

GROCERY\HOST 
 

All host batches reside in this directory. 

GROCERY\LOCAL 
 

All local batches reside in this directory. 

GROCERY\OFFSALE 
 

All off-sale batches reside in this directory. 

GROCERY\SIL\ACHIVE 
 

The directory where SIL files that have already been processed are stored.  They can 
be reprocessed as needed. 

GROCERY\SIL\BATCH 
 

The directory where ScanMaster batches are stored after they are imported from the 
processed SIL files. 

GROCERY\SIL\DECODE 
 

The directory where temporary files are placed after the SIL engine processes the 
original SIL file. 

GROCERY\SIL\ENCODE 
 

The directory where the extract requests are stored. 

GROCERY\SIL\OUTPUT 
 

The directory where LOG and extraction data are stored. 
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GROCERY\SIL\SOURCE 
 

The directory where original SIL files from host are placed. 

GROCERY\SIL\TEMPLATE 
 

The directory where extraction template files are stored. 

GROCERY\SRR 
 

Spreadsheet (ScanMaster Reconciliation Report) (Each of the following three is 
created at End-Of-Day) 

Memos with date (MEmmddyy.DAT) 

Receipts with date (REmmddyy.DAT) 

Paid-Outs with date (POmmddyy.DAT) 

POMAP Store Reconciliation Report Paidout Map files for the 
layout of the Paidout section of the SRR Paid-out accounts 
on the POS workstations.  Renamed POMAP.001 when 
needed by ScanMaster and placed in the UPDATE 
directory.   

MEMAP Store Reconciliation Report Memo Map files for the layout 
of the Memo section of the SRR.  

REMAP Store Reconciliation Report Receipt Map files for the 
layout of the Receipt section of the SRR. 

 

GROCERY\FILES\BLANK 
 

During installation empty BTRIEVE files are installed in this directory.   

 

GROCERY\FILES\CTL 
 

CTL files are used to create empty BTRIEVE files in both the 
\GROCERY\FILES\BLANK and \GROCERY\FILES directories, named according to 
the .CTL (control) file containing the template.  

The .BTR files in the BLANK subdirectory remain blank.  As the day progresses, the 
.BTR files in the \GROCERY\FILES subdirectory fill with information.  If an empty 
file is needed by a program, the program will either create an empty .BTR file in the 
\GROCERY\FILES subdirectory using the .CTL file, or copy an empty .BTR file from  
\GROCERY\FILES\BLANK to  \GROCERY\FILES. 
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The .CTL files are primarily used if the .BTR files become unusable for some reason, 
and need to be recreated.  For more information on recovering from system problems, 
see Chapter 6, “Recovery Procedures,” or Chapter 7, “Troubleshooting”. 

 

GR2ACTRP.CTL Activity Report File 

GR2BATCH.CTL Batch File 

GR2BUNDL.CTL Bundle Code 

GR2CHARG.CTL Accounts Receivable Charge File 

GR2CHIST.CTL In-Store Charge History File 

GR2CPLNK.CTL Coupon Linking File 

GR2CPN.CTL Receipt Coupon Print File 

GR2CPRMO.CTL CID Promo File 

GR2CUST.CTL Customer File 

GR2CUSTX.CTL Extended Customer File 

GR2DEPT.CTL Department File 

GR2DPT15.CTL Hourly Activity Report by Department File 

GR2DPTRG.CTL Active Department Total File (Lane)  

GR2DPTTL.CTL Active Department Totals 

GR2DTILL.CTL Department Totals for Delayed or Settled Cashiers 

CR2EJSTA.CTL Electronic Journal Status File 

GR2FINAL.CTL Final Totals Report File 

GR2FRATE.CTL Foreign Currency File 

GR2CGROUP.CTL Department Group File 

GR2HEADR.EXE Batch Header File 

GR2HOUR.CTL Hourly Activity Report File 

GR2ITEM.CTL Item file 

GR2LASTZ.CTL End of Day Date History File 

GR2LIKE.EXE Like Code File 

GR2MDFEE.CTL Media Fees File 

GR2MIX.CTL Mix and Match File 

GR2MVMNT.CTL Item Movement File 

GR2NCHEK.CTL Negative Check File 

GR2NRGT.CTL Non-resettable Totals File 

GR2POINT.CTL Electronic Coupon File 
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GR2PRICE.CTL Adjective Price File 

GR2PROD.CTL Cashier Productivity File 

GR2PRS.CTL Employee File 

GR2PRSRG.CTL Lane Totals Report File 

GR2PRSTL.CTL Cashier Totals Report File 

GR2RCODE.CTL Report Code File 

GR2RECON.CTL Reconciled Total Report File 

GR2RGPRD.CTL Lane Productivity Report File 

GR2RSTCT.CTL Department Sales Restriction File 

GR2SECUR.CTL Enhanced Security File 

GR2STORE.CTL Store Totals Historical File 

GR2SUBD.CTL Subdepartment File 

GR2TILL.CTL Delayed Totals Report File 

GR2TLDPT.CTL Yesterday’s Totals Report File 

GR2UCI.CTL Universal Credit Insertion File 

GR2UMTBL.CTL Unit of Measure File 

GR2UPD.CTL Update File 

GR2PST.CTL Electronic Flip Chart File 

 

GROCERY\FILES\LOG 
 

ARC.LOG Contains a general system log generated by SMWARC.EXE.  
This file can be used to trace errors in the EOD Archive 
program. 

AUTOEOD.LOG Contains the actions relating to the automatic EOD: 
Enabling/Disabling the Automatic EOD function in the 
System Configuration, setting or changing the automatic 
start times for each day of the week, selecting to skip or un-
skip an automatic EOD and the execution of a manual EOD. 

Note: If the automated EOD sees that a manual EOD has been executed at the time 
an automated EOD is scheduled to start, an entry will be made in the 
AUTOEOD.LOG file and the automated EOD will abort. 

ERROR.LOG Log for viewing from System Services/User-Defined Menu.  
Displays all errors reported by ScanMaster Programs.  
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SM2FRLOG.LOG Log for viewing actions performed using the Force Cashier 
Logoff function: The date/time the action took place, the 
employee logged into ScanMaster when the logoff occurred, 
the cashier (or lane) that the action affected and the action 
type (Cashier Logoff or Office Status Reset). 

 

GROCERY\FILES\ASC 
 

AUDTRAIL.ASC An ASCII file listing of any activity that affects the office 
safe, for example, a drawer pickup or opening a register. 

AUDTRAIL.OLD ScanMaster keeps the audit trail for two days; this file is a 
copy of AUDTRAIL.ASC from the previous day. 

GRCTLOG.ASC Combined Transaction Log (TLOG) Each ScanMaster site 
has a file in which information changes specific to that site 
are logged. 

ITMHSTEX.### A verbose batch error report, where ### is the store 
number. 

TLOGrrnn.ccc POS Workstation Log, (TLOGS), where rr represents the 
POS workstation number; nn represents  the sequence 
number and ccc represents the cashier number. 

 

GROCERY\FILES\MEDIA\IMAGES and GROCERY\FILES\MEDIA\MOVIES 
 

Media files (both images and movies, repectively) are placed in these folders are 
import.  These files are used by the Promotional Media Maintenance program when 
displaying images and movies to the customer on the customer information display. 

GROCERY\FILES\MEDIA\CUSTOMERS 
 

Customer photo images are placed in this folder and will display on the POS terminal 
when doing check tendering, check cashing, or in-store charge tendering.  The picture 
will only appear if the store is using the positive check file and the customer’s picture 
exists in the file. 

The .jpg filename for the customer photo must be placed in this folder using the 
customer’s 12-digit account number. For example, “000000509876.jpg” for customer 
number 000000508876. 
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ASP – Application Service Provider Directory 
ScanMaster is now enabled to support the ASP (Application Service Provider) 
electronic marketplace initiative offered by Retalix.  With ScanMaster ASP enabled, 
store reports and export files are written as text files when both the EOD process and 
Final Deposit are performed.  These files are then automatically transmitted to a web 
server.  Once uploaded, authorized personnel can view both individual store reports 
and consolidated reports (for all stores in the chain) using an Internet browser. 

When the Back Office Setting “Enable ASP Interface” is enabled, ScanMaster 
automatically date stamps these text files and places them in the <Program File 
Drive>:\GROCERY\ASP folder.  The files are given the XXXXmmdd.yy naming 
convention where “XXXX” denotes the report initials (see list below), “mm” denotes 
the month (01-12), “dd” denotes the day (01-31) and “yy” denotes the year (00-99). 

DPAC1101.01 is the Department Activity Report for November 1, 2001. 

Report 
Initials 

Description 

ENDD Enhanced Department Report - Daily 

ENDW Enhanced Department Report - Last Week 

DHSD Department Historical Report - Daily 

DHSW Department Historical Report - Last Week 

DPAC Department Activity Report - Daily 

HRAC Hourly Activity Report - Yesterday 

CTNS Consolidated TLOG No Sale Report 

CTNC Consolidated TLOG Non-Scans Report 

CTRT Consolidated TLOG Returns/Refunds Report 

CTOV Consolidated TLOG Overrides Report 

CTNG Consolidated TLOG Negative Sales Report 

CTCS Consolidated TLOG Canceled Sales Report 

CTVD Consolidated TLOG Void Report 

CTEC Consolidated TLOG Error Correct Report 

CTMS Consolidated TLOG Media Swap Report 

SADT Summary Audit Trail Report - Yesterday 

DADT Detailed Audit Trail Report - Yesterday 

CTRT Cashier/Store Totals Report - Trial Balance 

CTRF Cashier/Store Totals Report - Yesterday Final (Created 
during Final Deposit) 

LNPR Lane Productivity Report - Yesterday (Only available if 
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system in Cashier Accountability) 

LNCR Cashier Report for Lane Accountability (Only available if 
system in Lane Accountability) 

NRTL Non-Resettable Totals Report 

SRRT Store Reconciliation Report (in Excel Format) - Trial 
Balance 

SRRF Store Reconciliation Report (in Excel Format) - Final  
(Created during Final Deposit) 

CTGC Consolidated TLOG Gift Cert/Card Report 

ECDP Electronic Coupons by Department - Daily 

CTXT Cashier/Store Totals Export - Trial Balance 

CTXF Cashier/Store Totals Export - Final (Created during Final 
Deposit) 

DPNM Department Name 

GPNM Group Name 

MDNM Media Name 

ITNM Item Export 

MOVE Movement Export 

     

HISTORY - History Directory 
This subdirectory stores archives of the day’s work in a PkZip-compatible format.  
Archives are stored for 365 days.   

If two End-Of-Day Procedures are accidentally run, the redundancies captured in the 
archives provide the means to reconstruct the financial data collected prior to the 
execution of an End-Of-Day Procedure. 

GRCTLOG.ASC Combined Transaction Log (TLOG) 

TLOGrrnn.ccc Individual Cashier Transaction  Logs (TLOGS), where rr 
represents the POS workstation number; nn  represents the 
sequence number and ccc represents the cashier number. 

GRCCLGnn.ccc Individual Cashier Check Logs,  where nn represents the 
sequence number and ccc the cashier number. 

GR2DPTRG.BTR Department Total (If Accountability By Lane is active in 
Back Office Settings) 

GR2DPTTL.BTR Department Total (If Accountability By Lane is not active 
in Back Office Settings) 

GR2TILL.BTR Delayed Financial Data 
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GR2TLDPT.BTR Previous Day’s Department Total 

GR2RECON.BTR Data for finalized cashiers 

GR2FINAL.BTR Yesterday’s data for finalized cashiers 

DRmmddyy.DAT Historical Department Files. mmddyy represents the month, 
day and year in which the file was created. 

AUTOEOD.LOG The automatic EOD log prior to cleaning (based on the Back 
Office Setting “Days Historical Data to Save”). 

SM2FRLOG.LOG The log showing actions performed using the Force Casher 
Logoff function. 

TRAIL.OLD The renamed usage trail log (TRAIL.ASC) prior to cleaning 
(based on the Back Office Setting “Days Historical Data to 
Save”). 

 

All ScanMaster Reconciliation Reports (SRR) 

 

LASTZ.RUN File which stores when the last End-Of-Day Procedure was 
run and whether it was run automatically or manually. 

AUDTRAIL.OLD Yesterday’s pickups and loans, settlements, deposits, office 
reconciliation and office adjustments. 

AUDTRAIL.ASC Today’s pickups and loans 

*.LOG Any miscellaneous error logs residing in the \ASC and 
\LOG subdirectories 

TRAIL.ASC Log that shows Logins and Logoffs on the system and 
programs accessed. 

JOURNAL - Journal Directory 
This directory contains the databases for the Electronic Journal (if this optional 
module is used).   

When a cashier is settled or a pickup is performed, SM2EJ.EXE processes the 
associated Transaction Log (TLOG) files into the database. All line item transactions 
and relevant descriptive data (such as cashier information) are copied into the 
database. 

SM2SJRPT.EXE is the program that permits the access of information processed into 
the database files, and are called when the menu option Electronic Journal Reports. 
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REGFILES - Register Files Directory 
This directory serves as a template for the files which are on each POS workstation.  
When changes occur within a file in this directory, a copy is made for each POS 
workstation and placed in the UPDATE directory.  The three (3) digit filename 
extension displays the number of the POS workstation for which the file is intended.  
The default file is kept in this directory and usually bears the extension .DAT. 

When a POS workstation is updated, or when the End-Of-Day Procedure is run, each 
POS workstation checks the UPDATE directory to retrieve the appropriate file.  The 
file is then deleted from the UPDATE directory. 

 

BANNER.001 

BANNER.002 

and so forth 

BANNER.DAT 

Banner File 

BOTLINK.001 

BOTLINK.002 

and so forth 

BOTLINK.DAT 

Bottle Link Table 

CONTROL.001 

CONTROL.002 

and so forth 

CONTROL.DAT 

POS Workstation Settings File 

COUPON.001 

COUPON.002 

and so forth 

COUPON.DAT 

Coupon Price Codes File 

DEFDRIVE.001 

DEFDRIVE.002 

and so forth 

DEFDRIVE.DAT 

Default Drive Letter (usually C:) 

DYNXLAT.001 

DYNXLAT.002 

and so forth 

DYNXLAT.DAT 

DynaKey Keyboard Layout 

ERR.001 Error File 
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ERR.002  

and so forth 

ERR.DAT 

FILECHEK.001 

FILECHEK.002 

and so forth 

FILECHEK.DAT 

Generated by the GROCERY /FILECHECK 
command to verify the correct data files are in 
place to support the register configuration 

FRQDISC.001 

FRQDISC.002 

and so forth 

FRQDISC.DAT 

Frequent Shopper Discount Table 

GRCDISP.001 

GRCDISP.002 

and so forth 

GRCDISP.MSG 

Displays every string literal in the code, 
allowing the editing of displayed messages at 
POS workstation 

KBDDEPT.001 

KBDDEPT.002 

and so forth 

KBDDEPT.DAT 

Department Keyboard Link File 

KBDXLAT.001 

KBDXLAT.002 

and so forth 

KBDXLAT.DAT 

KBDXLAT.PC 

Keyboard File 

KEYPRIME.001 

KEYPRIME.002 

and so forth 

KEYPRIME.DAT 

For Regression Testing: Simulates key press 
(Playback Mode) 

LANDRIVE.001 

LANDRIVE.002 

and so forth 

LANDRIVE.DAT 

Network Drive Letter (usually F:) 

LVLDESC.001 Frequent Shopper Level Descriptor File 
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LVLDESC.002 

And so forth 

LVLDESC.DAT 

MEDIADSC.001 

MEDIADSC.002 

and so forth 

MEDIADSC.DAT 

Payment Media Descriptor File 

NCR.001 

NCR.002 

and so forth 

NCR.DAT 

Tells the system that the code is running on 
NCR hardware 

OVRDREAS.001 

OVRDREAS.002 

and so forth 

OVRDREAS.DAT 

Override Reason Code File 

PRESET.001 

PRESET.002 

and so forth 

PRESET.DAT 

PLU Code File 

RAMDRIVE.001 

RAMDRIVE.002 

and so forth 

RAMDRIVE.DAT 

RAM Disk Drive Letter (usually virtual Drive 
D:) 

RANDOM.001 

RANDOM.002 

and so forth 

RANDOM.DAT 

Limits the number of random winners per day 
(See Chapter 3, “System Setup,” POS 
Workstation Settings, “Maximum # of Random 
Winners” for more information.) 

REPRTDSC.001 

REPRTDSC.002 

and so forth 

REPRTDSC.DAT 

Available Reports Descriptor File 

RTRNREAS.001 

RTRNREAS.002 

Return Reason Code File 
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and so forth 

RTRNREAS.DAT 

STATES.001 

STATES.002 

and so forth 

STATES.DAT 

State abbreviation list for checks 

STATUS.001 

STATUS.002 

and so forth 

STATUS.DAT 

Displays status in order of priority during item 
entry 

TARE.001 

TARE.002 

and so forth 

TARE.DAT 

Tare Weight Code File 

TAX1.001 

TAX1.002 

and so forth 

TAX1.DAT 

Tax Table 1 

TAX2.001 

TAX2.002 

and so forth 

TAX2.DAT 

Tax Table 2 

TAX3.001 

TAX3.002 

and so forth 

TAX3.DAT 

Tax Table 3 

TAXCODE.001 

TAXCODE.002 

and so forth 

TAXCODE.DAT 

Tax Code Description File 

TRANCODE.001 

TRANCODE.002 

and so forth 

Transaction Number File 
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TRANCODE.DAT 

TSTATUS.001 

TSTATUS.002 

and so forth 

TSTATUS.DAT 

Displays status in order of priority during 
tendering 

VOIDREAS.001 

VOIDREAS.002 

and so forth 

VOIDREAS.DAT 

Void Reason Code File 

TELXON - Telxon Directory 
This is an optional directory requiring an additional software module.  If the store is 
using Telxon shelf scanning equipment, the temporary batch files for that equipment 
reside in this directory. 

All pertinent executables (.EXE) are in the \GROCERY subdirectory of the device 
running the FM software. 

TILL - Till Directory 
The Transaction Logs (TLOGS) of settled cashiers are stored in this subdirectory.  
 
A Transaction Log has the filename convention of TLOGrrnn.ccc, where rr represents 
the POS workstation number; nn represents the sequence number and ccc represents 
the cashier number. 

UPDATE - Update Directory 
Updates and changes to the REGFILES reside in this directory.  When a POS 
workstation is updated, or when the End-Of-Day Procedure is run, each POS 
workstation checks this directory for information which has been written to a file 
bearing its unique POS workstation number.  After the POS workstation retrieves the 
file, the file is deleted from the UPDATE directory. 
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Additional Workstation Software Index 

Directory Structure 
        

    GROCERY   HOST 

    HISTORY   LOCAL 

    JOURNAL   OFFSALE 

    REGFILES   SRR 

ROOT    ASP    FILES  BLANK 

    TELXON      CTL 

    TILL       ASC 

    UPDATE      LOG 

    SCAN1DOS     SCRIPTS 

 

Note:  The additional Back Office Workstation has one Local Drive (C:).  All files are 
accessed from the file server’s (F:) Drive.  The directory structure of the additional 
Back Office Workstation is similar to that of the file server. 
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Additional Workstation Directories 
GROCERY  ScanMaster Executables, .Dat and .Bat files 

FILES  Btrieve Data Files 

 BLANK Blank Btrieve Data Files 

 CTL Btrieve Control Files 

 LOG Error Logs 

   ASC   ASCII Files, Cashier Logs 

   SCRIPTS  SQL Script Files 

HOST Host Batches 

LOCAL  Local Batches 

OFFSALE Sales Batches 

SIL ScanMaster SIL Interface 

ACHIVE Previously processed SIL Files 

BATCH ScanMaster Batches post-import 

DECODE Temporary file location for SIL Processor 

ENCODE Extract Request Files 

OUTPUT Log and Extraction Data Files 

SOURCE Host SIL Files 

TEMPLATE Extract Template Files 

SRR Spreadsheet data files. 

ASP ScanMaster ASP Report and Export Files 

HISTORY  Archived Records 

JOURNAL  Electronic Journal 

REGFILES  POS Workstation (Register) Personalization Files 

TELXON  FM Software 

TILL  Settled Transaction Logs (TLOGS) 

UPDATE  Updates from the Back Office Workstation to the POS workstations. 

SCAN1DOS  (LAN drive data collection). 

Note: The local drive contains ScanMaster’s executable files, while the LAN drive 
contains the system’s data collection files. 
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POS Workstation Software Index 

Directory Structure 
    DOS 

    GHOST 

ROOT   PVSW 

    GROCERY      ASC 

    RAMDRIVE  FILES   BACKUP 

    CID       BLANK 

            CTL 

            LOAD 

                                                                              LOG 

            MEDIA 

                             IMAGES 

                                                                                                     MOVIES 
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POS Workstation Directories 
ROOT   

      

 GHOST   Norton Ghost Utility Program 

 PVSW     Pervasive SQL Workstation Directory 

 GROCERY   Grocery Executable, .Dat and .Bat files 

   FILES     Btrieve Data Files    

   ASC          ASCII Files, Cashier Logs 

   BACKUP   Backup of previous versions of software  
         
   BLANK  Blank Btrieve Files 

   CTL   Control Files used to create Btrieve Files 

   MOVIES  Contains Multimedia Files  

   LOAD   Not currently used 

   LOG   Error Logs 

 RAMDRIVE Folder used in lieu of DOS Ram Drive 

      CID  Contains the Customer Information Display drivers 
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Files for 
POS Workstation 

<Program File Drive>:\ - ROOT Directory 

 
7156DLLG.EXE Stores the logo for the receipt printer 

AUTOEXEC.BAT System startup command file 

BDELAY.EXE Delays network login after a reboot to allow Windows to 
remove previous session 

COMMAND.COM DOS system command interpreter 

CONFIG.SYS System device configuration file 

GROCERY DIRECTORY  <Program File Drive>:\GROCERY 
7156DLLG.EXE NCR logo load utility 

APTMEDIA.DAT Configuration file for S&H GreenPoints 

BANNER.DAT Scrolling banner message 

BOTLINK.DAT Bottle linking table 

CONTROL.DAT ScanMaster POS workstation configuration file 

CONTROL.TMP Template for System Configuration settings 

COPYPARM.EXE ScanMaster Parameter Copy Utility 

COUPON.DAT Manufacturers coupon price table 

DEFDRIVE.DAT Default drive letter 

DEPT.ICO Department Icon 

DPTVALID.DAT Department Validation File 

DRVRMSG.NCR Data file containing NCR driver error messages that the 
ScanMaster program loads to display 

DYNXLAT.DAT DynaKey keyboard layout 

EFTDRIV2.DAT Holds the mapped drive designation where the secondary 
EFT files will be placed to allow a second EFT Manager 
application to route the check tender to a different host 
switch 

ERR.DAT ScanMaster cashier error database file 

FILECHEK.DAT Generated by the GROCERY /FILECHECK command to 
verify the correct data files are in place to support the 
register configuration 

FILEIN Logo to print on receipt 
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FILEOUT Final Logo File which gets transmitted to the printer 

FRQDISC.DAT Frequent shopper discount table 

G3700726.BOM NCR LPIN Number for the software loaded 

GR2DEPT.BTR Btrieve Department File 

GRCDISP.MSG Cashier prompts 

GRCSFUPD.ASC  Defines the files that are considered for update 

KBDDEPT.DAT Department key layout 

KBDXLAT.DAT Keyboard layout 

KEYPRIME.DAT Required if Record Mode is active. (Created during record 
mode to be used by playback mode). 

LANDRIVE.DAT Network Drive Letter 

LVLDESC.DAT Descriptions of each customer level 

MEDIACFG.DAT Media Configuration File 

MEDIACFG.TMP Template for Media Configuration File 

MEDIADSC.DAT Tender descriptions 

NCR.DAT Flag file to specify ScanMaster is running NCR hardware. 

NCR7156.LGO NCR flag file to print a logo 

OVRDREAS.DAT Price override reasons codes 

POMAP.DAT All available paidouts on flip charts at POS workstations 

PRESET.DAT Department key UPC preset codes 

RAMDRIVE.DAT RAMdisk drive letter file 

RANDOM.DAT Local File containing the number of random winner 
coupons that are currently issued 

REGTIME.BAT Server/Workstation Time Synchronization batch file  (Note:  
If the name of the server is something other than SERVER, 
this file must be edited to path to the correct server name). 

REPRTDSC.DAT Available Reports Descriptor File 

REGSTART.DAT File used to pass the Grocery.exe parameters within a 
Windows POS Workstation environment  (See 
REGSTART.DAT below) 

RLAUNCH2.EXE Register Launch Program (used in conjunction with 
REGSTART.DAT) 

RTRNEAS.DAT Item return reason codes 

SMCIDPIC.DAT Manually created file to place a logo on the CID.  (Note:  
The file contains a single line pathing to the .JPG file). 

STATES.DAT State abbreviations for checks 
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STATUS.DAT Available functions appearing under the status key during a 
sale 

TARE.DAT Scale tare weight codes 

TAX1.DAT Tax table 1 

TAX2.DAT Tax table 2 

TAX3.DAT Tax table 3 

TAXCODE.DAT Receipt tax code for single or multiple tax 

TRANCODE.DAT Transaction counter 

TSTATUS.DAT Available functions appearing under the status flag at total 
time 

VARTARE.DAT Variable Tare Codes 

VOIDREAS.DAT Item void reason codes 

WGROCERY.EXE ScanMaster Windows executable 

<Program File Drive>:\GROCERY\FILES 
 

GR2BUNDL.BTR Bundle File Maintenance Codes  

GRCCLGss.ccc Check Log (ss represents a sequence number and ccc is a 
cashier or lane number) 

GR2CHARG.BTR Accounts Receivable Charge File 

GR2CHIST.BTR In-Store Charge History File 

GR2CPLNK.BTR Coupon Link File 

GR2CPN.BTR Receipt Coupon Print File 

GR2CPRMO.BTR CID Promo File 

GR2CUST.BTR Customer File 

GR2CUSTX.BTR Extended Customer File 

GR2DEPT.BTR Department file 

GR2DPTRG.BTR Active Department Totals File (If Accountability By Lane is 
active in Back Office Settings) 

GR2DPTTL.BTR Active Department Totals File (If Accountability By 
Cashier is active in Back Office Settings) 

GR2FRATE.BTR Foreign Currency Exchange Rate File 

 

GR2HOUR.BTR Hourly Activity Report File 

GR2ITEM.BTR Item File 

GR2MDFEE.BTR Media Fees File 
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GR2MIX.BTR Mix and Match File 

GR2NCHEK.BTR Negative Check File 

CR2POINT.BTR Electronic Coupon File 

GR2PRICE.BTR Adjective Price Lookup File 

GR2PRS.BTR Employee file 

GR2PRSRG.BTR Totals Report File (If Accountability By Lane is active in 
Back Office Settings) 

GR2PRSTL.BTR Totals Report File (If Accountability By Cashier is active in 
Back Office Settings) 

GR2REGTL.BTR Register Totals File 

GR2RCODE.BTR Report Code File 

GR2POSOP.BTR Register NCR Security File 

GR2RSTCT.BTR Department Sales Restriction Matrix File 

GR2SFUPD.ASC Defines the files that are considered for update 

GR2SFUPD.BTR Software Update File 

GR2SUBD.BTR Subdepartment File 

LOCAL999.BTR Local Not Found Batch (for Off-Line Mode) 

GR2PSTxx.BTR Electronic Flip Charts (xx represents the department 
number) 

REGLOG Register Error Log 

REGLOG.XXX POS workstation error log file 

STATIC.DAT Contains power-fail transaction data 

STATIC1.PFL Contains power-fail transaction data 

SUSPEND.DAT Permits suspended transactions in Offline Mode. Generated 
by the system. 

TLOGINIT.DAT Temporary POS initialization record 

Txxxxxxx.ccc Electronic Journal Transaction Files (xxxxxxx represents the 
sequence number and ccc the cashier number)  

TLOGxxyy.zzz Transaction Log File (xx represents the lane, yy the 
sequence number and ccc the cashier number) 

<Program File Drive>:\GROCERY\FILES\BLANK  
 

GR2BUNDL.BTR Blank Bundle Code File 

GR2DPTRG.BTR Blank Department total file for lane accountability 

GR2DPTTL.BTR Blank Department total file for end of day clearing 
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GR2FRATE.BTR Blank Foreign Currency File 

GR2HOUR.BTR  Blank Hourly Activity File 

GR2MDFEE.BTR Blank Media Fees File 

GR2PRICE.BTR Blank Adjective Price File 

GR2PRSRG.BTR Blank Media Total File for lane accountability 

GR2PRSTL.BTR Blank cashier total file for end of day clearing 

GR2REGTL.BTR Blank backup cashier total file for end of day clearing. 
 
 

<Program File Drive>:\GROCERY\FILES\CTL  
 

GR2BUNDL.CTL  Bundle Code Control File 

GR2DPTTL.CTL Department Total Control File 

GR2FRATE.CTL Foreign Currency Control File 

GR2HOUR.CTL Hourly Activity Control File 

GR2ITEM.CTL Item Control File 

GR2MDFEE.CTL Media Fee Control File 

GR2PRICE.CTL Adjective Price Control File 

GR2PRSTL.CTL Cashier Total Control File 

GR2REGTL.CTL Register Total File 

RAMDRIVE DIRECTORY  <Program File Drive>:\RAMDRIVE 
The files located in the RAMDRIVE directory are created automatically during a 
transaction and exist temporarily until the transaction is completed.  
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REGSTART.DAT 
The POS Workstations C:\GROCERY\REGSTART.DAT contains the parameters that, 
in  previous versions of ScanMaster , were passed through the GROCERY.EXE line of 
the Autoexec.bat file.  The parameters entered in the REGSTART.DAT file are called 
whenever ScanMaster is started on the POS Workstation, the parameters set in the 
REGSTART.DAT file are called (through RLAUNCH.EXE). 

Note: Some of these settings are overwritten by the OPOS configuration (where 
noted below). 

/FT 

Use the Fujitsu Touch Screen. 

/F32 

Use the Fujitsu Touch w/TeamKey Keyboard. 

/F92 

Use the Fujitsu 92R Touch w/TeamKey Keyboard. 

/BW 

Use color scheme on operator display designed for a black and white monitor. 

/REC 

Place POS in Sale Record Mode 

/PLAY  

Place POS in Playback mode 

/SCERROR  

Send beeps to the Sound Card 

Note: You can change the wave file used for the ScanMaster error tone.  In Windows 
XPe enter the Control Panel, select Sounds and Audio Devices.  Click on the Sounds 
Tab.  In Program Events click on Default Beep.  Change and play the sounds desired 
for the error tone.  The default beep set here will be used by ScanMaster. 

/SCANTYPE:MAGELLAN 

Use Magellan Scanner/Scale interface instead of OPOS configured 
Scanner/Scale 

/SCANc 

Scanner com port configuration 

c = 1-8 (overridden by OPOS configuration) 

/SCALEc 

Scale Com port  

c = 1-8 (overridden by OPOS configuration) 
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/BANKc:bbbb 

Payment Terminal configuration where 

c = serial com port 1-8 

bbbb = baud rate (default 9600) 

/COINc 

NCR 2010 Coin Changer configuration 

c = serial com port 1-8 

/APTc:bbbb 

S&H GreenPoints Interface configuration (xiNETix spec 1.05 and prior) 

c = serial com port 1-8 

bbbb = baud rate (default 9600) 

/XINETIXc:bbbb 

S&H GreenPoints Interface configuration (xiNETix spec 1.06 and prior) 

c = serial com port 1-8 

bbbb = baud rate (default 9600) 

/NOR 

Disable Register Reboot and End of Day 

/NOCDISP 

Disable communication to 2X20 customer display 

/NCR7156 

Use NCR 715x thermal printer 

/NOSED 

Disable the communication of Scanner Enable / Disable commands 

/NOPRT 

Disable Printer communication/NOSCAN 

/NOSCAN 

Disable Scanner/Scale communication 

/XV 

Disable all validation printing 

/NOOFFLINE 

Disable display of Offline Icon 

/JOURNAL 

Enable Journal Printer communication 
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/PAYMENT:(type) 

Electronic Payments Interface selection 

/PAYMENT:EPI = Universal Payment System Version 2 

/PAYMENT:EFT = Universal Payment System Version 2 

/PAYMENT:CONCORD = Concord's EFT Manager 

/PAYMENT:APT = S&H GreenPoints  

/PAYMENT:XINETIX = S&H GreenPoints  

/PAYMENT:OPENEPS = MTXEPS OpenEPS API (verified by 
ScanMaster HASP Security) 

/DYNAKEY 

Enables NCR DynaKey screen layout.  Omit for non-DynaKey. 

/DYN800 

Enables 12.1” and DVI (Digital Video Interface) DynaKeys 

/D:xx 

Restart delay in seconds.  Limited to max 99 seconds.  Used to fix restart error 
on slower machines. 

/? 

Displays setting options in Notepad 
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ScanMaster Financial Data Flow 

At the Register 
 

When the register is online and communicating with the server, data is read from and 
written to files on the server’s shared LAN drive.  If the register is not communicating 
with the server, these files are read from and written to data collect files on the 
register’s local hard drive. 

 

When the register is offline, the files on the local hard drive collect transaction data, 
and are automatically updated when the register is back online. 

Read Only 
\GROCERY\FILES\GR2DEPT.BTR (department file) 
\GROCERY\FILES\GR2CPN.BTR (promotion/coupon file) 
\GROCERY\FILES\GR2ITEM.BTR (item file) 
\GROCERY\FILES\GR2RSTCT.BTR (dept restriction table) 
\GROCERY\FILES\GR2NCHEK.BTR (negative check file) 
\GROCERY\FILES\GR2CPLNK.BTR (coupon link file) 
\GROCERY\FILES\GR2CPRMO.BTR (CID promotion) 
\GROCERY\FILES\GR2PST##.BTR (Electronic flip charts, ## is department number) 

Write Only  
\GROCERY\FILES\GR2DPTTL.BTR (dept totals if cashier accountability) 
\GROCERY\FILES\GR2DPTRG.BTR (dept totals if lane accountability) 
\GROCERY\FILES\GR2HOUR.BTR (hourly activity totals) 
\GROCERY\FILES\GR2CHIST.BTR (in-store charge history) 
 

Read and Write 
\GROCERY\FILES\GR2CHARG.BTR (in-store charge log)  
\GROCERY\FILES\GR2PRSTL.BTR (media totals – Cashier Accountability) 
\GROCERY\FILES\GR2PRSRG.BTR (media totals – Lane Accountability) 
\GROCERY\FILES\GR2PRS.BTR (employee file) 
\GROCERY\FILES\GR2CUST.BTR (customer file) 
\GROCERY\FILES\GR2POINT.BTR (electronic coupon file) 
\GROCERY\FILES\GR2NCHEK.BTR (negative check file) 

EFT Logs 
If the POS Workstation Setting DISABLE EFT LOGGING = N then EFT logs are kept 
on the register’s local hard drive throughout the day.  These files are moved to the 
server at the End-of-Day. 
 
\GROCERY\FILES\AUTHLOG.rrr (log of EFT auth records)   
\GROCERY\FILES\SNFLOG.rrr (log of EFT store-and-forward records) 
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Signature Capture Files 
If the POS Workstation Setting option ENABLE ELEC SIGNATURE CAPTURE = YES, 
tendered media types that have the setting SIGNATURE LINE ON SLIP = Y will 
produce TIFF (Tag Image File Format) files containing captured signature data.   

 
\GROCERY\FILES\tttttttt.Sxx (Signatuer Capture Files where tttttttt is the 
transaction number and xx is the tender number within the sale) 

 

For example, if transaction number 01234567 has three tenders: Visa, Cash, 
MasterCard, the signature for the Visa payment would be 01234567.S01 and the 
signature for the MasterCard payment would be 01234567.S03. 

The TLOG writing routine will (1) copy all signature files to the F:\JOURNAL 
directory for the Electronic Journal Processor to record and (2) delete files after 
successful transfer.  These steps will only be taken when the POS is in ONLINE mode.  
When OFFLINE, the files will neither be copied to the server nor deleted from the 
local hard drive of the POS. 

The Offline Consolidation routine will search for and copy all found signature capture 
files from the local hard drive of the POS to the server for processing by the Electronic 
Journal Processor.  This file transfer will happen in unison with the existing Electronic 
Journal TLOG consolidation. 

The Electronic Journal will record the filename of the signature file associated with 
each tender and store the filename in the Electronic Journal database along with the 
other transactional data.  The files will remain on the server but not incorporated into 
the core Electronic Journal Database. 

Electronic Coupons 
If the POS Workstation Setting option ENABLE UNVRSL MRKTING INTERFACE = 
YES, Electronic Coupons issued to the customer are written to the <LAN 
Drive>:\Grocery\Files\UMI folder using the LLTTTTTT.UMI filename (where LL is 
the lane number and TTTTTT is the transaction number).  The file layout is listed 
below: 

Field Name Field 
Length 
(Bytes) 

Field 
Type 

Notes 

Function Code 1  L = Electronic Coupon 

Sequence # 5   

Type 1  

1 = UCI 
2 = ScanMaster UPC 
3 = ScanMaster Mix & Match 
4 = ScanMaster Report Code 
5 = ScanMaster Bundle Code 
6 = ScanMaster Promo Code 
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Field Name Field 
Length 
(Bytes) 

Field 
Type 

Notes 

7 = ScanMaster Department 
8 = ScanMaster Total Sale 

Lookup Code 20 RJ0  

Status 1  0 = Normal 
1 = Void 

Discount Sponsor 1  0 = Store 
1 = Manufacturer 

Department 4 RJ0  

Description 20 LJS  

Qty 2 RJ0  

Amount 6 RJ0 2 Decimal Places (9999.99) 

Blank 95 0F  

Field Types: RJ0 (Right-Justified, Zero-Filled), LFS (Left Justified), 0F (Zero-filled) 
 

If an Electronic Coupon is voided, a void Electronic Coupon record is sent through 
the Universal Marketing Interface (see Status field above). 

Electronic Journal 
The electronic journal records real time item movement. Each transaction is 
represented by a separate electronic journal file. The TLOG processor processes the 
data and makes it available to the Electronic Journal reports. 

During each sale 
Electronic Journal records are written to the register. 
C:\GROCERY\FILES\Rrrttttt.ccc  

rr = register number 

ttttt = transaction number 

ccc  = cashier number or lane number 

At the end of each sale 
Electronic Journal files are written to the server. 
<LAN Drive>:\JOURNAL\Trrttttt.ccc  

rr = register number 

ttttt = transaction number  

ccc  = cashier number or lane number 
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Transaction Logs and Checklogs 
Sign On 
At Cashier sign on for both Cashier accountability and Lane accountability, a 
transaction log (TLOG) is created on the register’s local hard drive and appended to at 
the end of each transaction during that cashier’s session on that register. 
C:\GROCERY\FILES\GRCTLOG.ccc 

ccc  = cashier number  

A checklog is created on the register’s local hard drive and written to at the end of 
each transaction during that cashier’s session on that register: 
C:\GROCERY\FILES\GRCCLOG.ccc 

ccc  = cashier number 

After Each Transaction 
At the end of each transaction for both Cashier accountability and Lane 
accountability, the transaction log (TLOG) is moved to the server. 
<LAN Drive>:\GROCERY\FILES\TLOGrrnn.ccc 

rr = register number 

nn = session number (beginning with 00)  

ccc  = cashier number  

After Sign Off 
The checklog (checking account and amount information, also charge information) is 
moved to the server. 
<LAN Drive>:\GROCERY\FILES\GRCCLGss.ccc 

ss = session number (beginning with 00)  

ccc = cashier number  

If you turn on the Back Office Setting PRINT CASHIER LOG FILES, checklog data will 
be printed on the cashier settlement report. The register writes net totals. 
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Pickup and Loan Data Flow  

Accept 
At accept of each Pickup or Loan, media totals are written to the following files. 
<LAN Drive>:\GROCERY\FILES\GR2PRSTL.BTR if using cashier accountability  
<LAN Drive>:\GROCERY\FILES\GR2PRSRG.BTR if using lane accountability 

 

The office record is modified in: 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 
Transaction Log (TLOG) data is written to the following files. 
<LAN Drive>:\GROCERY\FILES\TLOGrrnn.ccc 

rr = back office is always 00 

nn = session number (beginning with 01)  

ccc  = cashier number  

Details 
Pickup or loan details are written to the Audit Trail. 
<LAN Drive>:\GROCERY\FILES\ASC\AUDTRAIL.ASC 
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SRR Adjustments for the Current Day 

Handkeyed Receipt 
Handkeyed Receipt totals are written to the following file. 
<LAN Drive>:\GROCERY\SRR\REmmddyy.dat 

mm = month 

dd = day  

yy  = year 

The office record is modified in: 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 

Handkeyed Paidout 
Handkeyed Paidout totals are written to the following file: 
<LAN Drive>:\GROCERY\SRR\POmmddyy.dat 

mm = month 

dd = day  

yy  = year 

The office record is modified in: 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 
 

Note: An audit trail is provided for the SRR.  A record will be written to the audit 
trail file each time a change is made by hand to the SRR. 

Handkeyed receipts or paidouts should always be made for the current day. 
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Mid-Day Deposit Data Flow  
When an End-of-Day is activated, the files DEPOSIT.DUN and RECON.DUN are 
deleted from the <LAN Drive>:\GROCERY directory and some options are grayed-
out on the Office Procedures menu. Once all delayed cashiers have been settled, the 
first available option on the Office Procedures menu is Office Reconciliation.  After 
the Office Reconciliation is performed, the first available option on the Office 
Procedures menu is Deposits and the RECON.DUN file is created in the <LAN 
Drive>:\GROCERY directory.   

When the RECON.DUN file exists in <LAN Drive>:\GROCERY, the next deposit is 
the final deposit that creates a beginning balance for the next day.  After the final 
deposit is performed, all buttons on the Office Procedures menu are available and the 
DEPOSIT.DUN file is created in the \GROCERY directory.   

When both RECON.DUN and DEPOSIT.DUN exist in <LAN Drive>:\GROCERY, all 
buttons on the Office Procedure menu are available and any deposits performed at 
this time are considered mid-day deposits.  

 

Office Totals 
Office totals are read from the following file. 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 
Office totals are modified for the appropriate media and a deposit record is written to 
the Audit Trail. 
<LAN Drive>:\GROCERY\FILES\ASC\AUDTRAIL.ASC 
 
The system writes deposit information to the appropriate totalizers on the SRR. 
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Accounts Receivable Postings 
When a payment is made to an in-store charge account, the end of day procedure 
decreases the oldest balance in the customer history files. This happens only if you 
run SMWAGE.EXE or do a Month-End. 
<LAN Drive>:\GROCERY\FILES\GR2CHIST.BTR 
 

When a payment is made to an in-store charge account, the end of day procedure 
decreases the total balance in the Charge File. 

<LAN Drive>:\GROCERY\FILES\GR2CHARG.BTR and increases the office balance in:  

  

The office record is modified in: 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 
Note: If GRCCHIST.BTR and GR2CHARG.BTR get out of sync, there is a utility to 
get them back in sync. GR2CHIST.BTR contains each charge transaction and each 
finance charge record. GR2CHARG.BTR contains the current account balance, account 
limit, and interest rate. 
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Office Adjustment Data Flow  

At accept 
Office Totals are modified in the following file.  

The office record is modified in: 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 
The totalizers in the SRR are written to and modified.  

SRR Totalizer #0217 if safe is increased 

SRR Totalizer #0218 if safe is decreased  

An office adjustment record is written to the Audit Trail: 
<LAN Drive>:\GROCERY\FILES\ASC\AUDTRAIL.ASC 
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Cashier Delay Data Flow  

At Accept 
Media Totals are moved. 
<LAN Drive>:\GROCERY\FILES\GR2PRSTL.BTR if using cashier accountability 
<LAN Drive>:\GROCERY\FILES\GR2PRSRG.BTR if using lane accountability 

TO 
<LAN Drive>:\GROCERY\FILES\GR2TILL.BTR  

Department totals are moved. 
<LAN Drive>:\GROCERY\FILES\GR2DPTTL.BTR - cashier accountability 
<LAN Drive>:\GROCERY\FILES\GR2DPTRG.BTR - lane accountability 

TO 
<LAN Drive>:\GROCERY\FILES\GR2DTILL.BTR  
 

Cashier TLOGs are moved. 
<LAN Drive>:\GROCERY\FILES\TLOGrrnn.ccc 

TO 
<LAN Drive>:\TLOG\TLOGrrnn.ccc 

Zero-byte placeholder files are created. 
<LAN Drive>:\GROCERY\FILES\ $LOGrrnn.ccc 

Check Logs are moved. 
<LAN Drive>:\GROCERY\FILES\GRCCLGss.ccc 

TO 
<LAN Drive>:\CHECKLOG\ GRCCLGss.ccc 

Zero-byte placeholder files are created. 
<LAN Drive>:\GROCERY\FILES\$RCCLGnn.ccc. 
  
Note: Department totals for both settled and delayed cashiers are written to 
GR2DTILL.BTR. 
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Cashier Settlement Data Flow  

At Accept  
Media Totals are moved  
<LAN Drive>:\GROCERY\FILES\GR2PRSTL.BTR - cashier accountability 
<LAN Drive>:\GROCERY\FILES\GR2PRSRG.BTR - lane accountability 

TO 
<LAN Drive>:\GROCERY\FILES\GR2RECON.BTR  

Department totals are moved 
<LAN Drive>:\GROCERY\FILES\GR2DPTTL.BTR - cashier accountability 
<LAN Drive>:\GROCERY\FILES\GR2DPTRG.BTR - lane accountability 

TO 
<LAN Drive>:\GROCERY\FILES\GR2DTILL.BTR  

Office Record is Increased 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 

Cashier TLOGs are Moved 
<LAN Drive>:\GROCERY\FILES\TLOGrrnn.ccc 

TO 
<LAN Drive>:\TLOG\TLOGrrnn.ccc 
 

Zero-byte Placeholder Files are Created 
<LAN Drive>:\GROCERY\FILES\$LOGrrnn.ccc. 

Check Logs are Moved 
<LAN Drive>:\GROCERY\FILES\GRCCLGss.ccc 

TO 
<LAN Drive>:\CHECKLOG\ GRCCLGss.ccc 

Zero-byte Placeholder Files are Created  
<LAN Drive>:\GROCERY\FILES\$RCCLGss.ccc. 

A Settlement Record is Written 
<LAN Drive>:\GROCERY\FILES\ASC\AUDTRAIL.ASC 
 
Note: Department totals for both settled and delayed cashiers are written to 
GR2DTILL.BTR. 
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Adjust Settled Cashiers Data Flow 

SM2ADJST.EXE 
Adjust Settled Cashier gets settled cashier information from and writes adjustments 
from the following file. 
<LAN Drive>:\GROCERY\FILES\GR2RECON.BTR 

Modifies the Office Safe Totals. 
 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 

The Cashier Over/Short and Net Store Over/Short on the SRR are updated. 

Updates Cashier Over/Short In Cashier Totals 
 
<LAN Drive>:\GROCERY\FILES\GR2PRSTL.BTR  

Writes both adjusted totals and new complete totals to the audit trail 
 
<LAN Drive>:\GROCERY\FILES\ASC\AUDTRAIL.ASC 
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End of Day Data Flow 

SM2EOD.EXE 
1 – Sets Flag Files 
Flags the beginning of the EOD to inhibit the user’s ability to access certain back office 
programs that will be affected during the EOD. 
<LAN Drive>:\Grocery\Files\EOD.BOF 
 

2 - Copies all of the Batches: 
<LAN Drive>:\GROCERY\HOST    →  <Program File Drive>:\GROCERY\HOST 
<LAN Drive>:\GROCERY\LOCAL   →  <Program File Drive>:\GROCERY\LOCAL 
<LAN Drive>:\GROCERY\OFFSALE  →  <Program File Drive>:\GROCERY\OFFSALE 

3 - Copies the register personalization files 
<LAN Drive>:\REGFILES  →  <Program File Drive>:\REGFILES 

4 - Copies all Btrieve files 
<LAN Drive>:\GROCERY\FILES  → <Program File Drive>:\GROCERY\FILES 

5 - Secret Numbers Reset 
The cashiers’ numbers at the POS workstation are reset. This is not an option. 
\GROCERY\FILES\GR2PRS.BTR 

6 – Makes REG Copy of Btrieve Files 
Makes an REG copy of the Btrieve data files for the registers. This list will vary 
depending on the POS Workstation Settings. These files are read to and copied. They 
are not written to unless the register is offline. 
<LAN Drive>:\Grocery\Files\Gr2prs.reg (employee file) 
<LAN Drive>:\Grocery\Files\Gr2dept.reg (department file) 
<LAN Drive>:\Grocery\Files\Gr2subd.reg (sub-department file) 
<LAN Drive>:\Grocery\Files\Gr2cpn.reg (promotion/coupon file) 
<LAN Drive>:\Grocery\Files\Gr2item.reg (item file) 
<LAN Drive>:\Grocery\Files\Gr2chist.reg (in-store charge history) 
<LAN Drive>:\Grocery\Files\Gr2charg.reg (instore charge log) 
<LAN Drive>:\Grocery\Files\Gr2rstct.reg (department restriction table) 
<LAN Drive>:\Grocery\Files\Gr2nchek.reg (negative check file) 
<LAN Drive>:\Grocery\Files\Gr2cust.reg (processed customer file) 
<LAN Drive>:\Grocery\Files\Gr2pst##.reg (electronic flip chart ## = dept num) 
<LAN Drive>:\Grocery\Files\Gr2cplnk.reg (coupon link file) 
<LAN Drive>:\Grocery\Files\Gr2cprmo.reg (cid promotion) 

7 - Copies Blank Data Collect Files  
Copies blank data collect files from the <Program File 
Drive>:\GROCERY\FILES\BLANK directory to <LAN Drive>:\GROCERY FILES on 
the server.  The BTR files will be used to collect totals for the next day’s business on 
the server’s F: drive. 
<LAN Drive>::\GROCERY\FILES\GR2MVMNT.BTR (if real time movement is turned on) 
<LAN Drive>::\GROCERY\FILES\GR2PRSTL.BTR (media totals if cashier 
accountability) 
<LAN Drive>::\GROCERY\FILES\GR2PRSRG.BTR (media totals if lane 
accountability) 
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<LAN Drive>::\GROCERY\FILES\GR2DPTTL.BTR (department totals if cashier 
accountability) 
<LAN Drive>::\GROCERY\FILES\GR2DPTRG.BTR (department totals if lane 
accountability) 
<LAN Drive>::\GROCERY\FILES\GR2HOUR.BTR (hourly activity totals) 

8 – Writes Register Flag Files  
The end-of-day register flag files are written(EOD.rrr) to the shared directory for each 
register on the store system.  The system knows which registers to update by reading 
REG.TBL in the <LAN Drive>:\GROCERY directory. 
<LAN Drive>::\Grocery\Files\EOD.001 
<LAN Drive>::\Grocery\Files\EOD.002 
<LAN Drive>::\Grocery\Files\EOD.003 

9 – Updates LASTZ.RUN  
Updates <LAN Drive>:\GROCERY\LASTZ.RUN with the current time and date.  
This file tracks when and how an End-of-Day has been run and is used to prevent 
running two EODs during the same day. 

 

8 – Runs EOD Script 
Runs the end of day script, SM2EOD.SCR, which includes the programs below. Each 
application’s dataflow is discussed in more detail in the following section. 

 

SM2CTLOG.EXE 

SM2ARC.EXE 

SM2CDEPT.EXE 

SM2CSHPR.EXE 

SM2TLRPT.EXE 

SM2NRT.EXE 

SM2ACTVT.EXE 

SM2BAPLY.EXE (if doing batch activation) 

Executables added to end of day script 

9 – Deletes End-of-Day Flag 
<LAN Drive>:\GROCERY\FILES\EOD.BOF is the flag that was placed on back 
office workstations, and the server to inhibit users from obtaining access to programs 
that are affected by the EOD. This flag is deleted to allow access to programs that are 
affected by the EOD. 
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Running the End-of-Day Script 

A.  SM2CTLOG.EXE  
SM2CTLOG.EXE consolidates all of the Transaction Logs (TLOGS) for that day. The 
files are written to two places – CRTLOG.ASC, and CTMMDDYY.ASC. 
GRCTLOG.ASC is overwritten at each EOD. 

Consolidates TLOGs 
<LAN Drive>:\Tlog\ 

TO 
<LAN Drive>:\ Grocery\ Files\ Asc\ Grctlog.Asc  

Copies Files 
<LAN Drive>:\Grocery\Files\Asc\Grctlog.Asc  

TO 
<LAN Drive>:\Grocery\Files\Asc\Ctmmddyy.Asc 

mm = month 

dd = day  

yy  = year 

Note: GRCTLOG.ASC and CTmmddyy.ASC are identical until the next day’s EOD. 

B.  SM2CDEPT.EXE 
SM2CDEPT.EXE processes the daily department totals and updates the weekly 
department totals.  

Processes The Department Totals 
<LAN Drive>:\Grocery\Files\Gr2dtill.Btr  
    To 
<LAN Drive>:\Grocery\Files\Drmmddyy.Dat  
<LAN Drive>:\Grocery\Files\Drmmddyy.Ccc 

mm = month 
dd = day 
yy  = year 
ccc = cashier 

Updates Weekly Department Totals 
<LAN Drive>:\GROCERY\FILES\DRWEEK.DAT (this week’s department sales data) 
<LAN Drive>:\GROCERY\FILES\DRLWEEK.DAT (last week’s department sales data) 

C.  SM2CSHPR.EXE 
SMW2SHPR.EXE compiles the lane and cashier productivity information. 

Compiles lane and cashier productivity 
<LAN Drive>:\GROCERY\FILES\ASC\GR2TLOG.ASC  

TO 
<LAN Drive>:\GROCERY\FILES\GR2PROD.BTR 
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D.  SM2TLRPT.EXE 
SM2TLRPT.EXE consolidates the Enhanced Department Report information for the 
day, current week, and last week.  

Enhanced Dept Report for the Day 
<LAN Drive>:\GROCERY\FILES\ASC\GRCTLOG.ASC  (cycles through this file) 

    TO 
<LAN Drive>:\GROCERY\FILES\VDmmddyy.dat  (voids) 

\CRmmddyy.dat  (coupons) 
\DImmddyy.dat  (discounts) 
\DCmmddyy.dat  (department counts) 
\Rtmmddyy.dat  (returns) 

Enhanced Dept Report For The Current Week 
<LAN Drive>:\GROCERY\FILES\VDWEEK.dat  (voids)  

\CRWEEK.dat  (coupons) 
\DIWEEK.dat  (discounts) 
\DCWEEK.dat  (department counts) 
\RTWEEK.dat  (returns) 

Enhanced Dept Report Last Week 
<LAN Drive>:\GROCERY\FILES\VDLWEEK.dat  (voids)  

\CRLWEEK.dat  (coupons) 
\DILWEEK.dat  (discounts) 
\DCLWEEK.dat  (department counts) 
\RTLWEEK.dat   (returns) 

Coupon Totals 
If the following Back Office Settings are set to YES, 

 ADD DBL MFG COUPONS BACK TO SALES 

ADD STORE COUPONS BACK TO SALES 

ADD DBL STORE COUPONS BACK TO SALES 

then the appropriate coupon totals are added to the following files. 
<LAN Drive>:\GROCERY\FILES\DRmmddyy.dat 
<LAN Drive>:\GROCERY\FILES\DRmmddyy.ccc 
<LAN Drive>:\GROCERY\FILES\GR2HOUR.btr 
 

Note: The Btrieve data files are not altered based on these Back Office Settings. 

 

E.  SM2NRT.EXE 
SM2NRT.EXE compiles the non-resettable totals for the day.  
<LAN Drive>:\GROCERY\FILES\ASC\GRCTLOG.ASC   

TO 
<LAN Drive>:\GROCERY\FILES\GR2NTGT.BTR (grand totals) 
 

Note: Non-resettable totals are by lane.  Registers write net sales which include 
manufacturer coupons not store coupons or multiples. 
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F.  SM2ACTVT.EXE 
SM2ACTVT.EXE consolidates the individual cashier records into store records.  
<LAN Drive>:\GROCERY\FILES\GR2HOUR.BTR  

G.  SM2BAPLY.EXE 
These applications run only if batch activation is selected. 

SMWBAPLY.EXE stages and applies batches that are set up for automatic activation 
on this date.    

H.  User Added Applications 

Using SM2EOD.SCR 
A variety of daily store activities -- automatic batch activation, for example-- can be 
executed automatically through ScanMaster’s End of Day procedure.  This is 
accomplished through ScanMaster’s End of Day Script (named SM2EOD.SCR). 

The End of Day Script is among numerous tasks performed by ScanMaster when the 
End of Day routine is performed.  It is located at:  <LAN 
Drive>:\Grocery\SM2EOD.SCR. 

Through this file, other programs, batch files, or various activities can be added to the 
End of Day routine. 

Note: It is recommended that ANY items added to the SM2EOD.SCR file should be 
placed at the end of the file, and before the line containing “SM2ARC”.  This ensures 
ScanMaster’s basic functions are performed first before any supplementary activities 
are completed. 

Using Microsoft Windows Notepad, DOS Editor or some other ASCII file editor, 
append SM2EOD.SCR by adding an: 

• A Program Executable 

• A Batch File 

Adding an Executable 
Stores may want to run a certain software program during the End of Day routine.  
This is accomplished by incorporating the program’s executable file in the 
SM2EOD.SCR. 

For example, to automatically activate and apply a batch of items, the program 
executable file for that ScanMaster program is added to SM2EOD.SCR.  Those 
executable SM2BAPLY is placed at the end of the script before SM2ARC. 
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Note:  There is no need to include .EXE on the executable programs.  ScanMaster 
SM2EOD.SCR assumes the command is an executable so the .EXE extension is not 
needed, but can be used if desired.  In addition, you cannot add command line 
parameters to an executable program within the SM2EOD.SCR file.  If you need to do 
so, place the executable along with the command line parameter(s) in a batch file. (See 
Adding a Batch File below.) 

The SM2XPORT program can be added to the End of Day Script to automatically 
export the Customer File, Electronic Coupon File, Item File and Movement File.   

You can configure what files are exported in the SM2XPORT program by running the 
application without any command line options, and then selecting the appropriate 
reports, and then save.  When SM2XPORT is added to the End of Day Script it will 
process those files saved in the configuration. 

The SM2ESL program can be added to the End of Day Script to either append data 
read from the shared Btrieve (<LAN Drive>:\Grocery\Files\GR2ESL.BTR) file to the 
<LAN Drive>:\ESL\ESL.001 file or create a <LAN Drive>:\ESL\ESL.SCR file which 
will be a complete ScanMaster Item File converted to an ASCII file formatted for the 
Pricer ESL (Electronic Shelf Label) interface.  When added to the SM2EOD.SCR file 
without parameters, the SM2ESL will read the data from the GR2ESL.BTR file, write it 
to the <LAN Drive>:\ESL\ESL.001 file and delete the data from the GR2ESL.BTR file.  
When the command line  “/AUTO” is added, the program will create either the initial 
load file <LAN Drive>:\ESL\ESL.SCR before deleting the data from the GR2ESL.BTR 
file.  

Please see Clear Customer Totals in Chapter 5 of the ScanMaster 2.03 User Guide for 
more information on exporting and clearing customer totals during End-of-Day 
Processing. 

Adding a Batch File 
Batch files can also be included in the End of Day Scripts.  For example, stores may 
use a batch file to send movement information to a host during the End of Day 
procedure. 

This is accomplished by creating and saving a batch file -- for example, 
CALLHOST.BAT -- with the necessary host instructions and then placing that .BAT 
file line in the SM2EOD.SCR. 

This batch file -- and all of its instructions -- runs when it is called during End of Day. 

Note: It is NECESSARY to include the .BAT file extension when including a batch 
file in the End of Day script.  If this is not done the End of Day script will attempt to 
run the application with an .EXE.  Example: If CALLHOST is placed in the End of Day 
script file, the End of Day Process will attempt to run CALLHOST.EXE instead of 
CALLHOST.BAT.   
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Automatic Batch Activation 
One of the most common uses of the ScanMaster End of Day Script is for automatic 
batch activation.  These executables (SM2WAIT and SM2BAPPLY) are placed at the 
end of the EOD script to activate batches -- sale, off-sale, host, etc. -- that start on the 
next business day following the End of Day. 
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End-of-Day Resets Register 
As part of the End-of-Day process, each register is reset for the next day’s business. A 
register must be at the CLOSED prompt before the EOD is automatically performed. 
ScanMaster BackOffice activities, such as the EOD, never interrupt the front-end 
operation.  The End-of-Day process performs the following steps on the POS 
workstation: 

1 – Resets Register Totals 
GR2PRS.BTR 

Secret Number 

Register Number 

2– Resets Random Winner 
If the store is running a promotion in which random winners are selected to win 
prizes each day, then the number of random winners is reset to 0.  
<LAN Drive>:\Grocery\Files\Random.dat 
<LAN Drive>:\Update\Random.xxx 

3 – Copies Blank Files 
Copies the blank files from the blank file on the shared LAN drive to the register.  
<LAN Drive>:\Grocery\Files\Blank\Gr2prstl.btr (Cashier Accountability) 
<LAN Drive>:\Grocery\Files\Blank\Gr2prsrg.btr (Lane Accountability) 
<LAN Drive>:\Grocery\Files\Blank\Gr2dpttl.btr (Cashier Accountability) 
<LAN Drive>:\Grocery\Files\Blank\Gr2dptrg.btr (Lane Accountability) 
<LAN Drive>:\Grocery\Files\Blank\Gr2hour.btr (hourly activities totals) 

TO 
C:\Grocery\Files\Gr2prstl.btr (Cashier Accountability) 
C:\Grocery\Files\Gr2prsrg.btr (Lane Accountability) 
C:\Grocery\Files\Gr2dpttl.btr (Cashier Accountability) 
C:\Grocery\Files\Gr2dptrg.btr (Lane Accountability) 
C:\Grocery\Files\Gr2hour.btr (hourly activities totals 

 

4 – Copies the Error Log 
The local register error log is copied to the shared LAN drive  
C:\grocery\files\reglog.xxx → <LAN Drive>:\Grocery\files\log\Rlmmddyy.xxx 

Rl = Register Log 

MM = two-digit month 

DD = two-digit day 

YY = two-digit year 

XXX = three-digit register number 
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5 – Copies And Deletes EFT Logs 
If the POS Workstation Setting DISABLE EFT LOGGING = No then EFT logs are kept 
on the register’s local hard drive throughout the day. At the end of day, the files are 
copied to the server’s LAN drive, renamed, and then deleted from the register. 
C:\Grocery\Files\AuthLog.xxx (authorization log file) 
C:\Grocery\Files\SNFLog.xxx (store and forward log file) 

TO 
<LAN Drive>:\Grocery\Files\Log\Almmddyy.xxx (authorization log file) 
<LAN Drive>:\Grocery\Files\Log\Slmmddyy.xxx (store and forward log file) 
 

6 – Copies All Reg Files And Converts Them To Btrieve Files 
 

Copies Btrieve files with the REG extension from the <LAN Drive>:\Grocery\Files 
directory on the server to the C:\Grocery\Files directory on the register, and changes 
the extension from REG to BTR.  
 
C:\GROCERY\FILES\GR2PRS.BTR (employee file) 
C:\GROCERY\FILES\GR2DEPT.BTR  (department file) 
C:\GROCERY\FILES\GR2SUBD.BTR (sub-department file) 
C:\GROCERY\FILES\GR2CPN.BTR (promotion/coupon file) 
C:\GROCERY\FILES\GR2ITEM.BTR (item file) 
 
 

Note: Before copying GR2ITEM.REG to GR2ITEM.BTR, the register determines if 
there will be at least 5MB of memory left on the register after the item file is copied. If 
not, the item file will not be copied and you will get an out of memory error. You will 
have to free memory at the register to continue. 

 
C:\GROCERY\FILES\GR2CHIST.BTR  (in-store change history) 
C:\GROCERY\FILES\GR2HARGE.BTR (in-store charge log) 
C:\GROCERY\FILES\GR2RSTCT.BTR  (department restriction table) 
C:\GROCERY\FILES\GR2NCHEK.BTR  (negative check file) 
C:\GROCERY\FILES\GR2POINT.BTR (processed electronic coupon file and removed 
movement) 
C:\GROCERY\FILES\GR2CUST.BTR (processed customer file and extracted only 
account numbers, control codes, and frequent shopper information) 
C:\GROCERY\FILES\GR2PST##.BTR (electronic flip charts where ## is department 
number) 
C:\GROCERY\FILES\GR2CPLNK.BTR (coupon link file) 
C:\GROCERY\FILES\GR2CPRMO.BTR (CID promotion) 

7 – Deletes the End-of-Day flag 
The end of day flag file is deleted when the register is updated. 

<LAN Drive>:\Update\Eod.xxx 

8 – Copies Personalization Files From <LAN Drive>:\Update 
Copies all personalization files from the shared directory, <LAN Drive>:\Update, 
that has the matching extension number of the particular register and renames the 
files. This list varies depending on which files have been updated since the last end-
of-day. 
<LAN Drive>:\Update\Banner.xxx  → C:\Grocery\banner.dat 
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<LAN Drive>:\Update\BotLink.xxx  →  C:\Grocery\botlink.dat 
<LAN Drive>:\Update\control.xxx  →  C:\Grocery\Control.dat 
<LAN Drive>:\Update\Coupon.xxx  →  C:\Grocery\Coupon.dat 
<LAN Drive>:\Update\Err.xxx   →  C:\Grocery\Err.dat 
<LAN Drive>:\Update\Frqdisc.xxx  → C:\Grocery\Frqdisc.dat 
<LAN Drive>:\Update\Kbddept.xxx  → C:\Grocery\Kbddept.dat 
<LAN Drive>:\Update\Kbdxlat.xxx  → C:\Grocery\Kbdxlat.dat 
<LAN Drive>:\Update\Dynxlat.xxx  → C:\Grocery\Dynxlat.dat 
<LAN Drive>:\Update\Ovrdreas.xxx  → C:\Grocery\Kbddept.dat 
<LAN Drive>:\Update\Preset.xxx  → C:\Grocery\Preset.dat 
<LAN Drive>:\Update\Rtrnreas.xxx  → C:\Grocery\Rtrnreas.dat 
<LAN Drive>:\Update\Tax1.xxx   → C:\Grocery\Tax1.dat 
<LAN Drive>:\Update\Tax2.xxx   → C:\Grocery\Tax2.dat 
<LAN Drive>:\Update\Tax3.xxx   → C:\Grocery\Tax3.dat 
<LAN Drive>:\Update\Taxcode.xxx  → C:\Grocery\Taxcode.dat 
<LAN Drive>:\Update\Tare.xxx   → C:\Grocery\Tare.dat 
<LAN Drive>:\Update\Voidreas.xxx  → C:\Grocery\Voidreas.dat 
<LAN Drive>:\Update\Mediadesc.xxx  → C:\Grocery\Mediadesc.dat 
<LAN Drive>:\Update\reprtdsc.xxx  → C:\Grocery\Reprtdsc.dat 
<LAN Drive>:\Update\Status.xxx  → C:\Grocery\Status.dat 
<LAN Drive>:\Update\Tstatus.xxx  → C:\Grocery\Tstatus.dat 
<LAN Drive>:\Update\Aptmedia.xxx  → C:\Grocery\Aptmedia.dat 
<LAN Drive>:\Update\Lvldesc.xxx  → C:\Grocery\Lvldesc.dat 

 

9 – Reboots the Workstation 
The register will reboot once all of the files have been copied.  
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End-of-Day Archive  
The End-of-Day Archive is executed during the End-of-Day Script. The archiving 
procedure creates and keeps files for a set number of days. You determine the number 
of days with the Back Office Setting, DAYS OF HIST. ARCHIVES TO SAVE. The 
default setting is 14 days. 

SMWARC.EXE:  
Archives the following files into history archive (<LAN Drive>:\HISTORY\ssjjjTL.zip): 

<LAN Drive>:\GROCERY\FILES\ASC\GRCTLOG.ASC  
\GRCTLOG.OLD  
\CTmmddyy.ASC  

<LAN Drive>:\GROCERY\FILES\GRCCLGss.ccc  (individual cashier check logs) 
\GR2DPTRG.BTR  (department totals for lane accountability) 
\GR2PRSRG.BTR  (cashier totals for lane accountability) 
\GR2DPTTL.BTR (department totals for cashier accountability) 
\GR2PRSTL.BTR  (cashier totals for cashier accountability) 
\GR2DTILL.BTR  (department sales data) 
\GR2TLDPT.BTR  (department totals for the previous day) 
\GR2RECON.BTR(cashier & store totals for office reconciliation) 
\GR2TILL.BTR  (delayed cashier data) 
\GR2STORE.BTR (store totals) 
\GR2FINAL.BTR  (totals after office reconciliation, used for final   
 deposit) 
\DRmmddyy.ccc  (individual cashier historical department totals) 
\DRmmddyy.DAT  (daily historical department totals) 
\DRWEEK.DAT   (weekly historical department totals) 
\CRmmddyy.DAT  (daily coupon totals) 
\CRWEEK.DAT  (weekly coupon totals) 
\DCmmddyy.DAT  (daily department counts) 
\DCWEEK.DAT  (weekly department counts) 
\DImmddyy.DAT  (daily discount totals) 
\DIWEEK.DAT  (weekly discount totals) 
\RTmmddyy.DAT  (daily return/refund totals) 
\RTWEEK.DAT  (weekly return/refund totals) 
\VDmmddyy.DAT  (daily void totals) 
\VDWEEK.DAT  (weekly void totals) 
\ECmmddyy.DAT  (electronic coupon totals by department) 

<LAN Drive>:\GROCERY\SRR\*.* 

<LAN Drive>:\GROCERY\LASTZ.RUN 
Provides answer to question, “Did store run 2 EODs during same day?”  A record is 
written to this file at the beginning of an EOD.  (You will be cautioned if you are 
starting the second EOD in a 24-hour period). 

<LAN Drive>:\GROCERY\FILES\LOG\EJ.LOG 
\EOD.LOG  (eod log) 
\ERROR.LOG  (error log) 
\ITRAIL.LOG  (item trail) 
\SM2ARC.LOG  (eod archieve log) 
\RLmmddyy.rrr (Register error log; time stamped) 
\ALmmddyy.rrr  (EFT authorization log) 
\SLmmddyy.rrr  (EFT store and forward log)   

TO 
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<LAN Drive>:\HISTORY\ssjjjTL.ZIP 
ss = last two digits of store number 
jjj = Julian calendar date 

Archives and Deletes 
<LAN Drive>:\TLOG\TLOG*.*  (based on days # TLOG to save) 

<LAN Drive>:\CHECKLOG\GRCCLGss.ccc 

Deletes Place Holders for Tlogs and Checklogs: 
<LAN Drive>:\GROCERY\FILES\$RCCLGss.ccc 

<LAN Drive>:\GROCERY\FILES\$LOGrrtttt.ccc 
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SRR Adjusts Current Day 
The store reconciliation report adjusts the day’s totals for Handkeyed receipts and 
paidouts. 

Handkeyed Receipt:  
The Handkeyed receipt total is written the receipt file for that day’s business, and 
modified in the store totals.  
<LAN Drive>:\GROCERY\SRR\REmmddyy.dat 

mm = month 

dd = day  

yy  = year 

The Handkeyed receipt total modifies cash or check in the office record. 
<LAN Drive>:\GROCERY\FILES\GRCSTORE.BTR 
 

Handkeyed Paidout 
The Handkeyed paidout total is written to the paidout file for that day’s business, and 
modified in the store totals. 
<LAN Drive>:\GROCERY\SRR\POmmddyy.dat 

mm = month 

dd = day  

yy  = year 

The Handkeyed paidout total modifies the office record. 
<LAN Drive>:\GROCERY\FILES\GRCSTORE.BTR 
 
Note: Handkeyed receipts or paidouts for the current day must be recorded in the 
SRR before office reconciliation. 
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Office Reconciliation  
When an End-of-Day is executed, the files DEPOSIT.DUN and RECON.DUN are 
deleted from the <LAN Drive>:\GROCERY directory and some options are grayed 
out on the Office Procedures menu.   Once all delayed cashiers have been settled, the 
first available option on the Office Procedures menu is Office Reconciliation.  After 
the Office Reconciliation is performed, the RECON.DUN file is created in the <LAN 
Drive>:\GROCERY directory and the first available option on the Office Procedures 
menu is Deposits.  

SM2OFREC.EXE 
SM2OFREC.EXE is the application that adjusts the office record in GR2STORE. 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 
SM2OFREC.EXE then copies and renames the file. 
<LAN Drive>:\GROCERY\FILES\GR2FINAL.BTR 
 

The office reconciliation record is then written to the audit trail. 
<LAN Drive>:\GROCERY\FILES\ASC\AUDTRAIL.ASC 
 

The following file is created, which records the current date and time. 
<LAN Drive>:\GROCERY\RECON.DUN 
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Final Deposit  
When an End-of-Day is run, the files DEPOSIT.DUN and RECON.DUN are deleted 
from the <LAN Drive>:\GROCERY directory and some options are grayed out on the 
Office Procedures menu.   Once all delayed cashiers have been settled, the first 
available option on the Office Procedures menu is Office Reconciliation.  After the 
Office Reconciliation is performed, the first available option on the Office Procedures 
menu is Deposits and the RECON.DUN file is created in the <LAN 
Drive>:\GROCERY directory.   

When the RECON.DUN file exists in <LAN Drive>:\GROCERY, the next deposit is 
the final deposit that creates a beginning balance for the next day.  After the final 
deposit is performed, all buttons on the Office Procedures menu are available and the 
DEPOSIT.DUN file is created in the <LAN Drive>:\GROCERY directory.   

When RECON.DUN exist in <LAN Drive>:\GROCERY; but DEPOSIT.DUN does not, 
all buttons on the Office Procedure menu are grayed out except the Deposit button.  
The deposit performed at this time is considered the final deposit. 

SM2DPSIT.EXE 
 

When the office record is modified by making a final deposit, SM2DPSIT.EXE updates 
GR2STORE, and creates a new beginning safe record in <LAN 
Drive>:\GROCERY\FILES\GR2STORE.BTR 
<LAN Drive>:\GROCERY\FILES\GR2STORE.BTR 
 
The deposit totals are written to the appropriate totalizers in the SRR paidout file for 
the current day: 
<LAN Drive>:\GROCERY\SRR\POmmddyy.DAT 
  

The cashier and office totals are moved. 
<LAN Drive>:\GROCERY\FILES\GR2RECON.BTR 

TO 
<LAN Drive>:\GROCERY\FILES\GR2FINAL.BTR 
 

A backup copy of the department totals is created. 
<LAN Drive>:\GROCERY\FILES\GR2DTILL.BTR 
to  
<LAN Drive>:\GROCERY\FILES\GR2TLDPT.BTR 
 

A copy of the final deposit is written to the audit trail 
<LAN Drive>:\GROCERY\FILES\ASC\AUDTRAIL.ASC 
 

A file is created with the current date and time. 
<LAN Drive>:\GROCERY\DEPOSIT.DUN  
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Archiving Files for End of Day 
Overview 

Several Back Office Setting questions dealing with archiving files for End of Day 
processing have been changed. The questions are: 

Days of Hist. Archives to Save: Enter the number of days history that must be archived 
during End of Day. This affects: 

• ZIP files in the <LAN Drive>:\History directory 

• VD, DS, RT, and CRmmddyy.* in the \Grocery\Files directory. 

 
Weeks of SRR to Save: Enter the number of weeks of SRR that are necessary to archive. 
This affects: 

• All spreadsheet files in the \SRR directory. (\SRR\*.DAT) 

• DRmmddyy.* in the \Grocery\Files directory. 

 
Note: The DR*.* (Department Sales) files must follow clearing the SRR files because 
the DR*.* files are used by the SRR. 

 

# of Days of TLOG to Save: Enter the number of days of TLOG that must be archived. 
This is done by SMWCTLOG.EXE. This affects: 

• TLOG.* files in the \TLOG directory. 

• CT*.ASC files in the \Grocery\Files\Asc directory 

 
# of Days of EFT log to Save: Enter the number of days of Electronic Funds Transfer 
communications to archive. (The default is 0 = 60.) 

 

Days Historical Data to Save: Enter the number of days the system will save 
supplemental department information (for example historical voids and error 
correct).  This information is accumulated through the Enhanced Department Report 
and the Department Activity Report.
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Btrieve File Manager 
Overview 

Btrieve is the database file manager that ScanMaster uses to store and retrieve 
information for Back Office and Register functions.  Btrieve database files carry the 
.BTR extension.  
The Btrieve File Manager for ScanMaster version 2 is now supplied by the 
Pervasive.SQL v8 that you will install on your system. The files are now Btrieve 
version 7.x. Although the file sizes don’t change with the newest version, the headers 
have changed.  
Pervasive.SQL v8 can read Btrieve versions 5.x, 6.x, and 7.x. 

Previous versions of Btrieve cannot read the newest version of Btrieve. You will 
have to exercise caution when downloading host batches in Btrieve format. 

Btrieve commands must be issued from an MS-DOS prompt or from the Windows 
Desktop using Start → Run → Browse.  The application to run is called 
SM2BUTIL.EXE and is located in the <Program Files Drive>:\GROCERY folder.  
Highlight the file, click on Open.  If desired, append a command line option (see 
below) and before clicking OK.  A windows interface will display for use of this 
application. 
Note: The SM2BUTIL application must be run only on the ScanMaster Server or on a 
ScanMaster Back Office Workstation. 

Command line options include: 
SM2BUTIL –STAT    [BTR File Name] 
SM2BUTIL –CREATE  [BTR File Name] [CTL File Name] 
SM2BUTIL –SAVE    [BTR File Name] [ASC File Name] 
SM2BUTIL -LOAD    [BTR File Name] [ASC File Name] 
SM2BUTIL –RECOVER [BTR File Name] [ASC File Name] 
SM2BUTIL –REBUILD [BTR File Name] [CTL File Name] 

To display the application version number, type: 
SM2BUTIL –VER  

To show a simple help file 
SM2BUTIL –HELP  
SM2BUTIL /? 

Password protected files must be executed from the command line only and carry 
the additional switch /O<Owner> where <Owner> is replaced by the user name of the 
Owner of that file. 
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SM2BUTIL Windows Interface 
The SM2BUTIL application can run in either DOS command mode or as a Windows 
application.  The windows interface screen is shown below.  From Windows Explorer, double 
click on the file <Program Files Drive>:\GROCERY\SM2BUTIL.EXE to start this application.  

 
Figure 5 – 1:  SM2BUTIL Main Screen 

Any one of six potential commands can be executed on named Btrieve, Control, or ASC (text) 
files.  Click the appropriate action desired.  The file types change depending on the command 
option chosen.  STAT works only on Btrieve files.  SAVE, LOAD, and RECOVER require entry 
of Btrieve and ASCII files.  CREATE and REBUILD require entry of Btrieve and Control File 
names.  The ASCII File prompt replaces the Control File prompt label for SAVE, LOAD, and 
RECOVER commands. 

Click on the Browse Folder icon  to the right of the file name box to choose a file. The full 
file name and path can also be entered directly. 

Displaying Btrieve File Statistics 
SM2BUTIL -STAT <BTR Filename> 
The STAT command displays the defined characteristics of a Btrieve file and statistics 
about its contents. Use STAT to determine all the parameters specified for a file 
produced by the CREATE command.   

To run STAT, enter the command in the format shown above or use the Windows 
interface by double clicking on C:\GROCERY\SM2BUTIL.EXE from Windows NT 
explorer. 
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Replace <BTR Filename> with the name of an existing Btrieve file for which statistics 
are to be retrieved. Specify the full path name.  

SM2BUTIL -STAT GR2POINT.BTR 

The STAT command displayed above retrieves the file statistics for the 
GR2POINT.BTR file.   

 

Results are displayed in a window with three horizontal regions.   

The upper region shows File Statistics such as File Date, Time, Size, Record Length, 
Page Size, Number of Indexes, Unused Pages, Number of Records, and 
Preallocates Pages setting. 

The middle region shows Key Information such as the Key number, Field Position 
(starting column) and Length, # of Keys, Data Type, and Flags.  The eight possible 
flags are as follows: 

D Duplicates are allowed in this field 

M Modifiable allows edits to the contents of this field 

N Null marks out bad records – Not used in ScanMaster 

A Alternate Collating Sequence Number – Not used in ScanMaster 

A or D Ascending or Descending Sort Order 

S Supplemental Key – Dynamically created index – Not used 

E Extended – For automatic increment – Not used in ScanMaster 

M  Manual – Manually entered values not maintained by Btrieve 

SEG Segmented Key – Concatenated key (multiple fields)  Red – First Segment; 
Blue – each additional field forming the key 
– (dash) - Means no flag set  

The lower region shows Legend information to explain FLAG Settings 

Here is a sample screen resulting from the STAT inquiry above. 
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Figure 5-2: SM2BUTIL STAT Screen 
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Creating a Btrieve File 

SM2BUTIL -CREATE <BTR Filename> <CTL File> 
The CREATE command generates an empty Btrieve file by using the characteristics 
specified in a description file.  If an existing file already contains records, it will ask if 
you want those records deleted. 

Before executing CREATE, if one does not already exist, it  may be necessary to use a 
text editor to generate a control file. The <CTL File> must follow standard Btrieve 
layout definition format. 

To run CREATE, enter the command in the format shown above or use the Windows 
interface.  Click the Create radio button, enter the Btrieve file name to be created, then 
enter the name of the Control file (CTL) to use to create this Btrieve file. 

Replace <BTR Filename> with the name of the Btrieve file to be created. Specify a full 
path name, if necessary. 

For <CTL File>, substitute the name of the control file containing the Btrieve 
specifications for the new file. Specify the full path name if necessary.  By convention, 
these files are stored in the C:\GROCERY\FILES\CTL folder.   

 
SM2BUTIL –CREATE C:\GROCERY\FILES\GR2DEPT.BTR 
C:\GROCERY\FILES\CTL\GR2DEPT.CTL 

When using the MS-DOS command line, the CREATE command above should be 
typed on one line.  This command builds a new Btrieve file called GR2DEPT.BTR 
according to the file layout specifications given in the Btrieve specifications file called 
GR2DEPT.CTL located in the C:\GROCERY\FILES\CTL folder. 

Saving Btrieve Records to Another File 

SM2BUTIL -SAVE <BTR File> <ASC Filename> 
The SAVE command retrieves records from a Btrieve file and stores them in a sorted 
order in a sequential ASCII file.  It is the exact inverse of LOAD.  This command can 
be used in conjunction with LOAD, so the data in a Btrieve file can be easily 
extracted, edited, and then stored in another Btrieve file. 

SAVE generates a single record in the output file for each record in the Btrieve file it 
is reading.  Each record begins with its length and a comma and ends with a carriage 
return and a line feed (0D0AH).  The file terminates with an end-of-file character 
(1AH).  The file is compatible with most text editors.  SAVE performs no conversion 
on the data in the records.  

After SAVE completes its processing, it displays the total number of records saved on 
the screen. 

To run SAVE, enter the command in the format shown above or use the Windows 
interface.  Click the Save radio button, enter the Btrieve File name, and the ASCII File 
name. 
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Replace <BTR File> with the name of the Btrieve file containing the records to be 
saved. Specify a full path name, if necessary. 

Replace <ASC Filename> with the name of the ASCII file that should contain the 
records being saved.  Specify a full path name, if necessary. 

 
SM2BUTIL –SAVE C:\GROCERY\FILES\GR2ITEM.BTR 
C:\GROCERY\FILES\GR2ITEM.ASC 

When using the MS-DOS command line, the SAVE command above should be typed 
on one line.  This command saves a Btrieve file called GR2ITEM.BTR to a text file 
called GR2ITEM.ASC in the C:\GROCERY\FILES folder. 

Be sure to use some extension other than .BTR for the ASC file name to avoid 
overwriting an existing Btrieve file in the \GROCERY\FILES folder. 

 

If the logical drive containing the output file fills up before the entire field is saved, 
SAVE stops, displays the number of records already saved, and then displays the 
following screen: 

Disk volume is full.  Enter new file name to continue or to quit, then press Enter. 

To continue the operation in another output file, complete one of the following 
instructions: 

To save the Btrieve file to diskette, remove the full diskette and replace it with another 
formatted diskette. 

To save the Btrieve file to a hard disk, specify another logical drive that has space 
available. 

To continue storing records, enter the name of the file that Btrieve is to use and press 
Enter.  Btrieve continues to copy records from the Btrieve file to the new output file. 

If a logical drive fills up and it is necessary to terminate the SAVE operation, type a 
period (.) and press Enter. 

SM2BUTIL -LOAD <Btrieve File Name> <ASC File Name> 
The LOAD command inserts records from a sequential ASCII file (formatted in 
Btrieve LOAD format) into an empty Btrieve file. LOAD performs no conversion on 
the data in the load file. After Btrieve transfers the records, it displays the total 
number of records loaded. 

Create the empty Btrieve file before performing the LOAD or the application will ask 
you to delete existing records.  Without a blank file, the LOAD command cannot 
continue.  
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Before running the LOAD command, create a sequential file that contains the new 
records. Create the file by using either a standard text editor or an application 
program. When using a text editor to create the LOAD file, be sure to pad each record 
with as many blank spaces as necessary to fill the record length specified in front of 
the record. When using an application program to create the LOAD file, be sure to 
append a carriage return and line feed to each record and include an end-of-file 
record.  Follow the required file description format. 

To run LOAD, enter the command using the format shown above or use the 
Windows interface.  Click on the Load radio button then enter the <Input File> into 
the ASCII File field.  Enter the <Btrieve File> name in the Btrieve File field. 

Replace <Btrieve File> with the name of the Btrieve file into which the records are to 
be inserted. Specify a full path name if necessary. 

Replace <ASC File Name> with the name of the ASCII sequential file containing the 
records to be loaded into the Btrieve file. Specify a full path name if necessary. 

SM2BUTIL -LOAD C:\GROCERY\FILES\GR2DEPT.BTR 
C:\GROCERY\FILES\GR2DEPT.ASC 

When using the MS-DOS command line, the LOAD command displayed above 
should be typed on one line.  This command inserts sequential records from the 
GR2DEPT.ASC text file into the GR2DEPT.BTR file located in the 
C:\GROCERY\FILES folder.   

Recovering a Btrieve File 

SM2BUTIL -RECOVER <BTR File> <Output File> 
The RECOVER command reads records from a specified Btrieve file by using Step 
operations and creates a sequential file in which the data is stored.  This sequential file 
is compatible with the LOAD command. 

Use RECOVER to retrieve data from a damaged Btrieve file.  For example, if a file has 
been damaged due to a system failure that occurred while the file was being accessed, 
the RECOVER command may be able to retrieve many, if not all, of the records in the 
file. Then use the LOAD command to insert the records into a new, undamaged 
Btrieve file.  Also see the REBUILD command (next page). 

To run RECOVER, enter the command by using the format shown above or use the 
Windows interface.  Click on the Recover radio button, then enter the <BTR File> to 
be recovered in the Btrieve File Field and the <Output File> name in the ASCII File 
field. 

Replace <BTR File> with the name of the Btrieve file that is to be recovered. Specify a 
full path name, if necessary. 

Replace <Output File> with the name of the ASCII file to which RECOVER should 
store the recovered records. If necessary, specify a full path name. 
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SM2BUTIL -RECOVER C:\GROCERY\FILES\GR2DEPT.BTR 
C:\GROCERY\FILES\GR2DEPT.ASC   

When using the MS-DOS command line, the RECOVER command displayed above 
should be typed on one line.  This command retrieves records from the damaged 
GR2DEPT.BTR file and saves them into an ASCII formatted file called GR2DEPT.ASC 
located in the C:\GROCERY\FILES folder.  The GR2DEPT.ASC file is properly 
formatted for execution using the LOAD command.  See Loading Records into a 
Btrieve File.   

 

After RECOVER retrieves the records, it displays the total number of records 
recovered. 

If the logical drive containing the output file fills up before the entire Btrieve file is 
recovered, RECOVER stops, displays the number of records already recovered, and 
then displays the following message. 

Disk volume is full.  Enter new file name to continue or to quit then press Enter. 

To continue the operation in another output file, complete one of the following 
instructions: 

When recovering the Btrieve file to diskette, remove the full diskette and replace it 
with another diskette. 

When recovering the Btrieve file to a hard disk, specify another logical drive that has 
space available. 

To continue storing records, enter the name of the file that Btrieve is to use then press 
Enter.  Btrieve continues to restore and copy records from the Btrieve file to the new 
output file. 

If a logical drive is full and it is necessary to terminate the RECOVER operation, type 
a period (.) then press Enter. 
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Rebuilding a Btrieve File 

SM2BUTIL -REBUILD <BTR File> <Control File> 
The REBUILD command automates the process of file restoration.  It sequentially 
performs three steps to quickly restore a damaged file: 

Execute the RECOVER command 

Execute the CREATE command 

Execute the LOAD command 

For example, if a file has been damaged due to a system failure that occurred while 
the file was being accessed, the REBUILD command may be able to retrieve many, if 
not all, of the records in the file and restore the file to an operable condition.  

To run REBUILD, enter the command by using the format shown above or use the 
Windows interface.  Click on the Rebuild radio button, then enter the <BTR File> to 
be recovered in the Btrieve File Field and the <Control File> name in the Control File 
field. 

Replace <BTR File> with the name of the Btrieve file that is to be rebuilt. Specify a full 
path name, if necessary. 

Replace <Control File> with the name of the CTL file that defines the proper layout 
for the undamaged Btrieve file. Specify a full path name. 

SM2BUTIL -REBUILD C:\GROCERY\FILES\GR2DEPT.BTR 
C:\GROCERY\FILES\CTL\GR2DEPT.CTL   

When using the MS-DOS command line, the REBUILD command displayed above 
should be typed on one line.  This command rebuilds records in the damaged 
GR2DEPT.BTR file. The GR2DEPT.CTL file is the properly formatted definition for 
the file layout. 
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Pervasive.SQL v8 Utilities 
In addition to using the utilities provided with your ScanMaster system, 
Pervasive.SQL v8 has file utilities that you can use. For more information regarding 
the use of these utilities, download an electronic copy of the Pervasive.SQL v8 User’s 
Guide on the Pervasive Software website: 

http://www.pervasive.com 

The document is also located in help files on your computer. To find the User Guide 
document, select Start → Programs →Pervasive→ Pervasive.SQL v8 → 
Documentation→Pervasive.SQL v8.   Expand the Pervasive.SQL User’s Guide book 
icon to see the chapters and their titles.  
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Pervasive.SQL v8 Status Codes and Messages 
Pervasive.SQL v8 status codes and messages may be displayed during installation, 
while using the utilities, or while using an application. You can obtain a complete 
listing of Pervasie.SQL v8 Status Codes and Messages on the Pervasive web site: 
 
http://www.pervasive.com 

The documents are also located in help files on your computer. To find the Status 
Codes and Messages documents, select Start → Programs →Pervasive→ 
Pervasive.SQL v8 → Documentation→Pervasive.SQL v8.   Expand the Status 
Codes and Messages book icon to see the chapters and their titles. 

Status Codes 
Pervasive.SQL v8 Status Codes are returned to an application making a 
Pervasive.SQL interface call. The application determines if the status code is 
displayed to the user. Applications will often display status codes in addition to 
helpful messages about a problem that has occurred. For more information regarding 
Pervasive.SQL v8 Status Codes, obtain an electronic copy from their web site stated 
above. 

Messages 
Pervasive.SQL v8 Messages are returned to end-users by utilities or specific 
components and generally begin with a prefix or number. For more information 
regarding Pervasive.SQL v8 Messages, obtain an electronic copy from their web site 
stated above.
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Recovery Procedures 
Hardware redundancy provides extra protection for files in the event of system 
failure.   When redundancy exists, two components must fail before all file access is 
lost.  If a single component fails, action can be taken to maintain an acceptable level of 
access. 

If the network or ScanMaster file server fails, the POS workstations can be switched to 
run in Off-Line Mode.  Ordinarily, the system runs in On-Line Mode, and all look-up 
requests are directed to the ScanMaster file server.  If a POS workstation is in Off-Line 
Mode, all look-up requests are directed to the resident files located on the hard drive 
of the POS workstation. 
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Switching POS Workstations to Off-Line Mode 

The Network Has Failed 
If the ScanMaster file server loses communications with the ScanMaster Back Office 
Workstation and the POS workstations, the system automatically resets to run in Off-
line mode.  All POS workstations must be switched to Off-Line Mode until 
communications are restored.  If the ScanMaster Back Office Workstation has 
problems locating the ScanMaster file server, the ScanMaster Back Office Workstation 
may require restarting when the ScanMaster file server is restored.   

If the network is down (the cashier is in the middle of a sale) 
Follow this procedure. 

The cashier display on the POS workstation displays the following message: 
..............LAN FAILURE.............. 
  Press CLEAR to reset the system. 

GR2ITEM.BTR STATUS=3111 

The cashier must respond to the prompt in order to take the POS workstation to Off-
Line Mode. 

Press CLEAR in response to the message. 
 
The POS workstation displays the following message: 
  Please wait while system resets. 

The POS workstation automatically restarts in Off-Line Mode.   

The network icon (the word NET with a red circle and slash over it) will appear in the 
upper right-hand corner of the screen.  The cashier will be required to sign back on.  If 
communications were lost in the middle of a transaction, the register will return to 
that sale after Sign On.  The cashier can complete the sale started before the network 
and file ScanMaster Server went down.  Data from the sale is written to the hard disk 
of the POS workstation.  

The cashier continues to make sales transactions in Off-Line Mode.  When the POS 
workstation is placed back in On-Line Mode, information entered during Off-Line 
Mode is automatically transferred to the ScanMaster file server. 

If the network is down and POS workstations are inoperable (the cashier is idle and no 
new sale has been initiated): 
Follow these procedures. 

1. The cashier tries to sign off. 

2. If unsuccessful, proceed to Step 2. 

3. Turn the POS workstation off, then power it back up. 
 
The POS workstation automatically restarts in Off-Line Mode. 
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Note: A windows networking error message will appear.  Press Enter for Yes to 
“restore this connection next time you log on”. 

4. If the cashier was unable to sign off before the POS workstation was restarted to 
the Off-Line Mode, the cashier must sign on again and then sign off, using the 
same cashier number as was Entered before the POS workstation was restarted in 
Off-Line Mode.   

5. This clears the cashier number from the POS workstation.   

6. The cashier must sign back on to the POS workstation once again in order to 
continue operations in Off-Line Mode. 

Note: If Cashier security is enabled, only the 3-digit cashier number is required.  The 
3-digit security number is not required in Off-Line Mode. 

The cashier can continue to make sales transactions in Off-Line Mode.  When the POS 
workstation returns to On-Line Mode, information Entered during Off-Line Mode is 
automatically transferred to the ScanMaster file server. 

Powering Down the ScanMaster File Server  
If it is necessary at any time to manually power off the ScanMaster file server (if the 
hardware requires service, for example), it is MANDATORY that the network be shut 
down.  This ensures that all currently opened files are closed in an orderly fashion 
and diminishes the possibility of files being corrupted.  

Follow these instructions for each device in order to successfully power down the 
ScanMaster file server. 

POS Workstations 
If POS workstation functions are required while the ScanMaster file server is being 
serviced, it is imperative that the POS workstations be switched to Off-Line Mode to 
continue store functions.   
 
For more information about switching to Off-Line Mode for ScanMaster file server 
service, see “Recovery Procedures: The ScanMaster File Server Requires Service or 
File Repair is Needed” which displays next in this chapter. 

ScanMaster Back Office Workstation 
ScanMaster Back Office workstations are inoperable when the ScanMaster file server 
is down.  
 
IMPORTANT:  It is recommended that ScanMaster Back Office workstations be at 
the desktop before taking the ScanMaster file server down. 

1. Close all open ScanMaster menus and programs and EXIT to LOGIN. 

2. At the Security Login –ScanMaster screen, click the Close (X) Box displayed in 
the far upper right corner of the display. 
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ScanMaster File Server 
Follow this procedure on the file server. 

1. Be sure that all POS workstations and ScanMaster Back Office Workstations are 
logged off.  POS workstations can operate in off-line mode as needed.   

2. From the Security Screen –ScanMaster screen, click the Close (X) Box displayed 
in the far upper right corner. 

3. From the Task Bar, click Start, Shut Down to display the Shut Down Windows dialog 
box. 

4. A dialogue box displays the following choices: 

• Shut down  

• Restart  

• Close All Programs and Log On as a Different User 

1. Select SHUT DOWN. Click OK to confirm. 

2. The screen displays dialogue boxes that indicate that shutdown is occurring. 

3. When a dialog box displays indicating that it is safe to turn off the computer, 
power off the ScanMaster file server and monitor.  ScanMaster Back office 
Workstations should also be powered off the same way. 

 

Note: While the ScanMaster Server is unavailable, Electronic Journal files cannot be 
processed.  Also, EFT transactions are processed using the off-line settings of the 
Media Configuration File. 

The ScanMaster File Server Requires Service or File Repair is Needed 
If the ScanMaster file server requires service or if a file must be repaired (the network 
is up and the POS workstations are operating), follow this procedure. 

1. Have cashiers close their POS workstations down by signing off. 

The “CLOSED” message displays. 

2. Press the REPORTS MENU key or press the UP ARROW if using a DynaKey. 

The Reports Menu options are available. 

3. Select the UTILITIES (3) option. 

The Utilities options are available. 

4. Select the CHANGE TO OFFLINE MODE (9) option.  Press ENTER/YES.  
Confirm your choice by pressing ENTER/YES.   

The workstation will reset. 

Note: When the POS workstation is in Off-Line Mode, the network icon (the word 
NET with a red circle and slash over it) will appear in the upper right-hand corner of 
the screen.  All look-up requests made at the POS workstation are routed to the 
resident files on the hard drive of the POS workstation. 
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1. If cashier security is enabled, the cashier signs on to the POS workstation, using 
the 3-digit employee number only security number is not required. 

The cashier can continue to make sales transactions in Off-Line Mode.   

Note: When the POS workstation returns to On-Line Mode, information entered 
during Off-Line Mode is automatically transferred to the ScanMaster file server. 

Power On Sequence – File Server 
Follow this procedure for the power on sequence. 

1. Power on all equipment physically attached to the file server, such as external 
modem, monitor, network hub, etc.  Then power on the file server.  

Expect to wait about 45 seconds before performing Step 2. 

2. When the Windows dialog box screen is displayed prompting login, press CTRL-
ALT-DEL. 

The Welcome Screen displays, displaying the following data fields: 

• User name: 

This field displays the name of the last user to log on to this workstation/file 
server. 

• Password: 

This is the password associated with the username. 

• Domain: 

This field indicates the domain name of the ScanMaster file server (STORE) 
and should not be changed.  It appears as the “Log on to: field when the 
Options is chosen from the login screen. 

3. Highlight the User name: field by using TAB. If no previous username is 
displayed in the User name: data field, enter your username. 

4. Use TAB to highlight the Password: field. 

5. Enter your password in the Password: data field and press Enter, or just press 
Enter if no password is required. 

6. The Windows desktop displays. 

7. Double-click the ScanMaster icon. 

8. The Security Login –ScanMaster screen displays. 
 
The ScanMaster file server is “up.” 
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9. Power on other devices not directly physically attached to the ScanMaster file 
server, including ScanMaster Back Office Workstations and POS workstations. 
 
Note:  Restore POS workstations to On-Line Mode one POS workstation at a time 
in order to keep store functionality at peak performance.   
 
If POS workstations were switched to Off-Line Mode through use of the Utilities’ 
Switch to Off-Line Mode option on the POS workstation keyboard, they must then 
be switched to On-Line Mode by using the REPORTS MENU  UTILITIES 

CHANGE TO ON-LINE MODE (6) option. 
 
For more information about the UTILITIES option on the POS workstations, see 
“Recovery Procedures: The ScanMaster File Server Requires Service or File Repair 
Is Needed,” discussed earlier in this chapter.   

Switching back to On-Line Mode 
After the ScanMaster file server is powered back up and operating as described in the 
section Power On Sequence – ScanMaster File Server, switch the POS workstations 
back to On-Line Mode. 

To switch back to On-Line Mode, follow this procedure: 

1. Press the REPORTS MENU Key or press the UP ARROW if using a DynaKey. 

The Reports Menu options are available. 

2. Select the UTILITIES (3) option. 

The Utilities options are available. 

3. Select the CHANGE TO ON-LINE MODE (6) option. Press ENTER/YES.  
Confirm your choice by pressing ENTER/YES.   

The workstation will reset. 

Note: When the POS workstation is back in On-Line Mode, the network icon (the 
word NET with a red circle and slash over it) will no longer appear in the upper right-
hand corner of the screen.  Information entered during Off-Line Mode is 
automatically transferred to the ScanMaster file server if the End-Of-Day procedure 
was not executed at the off-line POS workstation.  Look-up requests made at the POS 
workstation are routed to the ScanMaster file server. 

Setting Up and Initializing Backup 

Overview 
There are several ways to back up ScanMaster using the Microsoft Windows back-up 
software that comes with your system.  However, you must configure the software to 
meet your store’s needs.  Two common ways of backing up ScanMaster include: 

• Creating a batch file that runs daily when the End-of-Day routine is initiated. 
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• Manually backing up the system each day using the User Defined Menu. 

Creating a Batch File to Automatically Back Up ScanMaster during EOD 
An easy way to back up your system each day is to create a command-line batch file 
for ScanMaster’s End-of-Day routine.  Once this line is placed in the routine, it will 
automatically be performed when an End-of-Day is run. 

Add the command line to the End-of-Day routine by editing the SM2EOD.SCR file.  This 
file is located at <LAN Drive>:\Grocery.  Access a command prompt by selecting 
START → RUN → (type) CMD→ OK.  Navigate to the LAN Drive (i.e. <F:> and 
press Enter).  Change directories (i.e. CD\GROCERY) Use the edit command (EDIT 
SM2EOD.SCR).  The back up command-line should be the last line of the SM2EOD.SCR 
file. 

Using the parameters detailed below, you can select which drives and directories you 
want backed up.  

Note:  You can only back up directories, not individual files, and you cannot use 
wildcard characters.  Also, a compatible tape must be loaded into the tape drive 
before the back-up procedure is initiated. 

Back-up parameters included in this batch command give you most of the same 
functionality that is provided in the graphical user interface. 

Syntax 
Below is the syntax necessary to set up the command line.  This should be placed on 
one line when entered.  See the Parameters section below for an explanation of the 
different types of switches. 

ntbackup operation path 
[/a][/v][/r][/d "text"][/b][/hc:{on | off}] 
[/t {option}][/l "filename"][/e][/tape:{n}] 
 

To back up your file server’s shared LAN drive (in this case, drive F:), except for 
“open, shared” files, enter the following line. 
 
ntbackup backup f: /d ”cdrive” /hc:on /t copy 
 
To back up “open, shared” files, first create another directory 
on the C: drive and copy the open files to this directory 
before backing up those files. 
 
md backup 
copy f:\grocery\files\*.Btr c:\backup 

Parameters 
These parameters explain the backup options for your ScanMaster system. Parameters 
enclosed in [ ] brackets are optional switches.  Do not type the [ ]  enclosure brackets 
when you use each of these parameters. 

Parameter Description 
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Parameter Description 

operation Specifies the operation, backup. 

path Specifies one or more paths of the directories to be 
backed up. 

/a Causes backup sets to be added after the last 
backup set on the tape. When /a is not specified, 
the program reuses the tape and replaces previous 
data.  When more than one drive is specified but /a 
is not, the program overwrites the contents of the 
tape with the information from the first drive 
selected and then appends the backup sets for the 
remaining drives. 

/v Verifies the operation. 

/r Restricts access 

/d “text" Specifies a description of the backup contents. 

/b Specifies that the local Registry be backed up. 

/hc:on or 
/hc:off 

Specifies that hardware compression is on or off. 

/t {option} Specifies the backup type. Option can be one of the 
following: 

Normal -- All the selected files are backed up and 
marked as such on the disk. 

Copy -- All the selected files are backed up, but 
they are not marked as such on the disk. 

Incremental -- Among the selected files, only those 
that have been modified are backed up and marked
as such on the disk. 

Differential -- The selected files that have been 
modified are backed up, but they are not marked as
such on the disk. 

Daily -- Among the selected files, only those that 
have been modified that same day are backed up, 
but they are not marked as such on the disk. (This 
can be useful if you want to take work home and 
need a quick way to select the files that you worked
on that day.) 

/l "filename" Specifies the filename for the backup log. 

/e Specifies that the backup log include exceptions 
only. 
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Parameter Description 

/tape:{n} Specifies the tape drive to which the files should be 
backed up. N is a number from 0 to 9 that 
corresponds to the tape drive number listed in the 
Registry. 

Manually Backing Up the System Using the User Defined Menu. 
You can manually back up the system each day using the User Defined Menu. 

The User Defined Menu is the third option on the ScanMaster System Services Menu.  
Click on that button (or press Alt-U) to access the ScanMaster User Defined Menu. 

This is a customizable menu that is used at the store-level for specialized DOS 
applications. 

Editing the User-Defined Menu 
Since this menu is user-defined, you can customize up to ten options to meet your 
needs.  These options are created in a text editor and are linked to the 
SM2XMENU.MNU file.  Below is an example of how to customize this menu. 

The store wants to create a DOS Tape Backup of the Grocery File Directory.  In order 
to do this, follow the steps below. 

1. Create a .BAT file using a text editor. 

2. Enter the commands in the .BAT file should process  

Note: Add “SM2XMENU.EXE” to the bottom of the batch file in order to return to 
the ScanMaster User-Defined Menu. 

3. Place the .BAT file in the <Program Files Drive>:\GROCERY directory. 

4. Link the .BAT file to the User-Defined Menu. 
 
Using the text editor, edit SM2XMENU.MNU.  The first two lines are used by the 
program.  Do not edit these two lines.  Place a description of the program [TAPE 
BACKUP] on the third line, then place the .BAT filename directly under the 
description line. 
 
SM2XMENU.MNU example: 
 
Line 1 = user-defined programs 
Line 2 = sm2xmenu.exe 
Line 3 = TAPE BACKUP (This is the program description.) 
Line 4 = tape.bat (Batch file with extension.) 
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File Recovery Procedures 

Overview 
The ScanMaster System Back-Up feature was designed to restore system files in the 
event of a file server hard drive failure. 

If the hard drive on your file server fails, follow the steps below to restore system 
information saved on a tape back-up. 

Note: Remember to back up your system files each day to ensure you have a copy of 
your system’s most current data. 

Restoring a File Server Using a Tape Back-Up 
1. Reload the Windows Operating System (Windows NT or Windows 2000 \2003 

Server) for the file server.  (Refer to Chapter 2 of the Installing and Support 
ScanMaster User Guide.) 

Be sure the data has been backed up previously.   
Re-installation of the operation system erases all prior existing data.   

2. Re-establish the share of the LAN drive. (Refer to Server Installation steps 
documented in Chapter 2.) 

3. Insert the Workstation Back-Up tape in the tape drive. 

4. From the Windows NT Task Bar, click Start → Programs → Administrative Tools 
(Common) → Backup to display the Back-Up screen. 

OR 

1. From the Windows 2000\2003 Task Bar, click Start → Programs → Accessories → 
System Tools→Backup to display the Back-Up screen. 

2. Using Windows NT, open the Tapes window, usually located in the lower left 
corner of the Backup window box to display the Tapes window. 

OR 

Using Windows 2000 \2003 Server, click on the Restore Tab. 

1. Select the line describing the tape contents. 

2. Click the check box next to the tape name description.   

A check box indicates the tape has been selected. 

3. Using Windows NT, on the tool bar at the top of the Tapes window, click 
RESTORE to display the Restore information dialog box displays. 

OR 

Using Windows 2000, on the tool bar at click Tools followed by Options.  Click 
the Restore tab. 
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1. Using Windows NT, click OK to restore system information and to display the 
Restore Status dialog box.   

Note: If the Confirm File Replace dialog box displays, click on the YES TO ALL 
button to overwrite files on the hard drive. 

OR 

Using Windows 2000 \ 2003, click the Always replace the file on my computer 
radio button and click OK. 

1. Insert the Data File Back-Up tape. 

2. Click the line describing the tape contents. 

3. Click the check box next to the tape name description.   

An “X” in the check box indicates the tape has been selected. 

4. Using Windows NT, click the RESTORE button, located on the tool bar at the top 
of the screen to display the Restore information dialog box. 

OR 

Using Windows 2000 \ 2003, on the tool bar click Tools followed by Options.  
Click the Restore tab. 

5. Using Windows NT, click OK to restore system information and to display the 
Restore Status dialog box.   

Note: If the Confirm File Replace dialog box displays, click on the YES TO ALL 
button to overwrite files on the hard drive. 

OR 

Using Windows 2000 \ 2003, click the Always replace the file on my computer 
radio button and click OK. 

1. When the back-up process is complete, click OK. 

2. Using Windows NT , from the Menu Bar, click on Operations then select Exit to 
close the NT Backup program. 

OR 

Using Windows 2000 \2003, click the click on Job then select Exit. 

1. Using Windows Explorer, navigate to the LAN Drive icon, then click on the + sign 
next to the Backup folder. 

2. Select all the displayed files in the right hand pane of the Backup folder. Select all 
files by clicking on the first file name, holding down the Shift key, then clicking 
the last file in the right hand pane.  Release the shift key when all the files are 
highlighted. 

3. Hold down the CTRL key, then press C to copy all of the selected files to the 
windows clipboard. 
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4. Click on the <LAN Drive>:\GROCERY\FILES folder. 
Hold down the CTRL key, then press V to paste all selected files into this folder.  
If the Confirm File Replace dialog box displays, click YES TO ALL to copy all 
back-up files to the <LAN Drive:\Grocery\Files folder. 

5. From Task Bar, click on Start→Run to display the Run dialog box. 

6. In the Open: text box, type: C:\Grocery\Makeuser.  
(where C: is the program files drive designation).  Click OK to create all default 
users on the system. 

7. Open Windows Explorer, select Tools, Disconnect Network Drive.  Click once on 
the F drive as the Network Drive to highlight it.  Click OK to disconnect it.    

8. From the Task Bar, click Start→Settings→Control Panel to display the Control 
Panel dialog box. 

9. Double-click on the System icon to display the System Properties window. 

10. Click the Environment tab, then scroll down the list of “System Variables”.  (In 
Windows 2000 \ 2003 systems, click the Advanced tab followed by Environment 
Variables).  Double-click the system variable named “Path” to display the contents 
of the Path variable in the Value text box. 

11. If the phrase below is not included in the value statement, add the following to the 
Value text box at the bottom of the screen. 

;%SystemRoot%\Grocery  
 

12. Click on the SET button and then click OK. 

13. Close the Control Panel. 

14. From the Task Bar, click Start, Shut Down, Close all programs and log on as a 
different user then OK.  (In Windows 2000 \ 2003 systems, choose “Log Off 
Administrator”).  

15. Log back onto the system to activate the above changes. 

16. The recovery process is complete. 
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Troubleshooting 
The normal configuration for ScanMaster includes a file server, back office 
workstation(s), and all POS workstations interconnected by a local area network 
(LAN).  When these devices are working as intended, the system is operating in On-
Line Mode.  This means that look-up requests initiated at a POS workstation and all 
data entered at the Back Office Workstation are routed over the network to the file 
server. 

However, if the file server or network fails, the interconnection between the separate 
devices comprising the ScanMaster system is broken, and network communication 
between the server, back office PC(s), and POS workstations is no longer possible.   
When this occurs, the system is operating in Off-Line Mode.  When a POS 
workstation runs in Off-Line Mode, look-up requests are routed to the hard drive of 
the POS workstation, rather than to the file server. 

The file server or network need not be inoperable in order for all POS workstations or 
a single POS workstation to be switched to Off-Line Mode.  Management can switch 
any or all POS workstations to Off-Line Mode at their discretion by accessing the 
Reports Menu.  

7 
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Off-Line Mode 

If Communication with the File Server Fails:  
Switching to Off-Line Mode 

If the file server PC loses communications with the back office PC and the POS 
workstations, the system automatically resets to run in Off-line mode.  All POS 
workstations must be switched to Off-Line Mode until communications are restored.  
If the back office PC has problems locating the file server PC, the back office PC may 
require restarting when the file server PC is restored.   

If the network is down (the cashier is in the middle of a sale), follow this procedure. 

The cashier display on the POS workstation presents the following message: 
..............LAN FAILURE.............. 
  Press CLEAR to reset the system. 

The cashier must respond to the prompt in order to take the POS workstation to Off-
Line Mode. 

Press CLEAR. 

The POS workstation displays the following message: 
  Please wait while system resets. 

The POS workstation automatically restarts in Off-Line Mode. 

The network icon (the word NET with a red circle and slash over it) will appear in the 
upper right-hand corner of the screen.  The cashier will be required to sign back on.  If 
communications were lost in the middle of a transaction, the register will return to 
that sale after Sign On.  The cashier can complete the sale started before the network 
and the ScanMaster Server went down.  Data from the sale is written to the hard disk 
of the POS workstation.  

The cashier continues to make sales transactions in Off-Line Mode.  When the POS 
workstation returns to On-Line Mode, information entered during Off-Line Mode is 
automatically transferred to the file server PC. 

If the network is down:  POS workstations are inoperable 
 If the network goes down and the cashier is idle (no new sale is in progress), follow 
this procedure: 

1. The cashier tries to sign off. 

2. If unsuccessful, proceed to Step 2. 

3. Turn the POS workstation off, then power it back up. 

4. The POS workstation automatically restarts in Off-Line Mode. 

Note: A windows networking error message will appear.  Press Enter for Yes to 
“restore this connection next time you log on”. 
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5. If the cashier was unable to sign off before the POS workstation was restarted to 
the Off-Line Mode, the cashier must sign on again and then sign off, using the 
same cashier number as was Entered before the POS workstation was restarted in 
Off-Line Mode.   

6. This clears the cashier number from the POS workstation.   

7. The cashier must sign back on to the POS workstation once again in order to 
continue operations in Off-Line Mode. 

Note: If Cashier security is enabled, only the 3-digit cashier number is required.  The 
3-digit security number is not required in Off-Line Mode. 

The cashier can continue to make sales transactions in Off-Line Mode.  When the POS 
workstation returns to On-Line Mode, information Entered during Off-Line Mode is 
automatically transferred to the ScanMaster file server. 

If the Network is Up:  Switching a POS workstation to Off-Line Mode 
At management discretion, it is possible to switch a POS workstation, or all POS 
workstations, to Off-Line Mode, even if the network and file server are working 
properly. 

To switch a POS workstation to Off-Line Mode, follow this procedure. 

1. Close the POS workstation down by pressing the Sign In/Off key an entering the 
logoff ID and security number. 

The “CLOSED” prompt appears in the upper left corner of the cashier display. 

2. Press the Reports Menu key (or press the Up Arrow if using a DynaKey). 

The Reports Menu options are available. 

3. Select the UTILITIES (3) option. 

The Utilities options are available. 

4. Select the CHANGE TO OFF-LINE MODE (9) option. 

Note: When the POS workstation is in Off-Line Mode, the network icon (the word 
NET with a red circle and slash over it) will appear in the upper right-hand corner of 
the screen.  All look-up requests made at the POS workstation are routed to the 
resident files on the hard drive of the POS workstation. 

Note: Security numbers are not used during offline mode operation if Cashier 
Security is enabled. 
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If the Network is Up:  Switching Back to On-Line Mode 
To switch back to On-Line Mode: 

1. Return the system to the “CLOSED” prompt. 

2. Press the Reports Menu key or press the Up Arrow if using a DynaKey. 

The Reports Menu options are available. 

3. Select the UTILITIES (3) option. 

The Utilities options are available. 

4. Select the CHANGE TO ON-LINE MODE (6) option.  Press ENTER/YES.  
Confirm your choice by pressing ENTER/YES.   

The workstation will reset. 

Note: When the POS workstation is back in On-Line Mode, the word “OFFLINE” no 
longer appears in the lower left corner of the cashier display.  All look-up requests 
made at the POS workstation are routed to the file server.  When a POS workstation 
returns online from the offline mode, all cashier, store, and PLU information is 
automatically transferred to the file server. 
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Corrupt Files 
If attempts to access a file continually result in a Btrieve error message, it may indicate 
that the file has been corrupted.   The actions that you take to correct the error depend 
upon the type of Btrieve message that you receive.    

Pervasive.SQL Status Codes and Messages can be obtained from the Pervasive.SQL 
2000 Documentation. To access the documentation, follow the steps below. 

1. Start → Programs → Pervasive → Pervasive.SQL 2000 → Documentation → 
Pervasive.SQL 2000 Documentation. 

2. Select Status Codes and Messages from the Help Topics Contents Menu and click 
Open. 

Corrupt Executables 
If an executable (a routine ending in the extension .EXE) becomes corrupted, it must 
be rewritten.  Contact ScanMaster Support personnel. 

The circumstances under which an executable may be corrupted appear later in this 
section. 

Determining the Characteristics of a File 
 

Pervasive.SQL Status Codes such as 1: The operation parameter is invalid and 2: The 
application encountered an I/O error may indicate that a parameter, position block, 
key value, or another characteristic associated with a file is invalid. 

Upon receiving these messages, execute the SM2BUTIL STAT command for the file 
that you are trying to access.  If you continue to receive a Btrieve error message, you 
may have to use the CREATE, LOAD or RECOVER commands to rebuild and reload 
the file. 

Recreating the Corrupted File 
Pervasive.SQL Status Codes such as 3: The file is not open and 12: The MicroKernel 
cannot find the specified file may indicate that the file has been accidentally deleted 
or does not exist.   

After first assuring that you have specified the correct filename and are still receiving 
the Btrieve error message, execute the SM2BUTIL CREATE command.  This 
command creates a new Btrieve file, using the characteristics that you specify for it. 

Recovering a Corrupted File 
Pervasive.SQL Status Codes such as 14: The MicroKernel cannot create or open the 
pre-image file may indicate that the file has been damaged.   
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If you are certain that you have the access rights to the file and that the disk is not full, 
execute the SM2BUTIL RECOVER command.  The SM2BUTIL RECOVER 
command reads records from a specified Btrieve file and creates a new Btrieve file.  
After records are recovered, you then load them into the new Btrieve file through use 
of the LOAD command. 

The SM2BUTIL RECOVER command can be used to recover the records of a 
corrupted Person, Employee, or Customer File. 

Btrieve commands are described in detail in Chapter Five – Btrieve File Manager. 

Responding to a Full-Disk Condition 
To respond to Pervasive.SQL Status Code 18: The disk is full, first attempt a restart of 
the system. Don’t restart on the hard drive.  Instead, check disk space at DOS and 
optimize where possible.   

If you continue to receive this Pervasive.SQL Status Code after restarting the system, 
you must free up memory on the disk.  If this is a recurring problem, you may wish to 
investigate why the disk is filling. 

Pervasive.SQL Status Codes 14: The MicroKernel cannot create or open the pre-image 
file, 15: The application encountered an I/O error during pre-imaging, and 25: The 
application cannot create the specified file also may indicate a full-disk condition.   

Program Errors 
Pervasive.SQL Status Codes such as 21: The key buffer parameter is too short, 30: The 
specified file is not a MicroKernel file, and 48: Alternate collating sequence definition 
is invalid indicate an error in the program.  An executable may be corrupt.  Contact 
ScanMaster Support personnel. 

If an executable file is corrupted, the system may close and return the operator to the 
NT/WIN2000 Desktop.  If this happens, retry the operation.  If the same situation 
occurs, contact ScanMaster Support personnel. 

Responding to a Full-Table Condition 
Btrieve messages such as 81: The MicroKernel encountered a lock error, 86: The file 
table is full, and 87 The handle table is full may indicate that a record or table is full.  
Restart the system to attempt a correction.   

Responding to a Locked File Condition 
To respond to Btrieve messages such as 85: The file is locked, close the file, reopen it 
(this is done at the Back Office PC under the System Services Menu), and repeat the 
operation. 
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Conclusion 
Because more than one error condition may initiate a Btrieve message, use caution 
when diagnosing the nature of the problem and applying remedial action.   

Refer to the listing of Btrieve status codes and messages in Chapter Five for more 
information, or contact your ScanMaster support representative if you are unsure 
about how to proceed with correction.   

In most situations, the Btrieve commands LOAD, RECOVER, SAVE, STAT and 
CREATE can correct the error.  Refer to Chapter Five for more information about 
Btrieve commands. 

Troubleshooting the POS Workstation 
Printer problems may be experienced at POS workstations.  An error code is listed on 
the cashier display. 

• Printer Error 126 - Check Printer Paper: This means the printer is out of paper.  
Press CLEAR to continue when error is corrected. 

• Printer Error 127 - Receipt Motor Jammed.  Press CLEAR to continue when error 
is corrected. 

• Printer Error 131 - No Slip Inserted.  Press CLEAR to continue when error is 
corrected. 

• Printer Error 132 - - Slip Motor Jam.  Press CLEAR to continue when error is 
corrected. 

• Printer Error 135 - Blank Slip Read, No MICR Data Available.  Press CLEAR to 
continue when error is corrected. 

• Printer Error 136 - General MICR Error.  Retry operation usually indicates bad 
read of MICR Data.  Press CLEAR to continue the retry operation. 

• Printer Error 137 - Check Printer Lid: This means the printer lid is open. Press 
CLEAR to continue when error is corrected. 



7-8 Chapter 7:  Troubleshooting 

Extracting TLog Files 

Overview 
ScanMaster has a dealer and support-oriented utility application (SM2XTRCT.EXE) to 
extract information from previously consolidated TLogs when a corruption occurs in 
a primary data source due to problems in the primary data source dependent tables. 

If a primary data source is corrupted during an end-of-day or some other process, this 
utility can be used as an alternate way to re-create sales information (for department 
sales, sales tax, coupons, discounts, open department sales, record counts, media 
tendered, gift certificates, money orders, item/customer counts, or electronic 
coupons).  The utility can help reconcile EOD balancing. 

ScanMaster TLog Extract Screen 

 

Using the ScanMaster TLog Extract  
This ScanMaster utility can only be run from the Server or Back Office workstation 
using the executable located at C:\Grocery\SM2XTRCT.EXE from a Run dialog box or a 
DOS prompt.  Simply type in this executable location and name and press Enter to 
display the ScanMaster TLog Extract screen. 

Follow these steps to use the ScanMaster TLog Extract utility. 
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1. Click on the type(s) of data reports (Department Sales, Sales Tax, coupons, 
discounts, open department sales, record counts, media tendered, gift certificates, 
money orders, item/customer counts, or electronic coupons) to extract from these 
historic Tlog files. 

2. Select one TLog to extract: 
GRCTLOG.ASC (yesterday) OR 
CTMMDDYY.ASC (older file). 

3. Click PROCESS to build the report(s). 

4. Select PRINT from the ASCII file viewer to print the report(s). 

Field Descriptions 
Below are field descriptions for the ScanMaster TLog Extract application. 

Data to Extract from Consolidated Tlog:  
Click one or more type(s) of reports desired from the consolidated TLog information. 
Each report type begins on a separate page. Most reports include store totals as well.  
Types include: 

• Department Sales: By cashier, shows total department sales by department. 

• Sales Tax: By cashier, shows total tax amounts for Tax 1, Tax 2, Tax 3, and Total 
Tax. 

• Coupons: By Store coupon and Manufacturer coupon, shows paper-based total 
face amount, paper-based total double amount, total electronic coupon, and total 
coupon amounts by cashier. 

• Open Department Sales: By cashier, shows total open department sales by 
department. 

• Record counts: By cashier, shows total voids, error corrects, cancelled 
transactions, refunds, and returns. 

• Media Tendered: By media type by cashier, shows the total amount tendered for 
each type of media. 

• Item / Customer Counts: By cashier, shows the total item count  and the total 
customer count. 

• Electronic Coupons: By each electronic coupon redeemed by department, show 
total amount and grand total. 

Which TLog to Extract:  
In this window, click one specific TLog file to be extracted.  Choose from GRCTLOG.ASC 
(the daily TLog file created during the last end of day) or Consolidated TLog files 
from previous days.  Older files are named CTMMDDYY.ASC where MMDDYY is replaced 
by numbers for month(MM), day(DD), and year(YY). 

Use Employee File (GRCPRS.BTR): Click this checkbox to display the employee 
name on the report along with the employee number.  If this box is unchecked, only 
the cashier number and the default cashier name will display. 
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Button Options 
Below are button options for the ScanMaster TLog Extract Screen. 

EXIT: Click this button (or press Alt-X) to exit to the ScanMaster TLog Extract screen 
without saving any report information. 

PROCESS: Click this button (or press Alt-P) to compile data extracted from a 
consolidated TLog.  Once information is processed, click PRINT to print a hard copy 
of the report.  Each report chosen begins on a new page. 

ABOUT: Click this button (or press Alt-A) for software release information about the 
ScanMaster TLog Extract screen. 

Sample ScanMaster TLog Extract Report – Dept. Sales 
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Optimizing System Performance 

Overview 
There are several ways to optimize system performance for stores using a server and 
multiple workstation network configuration for ScanMaster. 

• Installing hardware accessories on workstation PCs 

• Installing background-processing software on workstation PCs 

• Limiting the use of screensavers 

• Adding a second LAN card to speed up the network. 

 

Note: It is recommended that the server PC primarily be used to process ScanMaster 
programs while workstation PCs be used to perform other types of processing duties 
(for example, electronic journal processor, print server, and host communications). 

Installing Hardware Accessories on Workstation PCs 
To ensure maximum resource usage for ScanMaster programs, it is recommended that 
hardware accessories be placed on workstation PCs rather than the server PC.  This 
enables the server PC to run ScanMaster programs without being taxed by other 
hardware accessories. 

Hardware accessories include the following (but are not limited to): 

Modems 

Printers 

Tape backup units 

Price verifiers, FM mux boxes, or other ScanMaster-related hardware accessories. 

Installing Background Processing Software on Workstation PCs 
Software programs that run in the background also tax system resources.  It is 
recommended these software programs be placed on workstation PCs rather than the 
server PC. 

Note: Background processing software should be divided evenly among the server 
and workstation PC if only one workstation is available. 

ScanMaster uses numerous background processing software packages.  They include 
the following (but are not limited to): 

ScanMaster Electronic Journal processor 

FM Terminal Support 

Communication packages (for example, PC Anywhere) 
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 Limiting the Use of Screensavers 
Screensavers consume system memory and CPU resources, especially Open GL 3-D 
screensavers. 

It is recommended not to use OpenGL screensavers.  They include the following (but 
are not limited to): 

3D FlowerBox (OpenGL) 

3D Flying Objects (OpenGL) 

3D Maze (OpenGL) 

3D Pipes (OpenGL) 

3D Text (OpenGL) 

Note: Other (non-OpenGL) screensavers can be used without causing server 
problems. 

Adding a Second LAN Card to Speed up the Network 
Optimizing network speed is another way of enhancing ScanMaster’s performance.  
This is especially important in larger stores (with 12 lanes or more). 

One way of improving network speed is by installing two network LAN cards in the 
server PC and two network hubs.  This is beneficial for two reasons: 

1. It increases the bandwidth and makes the network faster. 

2. In case of a LAN card or network hub failure, only the number of lanes attached to 
that hub would be affected, not the entire network. 
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Trouble Shooting ScanMaster Balancing Problems 

Why are there no Store Totals in the Office Reconciliation? 
Did the Store run a double End of Day? This can be checked by viewing 
F:\GROCERY\LASTZ.RUN. If the store did run two End of Days, follow the 
instructions for reprocessing after two End of Days. 

Did they do a Mid-Day Deposit of all the money in the safe? This can be check by 
viewing F:\GROCERY\FILES\ASC\AUDTRAIL.OLD. 

Were there server Errors? Check the error logs. 

How can I reprocess sales and reproduce reports after I ran two End of 
Days? 

Note: The reprocessing must be done on a lab system. If you follow the procedures 
in a live store, you will erase all historical and current financial data from the store’s 
system. 

1. Gather all files needed from the store that ran the double End of Day.  
 
F:\GROCERY\FILES\GRCPRS.BTR 
F:\HISTORY\SSJJJTL1.ZIP 

2. On the lab system, run C:\GROCERY\SM2CLR.BAT from the command prompt 
or RUN. 
 
This will clear the system of all financial data to begin the recreation process. 

3. Change the date on the lab system to the date that you are trying to reprocess. 

4. Run an End of Day. 

5. Do an Office Reconciliation using Auto → Accept. 
 
There should be nothing in the safe. 

6. Do a final deposit using Auto → Accept. 

7. Extract SM2BCTRL.BTR from the zipped history file from the store, and place it 
in the C:\GROCERY\FILES directory of your lab system. 

8. Create a new directory (name does not matter) and extract all of the *.BTR and 
TLrrsss.ccc files from the zipped history file into this new directory.  
 
rr = register number 
sss= sequence number 
ccc=cashier number 

9. Copy the Btrieve (*.BTR) files to F:\GROCERY\FILES. 
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10. Copy the TLOG (TLrrss.ccc) files to F:\TLOG. 

11. Change directories to F:\Grocery\Files 

12. Copy F:\Grocery\Files\GRCTLDPT.BTR to 
F:\Grocery\Files\GRCDTILL.BTR 

13. Copy F:\Grocery\Files\GRCFINAL.BTR to 
F:\Grocery\Files\GRCRECON.BTR 

14. Run an End of Day. 

15. After the End of Day has completed, do the Office Reconciliation and Final 
Deposits. 

16. Run the financial reports. 

Why are my handkeyed (0500) paidouts not reporting to the SRR on the 
correct line? 

Each handkeyed paidout needs a general ledger account # of no more than five digits. 

If a handkeyed paidout doe not have a general ledger account number, then it’s totals 
from the register will write to Paidouts at the Register (0112) on the SRR. 

Why are my Handkeyed (0500) Paidouts reporting to two lines on the SRR? 
Each handkeyed paidout must have a unique general ledger account number. If two 
paidouts have the same general ledger account number, then the paidout total will 
report to both lines on the SRR. 

Why don’t the sales in my hourly activity report match my sales on other 
reports? 

The Hourly Activity Report is a productivity and not a balancing report. If a store is 
24 hours, the Hourly Activity Report will never match other reports. All balancing 
reports are based off of settled cashiers. The hourly activity report is based off of 
hourly sales. If you have a cashier signed on before midnight, but doesn’t get settled 
until the next day, that cashier’s totals will skew the hourly activity report. 

I can’t get my SRR to balance. 
First, try to balance the Store Totals Report for the store. If you can’t get the store 
totals report to balance, try to balance the individual cashier reports. If you can’t get 
the store totals and the cashier reports to balance, you will need to gather all 
balancing files and call global support. 

If the Store Totals Report balances, then the problem is in the SRR setup:  

1. Print an unhidden copy of the SRR.  
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2. Compare the totals between the Store Totals Report and the SRR.  
 
Are any totals missing on the SRR?  

3. Add the missing totals, if any, through the SRR Editor.  
 
Are any Totals on the SRR adding incorrectly?  

4. Change their attributes in the SRR editor.  
 
Are coupons adding to sales?  

5. Check your Back Office Settings, SRR setup, and be sure that you are using the 
correct balancing formula.  

What steps can I take to research an individual cashier report that doesn’t 
balance? 

Check the register error logs in the history file for any Btrieve errors on the balancing 
files. You may need to check the history file for the next day. The register copies the 
register error logs when the register runs the end of day. SM2ARC could possibly run 
before the register does its end of day. 

Run SM2TLOGX to extract the individual cashier’s totals from the TLOG then run 
SM2XTRACT against the cashier’s TLOG. Are there any discrepancies? 

If the store adds coupons back to sales and the Tlog is missing, the Grand Totals after 
discount line will be less than the Net Sales figure on the Cashier Report. You would 
see through SM2XTRACT that the coupon total from the TLOG was less than the 
coupon total from the cashier report. 

Check to see if the store does loans or pickups on cashiers who are not settled on that 
same business date. 

How can I get Cashier Reports from a store without faxing? 
1. Have the store run Cashier Reports. 

2. Pull back C:\Grocery\Cashier.rpt. 

3. Open Cashier.rpt by using Microsoft NotePad. 

4. Select Edit → Select All.  
 
The entire text file will be highlighted. 

5. Select Edit → Set Font. 

6. Change the Font size to 6 pt and change the font to Courier New.  

7. Click OK. 

8. Print the file. 
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How can I get the SRR from a store without faxing? 

Option 1 
Have the store export an unhidden SRR to a Microsoft Excel Spreadsheet. The Excel 
spreadsheet can then be emailed. 

Option 2 
1. Pull-back from F:\Grocery\SRR the following files: 

 
MEMAP 
POMAP 
REMAP 
Memmddyy.dat 
Pommddyy.dat 
Remmddyy.dat 

2. From F:\Grocery\Files, pullback Drmmddyy.dat. 

3. Place the files on a lab system and run the SRR report
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Since each customer using the ScanMaster System has different needs, it was 
developed with flexibility in mind.  Therefore, many user-defined selections were 
built into the system to help customers meet their needs.  

Most of these user-defined features are found under the System Personalization 
Menu.  Selecting the various options in each of these files helps users customize their 
system. 

Customer Survey 
Prior to installing the ScanMaster System, a customer survey is conducted to 
determine that customer’s specific needs.  This survey deals with the system’s various 
settings.  Through it, a proper configuration for that customer is established. 

In the event a customer’s needs change over the years, system personalization options 
can change to meet those needs. 

A 
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Set-Up Preparation 
When installing the ScanMaster System, consider the following data when 
customizing your system. 

Item File 

Item File 

Mix & Match Maintenance 

Flip Chart Maintenance 

Promotion/Coupon Editor 

Bottle Link Editor 

Report Codes 

Tare Table 

Variable Tare Table 

Electronic Coupon Maintenance 

Bundle File Maintenance 

Adjective Price Maintenance 

Employee File 

Employee File 

Enhanced Security 

Department File 

Department File 

Subdepartment File 

Department Restriction Table 

Group Descriptors 
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Customer File 

Negative Check File 

Customer File 

Check / Charge Reason Codes 

Frequent Shopper Discount Matrix 

Personalization 

System Configuration 

Banner File 

Reason Codes 

Tax Table 

Keyboard Configurator 

Media Configurator 

Foreign Currency Rate Editor 

Tax Code Editor 

SRR Editor 

Communication Parameters 

Customer CRT Promo Editor 
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Customer Data Sheet 

Customer Information 
 

Customer Name:  
Customer 
Address: 

 

  
Phone:  Fax:  Modem:  

 

Installation Information 
 

Install 
Date: 

 Live 
Date: 

 

Training Dates / Hours:  

  

  

  

Live Support Dates / 
Hours: 
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Store Information 
Please list the appropriate store personnel to contact. 

 
Name Job Title / Responsibility Phone 

   

   

   

   

   

   

   

   

   

   

 

Comments / Requirements 
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Item File 
The Item File can be manually entered, host provided, or possibly derived from an 
existing system converted into ScanMaster format. 

 
Figure A-1:  ScanMaster Item File Menu Screen 

 
Who and when to provide TEST file:__________________________ 

Who and when to provide LIVE file: __________________________  
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Mix & Match Maintenance 
This feature lists all the Mix & Match records on the system and enables the user to 
perform maintenance on those records.  There are nine hundred and ninety-nine (999) 
Mix & Match records available.  The purpose of the Mix & Match file is to permit 
scanning of different UPCs with the same price to be associated together for split price 
or limited quantity price breaks (such as Kool-Aid or Jell-O).  The Mix & Match file 
permits a descriptor to be associated with the Mix & Match record. 

The Mix & Match pop-up window displays in the item file when the Mix & Match 
field is accessed.  A Mix & Match record may also be created in Direct Item 
Maintenance. 

 
Figure A-2:  Mix and Match Record Maintenance 
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Flip Chart Maintenance 
This feature builds the Preset Menus that display store code numbers at the POS 
workstation.  There are two ScanMaster Flip Chart Maintenance screens.  The first 
screen displays a list of available departments.  The second screen enables the user to 
assign look-up codes to the selected department. 

From the Flip Chart Maintenance screen, you can select the desired department on 
which you want to perform flip chart maintenance.  Simply click on the desired 
department and the ScanMaster Flip Chart Maintenance edit screen displays. 

 
Figure A-3: Flip Chart Maintenance Screen (List) 

Promotion / Coupon Editor 
Through Promotion/Coupon Editor, you can create or edit coupons (or promotional 
advertisements) that print at the end of the customer’s receipt if the transaction meets 
the system criteria. 

Promotion/Coupons can print by random winner, frequent shopper, over/under 
total sale, over/under department sale, and by a link to a UPC.  There can be up to 
9999 promotion/coupons created on the system. 
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Figure A-4:  Promotion/Coupon Editor Screen 
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Bottle Link Editor 
This feature permits the user to link a bottle deposit amount to an item and to 
different departments.  There can be up to ninety-nine (99) bottle links created on the 
system.  The bottle link table can be viewed from the Direct Item Maintenance screen.  
It is found in the lower left corner above the button options. 

 

 
Figure A-5:  Bottle Link Maintenance 
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Report Codes 
The report code table associates a descriptor to a report code number.  There are 
ninety-nine report codes available through Item Maintenance.  Report codes can be 
used to group items into specific categories for reporting purposes.  For example, all 
products from Company A can be grouped under a specific report code. 

 
Figure A-6:  Reason Code  Maintenance Screen 
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Tare Table 
This feature permits you to assign up to 99 associated weight values to specific tare 
items.  Tare items are products that must be weighed to determine their price.  The 
tare value is the weight of the package the product is placed in.  Tare codes 1 through 
79 are reserved for Fixed Tare Codes, where the weight of the package is consistent 
regardless of the amount of product purchased. Tare codes 80-98 are reserved for 
Variable Tare Codes, where the weight of the package varies with the amount of 
product purchased.  An item with a tare code of 99 prompts the cashier to manually 
enter a tare code. 

 

 
Figure A-7:  Fixed Tare Table Maintenance 
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Variable Tare Tables 
If this feature is enabled, the system will support multiple package weights per 
individual product. 

 

Figure A-8:  Variable Tare Table 
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Electronic Coupon Maintenance 
This feature enables stores to generate electronic promotions and provide electronic 
discounts and frequent shopper benefits. 

 

 

Figure A-9:  Electronic Coupon Maintenance Screen 



  Appendix A:  Personalization Survey and Setup Guide A-15 

 

Bundle File Maintenance 
This feature enables stores to organize a group of items together in a “bundle” for sale 
or promotional purposes.  Customers get free or discounted item if all items included 
the bundle are purchased. Up to 99 bundles can be created in ScanMaster.  As many 
as five and as few as two items or groupings can be included in the bundle. 

 

 
Figure A-10: ScanMaster Bundle Maintenance Screen 
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Adjective Price Maintenance 
Adjective Pricing and Adjective Price Maintenance features are used to configure 
multiple level pricing for a single UPC.   Through adjective price maintenance, stores 
can use a single UPC to create layers of pricing for an individual product. 

There are two ways to configure Adjective pricing. They are: 

 By Level 

 By Quantity 

 
Figure A-11: Adjective Pricing By Level 
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Employee File 
Employee File options enable you to add, edit, delete, or view the store employee file, 
as well as monitor cashier activity and force logoff of a cashier.  It explains each field 
associated with employee maintenance, as well as how to generate and interpret a list 
of all employees and a list of active employees. 

 
Employee Name Employee 

Number 
Security 
Level 

Birth 
Date 

Employee 
Password 

     

     

     

     

     

     

     

     

     

     

     

     

     

     



A-18 Appendix A:  Personalization Survey and Setup Guide 

Enhanced Security 
Enhanced Security limits employee access to menu options on the ScanMaster System.   

Security is available for each menu item.  Main Menu and submenu options are listed 
below.  Use the Enhanced Security worksheet to identify security levels for your 
employees. 

Item Maintenance Menu:  Direct Item Maintenance; Create/Edit Batches; Activate 
Batches; Delete Batches; Print Batches; Mass Attribute Batches; Convert PLU Report to 
Batch; Mix & Match Maintenance; Flip Chart Maintenance; and Miscellaneous 
Maintenance. 

Employee Maintenance:  Employee Maintenance; Active Employee/Lane List; 
Cashier Monitoring; Force Cashier Logoff; Enhanced Security; and Active Cashier 
Status Editor. 

Department/Subdepartment Maintenance:  Department Maintenance; 
Subdepartment Maintenance; Department Restriction Matrix; and Group Descriptor 
Maintenance. 

Customer Maintenance:  Negative Check File Maintenance; Negative Check Report; 
Customer File Maintenance; Check/Charge Reason Codes; Clear Customer Totals; 
Customer Report; Frequent Shopper Discount Matrix; and Level Code Maintenance. 

System Personalization:  System Configuration; Banner File; Reason Code 
Maintenance; Tax Table Maintenance; Keyboard Configurator; Media Configurator; 
Foreign Currency Rate Editor; Tax Code Editor; SRR Editor; Communication 
Parameters; and Customer CRT Promo Editor. 

Communications Menu:  Call Host; Send PLU File to Host; Get Electronic Coupon 
File; Send Coupon Submission; and Kronos Communication.. 

Reports Menu:  Financial Report Menu; Item File Reports; Electronic Coupon 
Reports; Delete Electronic Coupons; Print End-of-Day Reports; Electronic Journal by 
Transaction; and Electronic Journal by Cashier.. 

Office Procedures:  Pickups and Loans; Cashier Settlement; Delay Cashiers; Office 
Reconciliation; Deposits; ScanMaster Reconciliation Report; Adjust Settled Cashiers; 
Active Cashiers List; Media Flash Report; and Office Adjustments. 

System Services:  View Security Log; View/Delete Suspend/Lock Files; Label 
Printing; Third Party Menu; Electronic Journal Backup; System Backup; and 
View/Print Error Logs. 

Miscellaneous Maintenance:  Promotion/Coupon Editor; Bottle Link Editor; Report 
Code Editor; Tare Table Maintenance; Variable Tare Maintenance; Electronic Coupon 
Maintenance; Bundle Code Maintenance; and Adjective Price Maintenance. 

Accounts Receivable Menu:  Post A/R Payments; Post A/R Finance Charges; A/R 
Month-End Close; A/R Statement Printing; A/R Aging Report; and A/R Activity 
Report. 
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Financial Reports Menu:  Department Flash Report; Enhanced Department Report; 
Department Historical Report; Department Activity Report; Hourly Activity Report; 
Consolidated TLOG Reports; Summary Audit Trail Reports; Detail Audit Trail 
Reports; Cashier Report; Lane Productivity Report; and Non-Resettable Totals Report. 

Item File Reports Menu:  PLU File Reports; PLU Movement Reports; Ad Movement 
Reports; and Clear Item Movement. 

Special Menu Access: Keyboard Configurator; User-Defined Menu; Third Party 
Menu; and End-of-Day Procedures. 

Application Security:  View SRR; Print SRR; Export SRR; Edit Handkeyed Totalizers; 
Edit Imported Totalizers; Edit Customer FS Info; and Allow SIL Configuration. 
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Enhanced Security Worksheet 
 

Cashier 
Name: 

 

  
ITEM MAINTENANCE MENU 

Direct Item Maint. ______ Print Batches  Flip Chart Maint.  

Create/Edit Batches  Mass Attribute Batches  Misc. Maint 
Menu 

 

Activate Batches  Convert PLU Report To Batch  reserved  

Delete Batches  Mix & Match Maint.  reserved  

 
EMPLOYEE MAINTENANCE 

Employee Maint.  Force Cashier Logoff  reserved  

Active Cashier List  Enhanced Security  reserved  

Employee List  Active Cashier Status Editor  reserved  

Cashier Monitoring  Cashier/Lane Messaging  reserved  

 
DEPARTMENT/SUBDEPARTMENT MAINTENANCE 

Dept. Maintenance  reserved  reserved  

Subdept. Maint.  reserved  reserved  

Dept. Restriction Matrix  reserved  reserved  

Group Desc. Maint.  reserved  reserved  

 
CUSTOMER MAINTENANCE 

Neg. Check File Maint.  Clear Cust. Totals  P.C. Expt/Impt  

Negative Check Report  Customer Reports  Level Code 
Maint 

 

Customer  File Maint.  Freq. Shpr. Disc. 
Matrix 

 Customer Host 
Configuration 

 

Check/Chg. Reason Codes  Accounts Rec. Menu  reserved  

 

SYSTEM PERSONALIZATION 
System Configuration  Tax Table Maint.  SRR Editor  

Reserved  Keyboard Configurator  Comm. Params  

Banner File  Media Configurator  CRT Promo Edit  

Reason Code Maint.  Tax Code Editor  Foreign Curr. 
Edit 
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REPORTS MENU 
Electronic Coupon Reports  EJ Reports  reserved  

Delete Electronic Coupons  reserved  reserved  

APT Coupon Report  reserved  reserved  

Print End of Day Reports  reserved  reserved  

 

OFFICE PROCEDURES 
Pickups and Loans  Deposits  Media Flash Report  

Cashier Settlement  ScanMaster Recon. Report  Office Adjustments  

Delay Cashiers  Adjust Settled Cashiers  reserved  

Office Reconciliation  Active Cashiers List   reserved  

 
SYSTEM SERVICES 

View Security Log  System Back Up  reserved  

View/Del. Susp/Lock Files  View/Print Error Logs  reserved  

Label Printing  reserved  reserved  

Electronic Journal Back Up  reserved  reserved  

 

MISCELLANEOUS MAINTENANCE 
Promotion/Coupon Editor  Variable Tare Maintenance  Adj. Price Maint.  

Bottle Link Editor  Elec. Coupon Maintenance  Unit of Measure 
Table 

 

Report Code Editor  reserved  Multi Media 
Maintenance 

 

Tare Table Maintenance  Bundle Maintenance  Like Code Editor  

 

ACCOUNTS RECEIVABLE MENU 
Post A/R Payments  A/R Aging Report  reserved  

Post A/R Finance Charges  A/R Activity Report  reserved  

A/R Month End Close  reserved  reserved  

A/R Statement Printing  reserved  reserved  
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FINANCIAL REPORTS MENU 

Department Flash Report  Sum. Audit Trail Reports  Det. Audit Trail 
Rpt. 

 

Dept.  Historical Report  Cashier Report  Dept. Activity Rpt.  

Hourly Activity Report  Enhanced Dept. Report  Lane Prod. Rpt.  

Consolidated TLOG Report  Non-Resettable Totals  E.C. by Dept Rpt.  

 

ITEM FILE REPORTS MENU 
PLU File Reports  reserved  reserved  

PLU Movement Reports  reserved  reserved  

Ad Movement Reports  reserved  reserved  

Clear Item Movement  reserved  reserved  

 

SPECIAL MENU ACCESS 
reserved  Communication Menu  reserved  

User Defined Menu  reserved  reserved  

Third Party Menu  reserved  reserved  

End of Day Procedures  reserved  reserved  

 

Application Security 
View SRR  Edit Imported Totalizers  reserved  

Print SRR  Edit Customer FS Info  reserved  

Export SRR  Allow SIL Configuration  reserved  

Edit Handkeyed Totalizers 
(500) 

 reserved  reserved  
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Department File 
Through Department Maintenance, you can add, edit, or delete departments and set 
associated parameters for those departments.  There can be up to 99 departments on 
the ScanMaster System. 

 
Figure A-12:  Department Maintenance Screen 
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Subdepartment Maintenance 
Through Department Maintenance, you can add, edit, or delete subdepartments and 
set associated parameters for those subdepartments.  There can be up to 999 
subdepartments on the ScanMaster System. 

 
Figure A-13:  Subdepartment Maintenance Screen 
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Department Restriction Matrix 
This feature enables restrictions to be placed on specific departments, cashiers and 
customers.  It can be used to restrict the cashier from selling items if the cashier is 
under age or it can be used to restrict the sale of certain items to customers under a 
certain age.  There can be up to 99 department restrictions on the ScanMaster system. 

 
Figure A-14:  Subdepartment Maintenance Screen 
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Group Descriptors 
This feature enables the creation of group link headings for system reports.  You can 
create group descriptions, memo descriptions or both. 

 
Figure A-15:  Subdepartment Maintenance Screen 
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Customer File 
The Customer File enables the user to create and maintain the negative or positive 
check file, the frequent shopper file, and the customer charge file.  This chapter also 
discusses how to perform reason code maintenance, clear customer totals, and 
maintain accounts receivable records. 

Customer Maintenance enables the stores to create a user-defined customer database.  
Through this option, a store can set limits, assign charges and payments, establish 
store programs, and provide several Accounts Receivable tracking and reporting 
programs. 
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Negative Check File Maintenance 
The Negative Check File creates and maintains a file on customers who have written 
bad checks to the store.  This alerts the cashier about customers with a negative check 
history and prompts for office interaction.  There can be up to 9 user-defined negative 
check reason codes.  The system default is 0 = Good Account.  This code does not 
require office interaction. 

 

 

Figure A-16:  Negative Check File Screen 
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Customer File Maintenance 
Customer File Maintenance enables you to track customer check cashing, frequent 
shopper dollars and points, and in-store charges. Customer information is entered 
into the ScanMaster customer database from this screen. 

 
Figure A-17:  Customer File Maintenance Screen 
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Check/Charge Reason Codes 
You can assign up to nine reason codes each for negative checks, positive checks, and 
in-store charges. 

 
Check Reason Codes: 0 Good Account 

 1  

 2  

 3  

 4  

 5  

 6  

 7  

 8  

 9  

 
Charge Reason Codes: 1 30-60 Days 

 2 60-90 Days 

 3 90 Days Past Due 

 4 Over Limit 

 5  

 6  

 7  

 8  

 9  
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Frequent Shopper Discount Matrix 
The Frequent Shopper Discount Matrix permits the user to set up and define the 
discount percentage given to frequent shoppers.  This matrix can be set up using 
frequent shopper dollars or points depending on the frequent shopper program used 
by a particular store. 

 
Figure A-18:  Frequent Shopper Discount Matrix Screen 
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POS Workstation Settings Survey 
The POS Workstation Settings control parameters for each POS workstation on the 
ScanMaster System. 

You can utilize every POS Workstation Setting option or select only those you need.  
Each POS workstation can have its own settings. 

For detailed information on each field in the POS Workstation Settings, please refer to 
Chapter 8:  Personalization. 
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POS Workstation Settings 
 

Devices Settings 
Coin Changer 0=No 1=OCIA 2=Ser  

Enable Check Imaging  

Disable Cust Name on CID  

Interface NCR OCIA Scan/Scale  

Interface 7870 RS232 scan/scal  

Interface 7870 RS232 Scanner  

Interface 7880 RS232 scanner  

Interface 7890 RS232 scanner  

Interface 960LS RS485 Scan/Scl  

Interface 960LS RS232 Scan/Scl  

Interface Space RS232 Scanner  

Interface SP210 RS232 Scanner  

Interface 4100 RS232 Scale  

Interface Cyberdata 9 bit 7824  

Interface ML2010 RS232 Scanner  

Interface MS951 RS232 Scanner  

Interface Orion RS232 scan/scl  

Interface 960LS RS232 (ICL)  

Interface 7835/7836 Scanner  

Interface 7837 Scanner  

Enable MICR Reader Support  

Enable Video Customer Display  

Use 40 Column CID Mode  

Beep Scanner On Not Found  

Beep Scanner on Manual Item  

Beep Scanner on Offline Sale  

Beep Scanner on Item Intervent  

MultiMedia to 64Key Op Display  
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EFT Settings 
Enable Gift Card Recharge  

Disable Bank Charge Verify  

Disable Debit Card Verify  

Disable EBT Cash Card Verify  

Enable APT Interface  

XiNETix Cust Assume Level 1  

xiNETix EFT Merchant ID  

Enable Electronic Payment Sys  

Universal EFT Auth File Name  

Universal EFT Str & Frwd File  

Universal EFT Setlemnt File Nam  

Secondary EFT Auth File Name  

Secondary EFT Str & Frwd File  

Secondary EFT Setlmnt File Nam  

Checks use Secondary EFT Files  

Electronic Paymt Term Attached  

Enable Elec  Signature Capture  

Press Clear After EFT Approval  

Exp Year < 71 then Year > 1999   

Enable EFT Settlement Capture  

EFT Authorization Timeout Secs  

Enable EFT Tender Reversal  

Print EBT Decline Slip  

Configurable Term Amt Verify  

Disable EFT Logging  

Accept Stand Beside 2nd EFS  

Stand Beside 2nd EFS Desc  

Enable S&H Auto Pnt Redemption  

Enable Credit/Debit Conv (Y/N)  

Disable Credit/Debit Override  
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Receipt Settings 
Receipt/Endorse Header Line 1  

Receipt/Endorse Header Line 2  

Receipt/Endorse Header Line 3  

Receipt Header Line 4  

Receipt Header Line 5  

Receipt Header Line 6  

Receipt Header Line 7  

Receipt Header Line 8  

Receipt Header Line 9  

Receipt Header Line 10  

Receipt Trailer Line 1  

Receipt Trailer Line 2  

Receipt Trailer Line 3  

Receipt Trailer Line 4  

Receipt Trailer Line 5  

Receipt Trailer Line 6  

Receipt Trailer Line 7  

Receipt Trailer Line 8  

Receipt Trailer Line 9  

Receipt Trailer Line 10  

Signature Slip Header Line 1  

Signature Slip Header Line 2  

Signature Slip Header Line 3  

Print Cashier Name On Receipt  

Item Detail on Journal Printer  

Print To Date Frq Shp Totals  

To Date Frq Shp Totals Desc  

Print Period Frq Shp Totals  

To Period Frq Shp Totals Desc  

Store CPN Mult 1 Description  

Mfg CPN Mult 1 Description  
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Store CPN Mult 2 Description  

Mfg CPN Mult 2 Description  

Store Cpn Mult Subtotal Desc  

Mfg Cpn Mult Subtotal Desc  

Disable Wide Receipt Printing  

Disable Wide Validation Print  

Disable Wide Debit Slip Print  

Enable 7156 Delayed Receipt  

Remove Voids from Delayed Rcpt  

Receipt Only On Demand  

Print Elec Coupons After Items  

Disable Itemized EC on Receipt  

Enable Receipt History Capture  

Print Dual Delayed Receipts  

Disable Cust Name On Receipt  

Disable Cust Name on Sig Slip  

Disable Frq Shp # on Receipt  

Disable Acct# Print on Receipt  

Disable Acct# Print on Sig Slip  

Print 2nd Payment Slip for Cust  

Reverse Order of Payment Slips  

Disable Prt of IRI CPN Receipt  

Beep Scanner On Error  

Disable Chrg Info on Sig Slip  

Enable “You Saved” On Receipt  

Print “You Saved” Percentage  

“You Saved” With Store Coupon  

“You Saved” With Str Cpn Mult  

“You Saved” With Mfg Coupon  

“You Saved” With Mfg Cpn Mult  

“You Saved” With Str Elec Cpn  

“You Saved” With Mfg Elec Cpn  
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“You Saved” With Key Discount  

“You Saved” With Frq Discount  

“You Saved” With TPR  

Double Wide Receipt Header 1  

Double Wide Receipt Header 2  

Double Wide Receipt Header 3  

Double Wide Receipt Header 4  

Double Wide Receipt Header 5  

Double Wide Receipt Header 6  

Double Wide Receipt Header 7  

Double Wide Receipt Header 8  

Double Wide Receipt Header 9  

Double Wide Receipt Header 10  

Double Wide Receipt Trailer 1  

Double Wide Receipt Trailer 2  

Double Wide Receipt Trailer 3  

Double Wide Receipt Trailer 4   

Double Wide Receipt Trailer 5  

Double Wide Receipt Trailer 6  

Double Wide Receipt Trailer 7  

Double Wide Receipt Trailer 8  

Double Wide Receipt Trailer 9  

Double Wide Receipt Trailer 10  

Double High Receipt Header 1  

Double High Receipt Header 2  

Double High Receipt Header 3  

Double High Receipt Header 4  

Double High Receipt Header 5  

Double High Receipt Header 6  

Double High Receipt Header 7  

Double High Receipt Header 8  

Double High Receipt Header 9  
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Double High Receipt Header 10  

Double High Receipt Trailer 1  

Double High Receipt Trailer 2  

Double High Receipt Trailer 3  

Double High Receipt Trailer 4  

Double High Receipt Trailer 5  

Double High Receipt Trailer 6  

Double High Receipt Trailer 7  

Double High Receipt Trailer 8  

Double High Receipt Trailer 9  

Double High Receipt Trailer 10  

Double High Mfg & Store Coupon  

Double High Coupon Multiple  

Double High Mfg & Store EC Cpn  

Double High Discount  

Double High Subtotal Info  

Double High Transaction Total  

Double High  Tenders  

Double High Change  

Double High You Saved  

Double High Return & Refund  

Double High Sale Items  

Double High Freq Shopper Items  

Double High TPR Savings  

Combine Store & Mfg Cpn Subtot  

Combine Cpn & Mutiple Subtot  

Combined Cpn & Mutiple Desc  

Combine Store & Mfg EC Cpn Sub  

Combine All Tax Totals  

Combined Tax Total Description  

Print TPR Savings After Item  

TPR Savings Description  
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Disregard TPR less or equal to  

Print Dept Quantity List  

Print Dept Amount List  

Enable Delivery Receipt Func  

Phone # on Delivery Receipt  

 

Tax Settings 
Enable Tax 1  

Enable Tax 2  

Enable Tax 3  

Tax1 Rate ##.####% (0 = Table)  

Tax2 Rate ##.####% (0 = Table)  

Tax3 Rate ##.####% (0 = Table)  

Tax 1 Receipt Description  

Tax 2 Receipt Description  

Tax 3 Receipt Description  

Tax Exempt 1 Forgives All Tax  

Auto Tax Exempt if Num on File  

Use Tax3 Total for Memo Total  

Tax3 Memo Total Description  

 

Coupons Settings 
Store CPN Multiplier (0 = None)  

Mfg CPN Multiplier (0 = None)  

Automate Store CPN Multiplier  

Automate Mfg CPN Multiplier  

Store CPN Max Amt. To Multiply  

Mfg CPN Max Amt. To Multiply  

Store CPN Max Result Amount  

Mfg CPN Max Result Amount  

Store CPN Multiplier2 (0 = None)  

Mfg CPN Multiplier2 (0 = None)  



A-40 Appendix A:  Personalization Survey and Setup Guide 

Store CPN Max Amt. to Multiply2  

Mfg CPN Max Amt. to Multiply2  

Store CPN Max Result Amount2  

Mfg CPN Max Result Amount2  

Price LALO on Store Coupons  

Price HALO on Store Coupons  

Price LALO on Mfg Coupons  

Price HALO on Mfg Coupons  

Store CPN Forgives Tax  

Store CPN Disc. Forgives Tax  

Mfg CPN Forgives Tax  

Mfg CPN Disc. Forgives Tax  

Check CPN Against Dept. Sales  

Scan Cpn Desc (0=dept 1=item)  

Check Scan Mfg Cpn in Itm File  

Enable Family Code Cpn Check  

Disable Scan Mfg Coupons  

Allow Scan Mfg Cpn > Itm Price  

Allow Scan Mfg Dbl > Itm Price  

Reduce Cpn if > Sale Total  

Buy X Get Cpn Allows Cpn to X  

Buy X Get Cpn Allows Dbl to X  

Enforce Dept Entry on Mfg CPN  

 

Discounts Settings 
Enable Non Frq Shp Surcharge  

Surcharge Percentage ##.##%  

Surcharge Description  

Disc 1 (1=Item 2=Sale 3=Both)  

Disc 2 (1=Item 2=Sale 3=Both)  

Disc 4 (1=Item 2=Sale 3=Both)  

Disc 5 (1=Item 2=Sale 3=Both)  
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Disc 1 Fixed % (0=variable %)  

Disc 2 Fixed % (0=variable %)  

Disc 4 Fixed % (0=variable %)  

Disc 5 Fixed % (0=variable %)  

Discount 1 Description  

Discount 2 Description  

Discount 4 Description  

Discount 5 Description  

Discount 1 Total Time Limit  

Discount 2 Total Time Limit  

Discount 4 Total Time Limit  

Discount 5 Total Time Limit  

Discount 1 Line Item Limit  

Discount 2 Line Item Limit  

Discount 4 Line Item Limit  

Discount 5 Line Item Limit  

Verify NSC4 Acct # on Disc 1  

Verify NSC4 Acct # on Disc 2  

Verify NSC4 Acct # on Disc 4  

Verify NSC4 Acct # on Disc 5  

Exclude Dsc 1 if Cpn Applied  

Exclude Dsc 2 if Cpn Applied  

Exclude Dsc 4 if Cpn Applied  

Exclude Dsc 5 if Cpn Applied  

Exclude Dsc 1 If Item on Sale  

Exclude Dsc 2 If Item on Sale  

Exclude Dsc 4 If Item on Sale  

Exclude Dsc 5 If Item on Sale  

Auto Apply Dsc1 at End of Sale  

Auto Apply Dsc2 at End of Sale  

Auto Apply Dsc4 at End of Sale  

Auto Apply Dsc5 at End of Sale  
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Total Disc 1 Set During Sale  

Total Disc 2 Set During Sale  

Total Disc 4 Set During Sale  

Total Disc 5 Set During Sale  

Minimum Item Count for Disc 1  

Minimum Item Count for Disc 2  

Minimum Item Count for Disc 4  

Minimum Item Count for Disc 5  

Minimum Purchase Amt for Disc1  

Minimum Purchase Amt for Disc2  

Minimum Purchase Amt for Disc4  

Minimum Purchase Amt for Disc5  

Enable Net Discount Str Cpn  

Enable Net Discount Str Dbl  

Enable Net Discount Mfg Cpn  

Enable Net Discount Mfg Dbl  

Enable Net Discount Line Disc 1  

Enable Net Discount Line Disc 2  

Enable Net Discount Line Disc 4  

Enable Net Discount Line Disc 5  

Enable Net Discount Str EC Cpn  

 

Promotions Settings 
Enable Enhanced Electronic Cpn  

Enable Enhanced Frq Shp Prgm  

Frequent Shopper Program Desc.  

Electronic Coupon Description  

Prmpt for Frq Sh # at New Sale  

Prompt for Freq Shp # at Total  

Enable Phone # Lookup  

Enable Driver’s License Lookup  

Enable User Defined Lookup  
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Force Customer Entry  

Print Frequent Shopper Msg.  

Print Non Freq. Shopper Msg.  

Use Item Price Based Points  

FS Points Reduce by StrCpn  

FS Points Reduce by StrCpn Mult  

FS Points Reduce by MfgCpn  

FS Points Reduce by MfgCpn Mult  

FS Points Reduce by ElecStrCpn  

FS Points Reduce by ElecMFGCpn  

Use Item/EC Pnts & Bonus Pnts  

Item Price Based Points Desc  

Points Description  

Bonus Points Description  

Combine Price Pts & Itm/EC Pts  

Combine Points & Bonus Points  

Points Format (0=Amt  1=Number)  

Max # of cpns to Prt up to 19  

Under Total Sale Amount  

Under Total Sale Coupon #  

Over Total Sale Amount  

Over Total Sale Coupon #  

Over Freq. Shopper $$ Amount  

Over Freq. Shopper Coupon #  

Disable FrqShp Msg Over $$  

Freq. Shopper Rollover Amount  

Maximum # of Random Winners  

Random Winner Coupon #  

Frq Shp Stat Set by Chk Verify  

Frq Shp Stat Set by ACH Verify  

Frq Shp Stat Set by Store Chrg  

Minimum Purchase for Elec Cpns  
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Min Purch Not Reducd by StrCpn  

Min Purch Not Reducd by StrDbl  

Min Purch Not Reducd by MfgCpn  

Min Purch Not Reducd by MfgDbl  

Enable Dynamic Customer Build  

Dynamic Customer Default Level  

Default CID Promotion Number  

Display Customer Comment Info  

EAN Cust # Trim 0=Right 1=Left  

Enable Unvrsl Mrktng Interface  

Enable Unvrsl Credit Insertion  

UCI-Item Credit Timeout(0-10)  

UCI-Tender Cred Timeout(0-10)  

UCI-All Credit Timeout(0-10)  

Special Promo Description  

Special Promo Accum Begin Date  

Special Promo Accum Begin Time  

Special Promo Accum End Date  

Special Promo Accum End Time  

Add FS Dollrs to Special Promo  

Add Points  to Special Promo  

Add Bonus Pts to Special Promo  

Redemption Reset Special Promo  

UPC Type 4 Cust Num Support  

Disable MultiMedia  

MultiMedia Image Display Time  

Disable Motion Video  

Disable MultiMedia Sound  

Disable MultiMedia Full Screen  

Min FrqShp Level for Cpn Mult1  

Min FrqShp Level for Cpn Mult2  
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Voids/Refunds Settings 
Line Item Void Limit  

Total Void Limit  

Line Item Refund Limit  

Total Refund Limit  

Enable Refund Mode Operation  

Enable Error Correct Validatn  

Enable Void Validation  

Enable Refund Validation  

 

Items Settings 
Use Manual Tare Entry  

Use Auto Not Found Batching  

Dept/Plu Status (0=Plu 1=Dept)  

Enable Dept # Key Flip Chart  

Enable Sales Restriction Table  

Cust Age (0=Date 1=Id 2=Both)  

Copy Item File at Reg. Update  

Disable Halo/Lalo Check on UPC  

Enable Variable Tare  

Birthdate Display Age Verify  

Print restricted Customers Age  

Enable Department Validation  

Enable Negative Dep Validatn  

Flag Sale Itms on Receipt w/ $  

Bottle Deposit Description  

Reprompt same Item Vis Verify  

Allow Manual Weight Entry  

Use Var Weight 5 Digit Price  

Report Code Prompt Begin Range  

Report Code Prompt End Range  

Report Code Prompt Text  
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Report Code Mgr Begin Range  

Report Code Mgr End Range  

Report Code Mgr Text  

 

Media Settings 
Cash Pickup Warning Amount  

Cash Pickup Compulse Amount  

FS Pickup Warning Amount  

FS Pickup Compulse Amount  

FC Pickup Warning Amount  

FC Pickup Compulse Amount  

Foreign Change if Last Tender  

Check File (1=Neg 2=Pos 0=none)  

Use Check Acct for POS Check  

Use Paper Check  

Use Payroll Check  

Use Electronic Check  

Payroll Check Max Amount (Mgr)  

Payroll Check Overtender (Mgr)  

Payroll Check Max Overtender  

Use Enhanced Split Qty Calc.  

Maximum # Checks / Day  

Maximum # Checks / Week  

Maximum Amount Checks / Day  

Maximum Amount Checks / Week  

Disable Store Charge Verify  

Automatic Check Pay to Field  

Use Frq Shp # for Check Verify  

Disable Bank Chrg Acct Capture  

Enable WIC Sale Mode  

Capture Max Wic Check Amount  

Check Wic Begin & End Dates  
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WIC Tender Forgives Tax  

Disallow Open Dept in WIC Mode  

Ensure Signature on WIC Check  

Open Drawer Before Chk Validtn  

Alarm if Drawer Remains Open  

Enable Gift Cert Sold Validatn  

Drawer Alarm Delay in Seconds  

Use Routing # for Neg Check  

Enable NSF RTN Endorsement  

Return Endorsement Line 1  

Return Endorsement Line 2  

Return Endorsement Line 3  

Return Endorsement Line 4  

Return Endorsement Line 5  

Return Endorsement Line 6  

Return Endorsement Line 7  

Return Endorsement Line 8  

Return Endorsement Line 9  

Return Endorsement Line 10  

 

Sign On/Off Settings 
Print Accountability Receipt  

Print Pickup & Loan Receipt  

Disable Drawer Open Signon/off  

Signoff From Idle in Seconds  

One Step Entry for Signon/off  

Disable Signon/off Security #  

Check Cashier Active Status  

 

Security Settings 
Minimum Security Level for Mgr  

No Security if Manager Cashier  
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Prevent Manager Self-Override  

Security On Cancel  

Security On Override  

Security On Refund  

Security On Error Correct  

Security On Void  

Security On Discount 1  

Security On Discount 2  

Security On Discount 4  

Security On Discount 5  

Security On Suspend Sale  

Security On Retrieve Sale  

Security On Report Function  

Security On Utilities  

Security On Sale of Gift Cert.  

Security On Sale of Money Ord.  

Security On Misc. Functions  

Security On Paidout  

Security On Coupon Paidout  

Security On Gift Card Cash Out  

Security On Check Cashing  

Security On Media Swap  

Security On Rtrn to Item Entry  

Security On HALO/LALO Errors  

Security On Nosale  

Security On Tax Exemption  

Security On Dynamic Cust Build  

Security On Currency Exch Rate  

Security On Age Rstrct Decline  

Security On Paidin  

Security On Manual Type 2 Entry  

Security on Quantity Entry  
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Disable Key Entry of Mgr Id  

Rtrn to Itm Entry During Tendr  

Allow Manager Override of ACH  

 

Utilities Settings 
Enable Gift Certificate Sales  

Enable Money Order Sales  

Enable Paidout Function  

Enable Coupon Paidout  

Enable Gift Card Cash Out  

Gift Card Cash Out Limit  

Enable Vendor Gift Card Prgm  

Enable Check Cashing Function  

Check Cashing Fee Link  

Check Cashing Fee Dept  

Media Fee Exempt FrqShp Level  

Allow Check Fee Override  

Enable Media Swap Function  

Enable PaidIn/Out Validation  

 

Misc Settings 
Idle mode timeout in seconds  

Display Running FS Total  

Use Override Reason Code Menu  

Use Refund Reason Code Menu  

Use Void Reason Code Menu  

Print Voucher for Check Fee  

Voucher Text Promo Cpn Num  

Allow Voucher Redeem > Total  

Disable UPC Repeat Key (ENTER)  

Enable Shoppers Hotline  

Use Local Scan Resource  
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End of Sale Delay in Seconds  

Disp Cust Name at End of Sale  

Enable Paidout Acct Flip Chart  

Enable Power Fail Recovery  

Background Screen Color 0-7  

Disable Training Mode  

Disable Validation in Training  

Bottle Statuses Follow Item  

Distribute Multi-Lane EOD Time  

Number of Lanes in EOD Set  

Minutes Between EOD Sets  

Enable Catalina Interface  

Use Media Swap Reas. Code Menu  

Enable CVC Interface  

Allow Offline Card Activation  

Operator Display Item Detail  

Enable Total Prompt  

Total Prompt Text  

 

Financials Settings 
Use Media Counts  

Enable Pickups/Loans at Lanes  

Disable Pickups/Loans Offline  

 

Instore Charge Settings 
Enable Instore Charge  

Disp Chg Info? (1=Al 2=Name)  

Allow Charge Only if Balance 0  

Amount Compulse on Charge Menu  

Min Charge Status for Mgr Auth  

Print Customer History Msg.  

Disable Charge Payment  
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Back Office Settings Survey 
The Back Office Settings pertain to the set up of the Back Office PC, the File Server PC, 
and additional workstation PCs.  Back Office workstations may be configured slightly 
different. 

For detailed information on each field in the Back Office Settings, please refer to the 
Chapter 8:  Personalization in the ScanMaster User’s Guide. 

Back Office Setting Options 
Global/Store Settings 

 
Store #  

Store Name For Reports  

Are Subdepartments Used  

Force Freq. Shopper Bit On  

Page Host Batches in UPC Order  

# of Days of TLOG to Save  

Days of Hist. Archives to Save  

Weight in LBS (Y) (N) = KG  

Sec. Level on Item Maint.  

Sec. Level on Employee Maint.  

Sec. Level on Department Mnt.  

Sec. Level on Customer Maint.  

Sec. Level on Personalization  

Sec. Level on Communications  

Sec. Level on Reporting  

Sec. Level on Day End  

Sec. Level on Office Proc.  

Sec. Level on System Services  

Money Order Fee  

Use Store Spreadsheet  

Use Blind Balancing  

End Week on Day # (SUN=1)  

ST Coup O/S Add Into Net O/S  

MFG Coup O/S Add Into Net O/S  

Use Enhanced Security  

Accountability by Lane  

GiftCert O/S add into net O/S:  
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Print Cashier Log Files  

Turn On Accounts Receivable  

Company Name  

Company Address  

Company City, State, Zip  

Company Telephone Number  

Registers do Local Item Update  

Use Shrink Trax Interface  

Use Normal Balancing Mode  

Add Formfeed to End of Reports  

Treat Cashier O/S as Memo   

Treat Office O/S as Memo  

Add DBL Vendor Coupon to Sales  

Add Store Coupon to Sales  

Add DBL Store Coup to Sales  

Description for TAX1  

Description for TAX2  

Description for TAX3  

Days Historical Data to Save  

Weeks of SRR to Save  

Use Auto Pickup Feature  

Third Party DSD Installed  

Use Item Trail Feature  

Use Coupon Linking Feature  

Freq Shopper $$$ (N) or Pnts (Y)  

Allow Item Delete w/ Movement  

Commodity Code = Family Code  

Print Charge Log Information  

No Zero/Neg Balances AR Stmnt  

No Printer Graphics AR Stmnt  

Num of Deposit Accounts (1-3)  

Calc SRR on Current Line  

Settle Media Counts  

Finance Charges Compounded  

EJ Reports use Ehncd Elc Coup  

Electronic Journal Installed  

Hide NRT Totals from EJ Rpts  
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Enable Host Batch Separation  

Logoff Windows after EOD  

Point Description  

Bonus Point Description  

Freq. Shop. Level set Manually  

Allow Mult Same ECPN-FRQSP Lvl  

Default Elec. Coupon Dept.  

Enable 2100 Interface  

Lbl App 1=UG  2=General   0=Both  

Item Host Update Recs Dont Add  

# of Days of EFT Log to Save  

Show Suspended Sales at EOD  

Create Daily Movement Files  

Is EBO Installed  

Do Not Include Cpns in Movement  

Use Margin (Y) or Markup (N)  

Allow Deletes in Batches  

Enable Elec Cpn Label Printing  

A/R  STMT: Don’t Print Remitance  

A/R  STMT: Don’t Print Aging  

A/R  STMT: Don’t Print APR% Line  

A/R STMT: Make Address Larger  

Enable ASP Interface  

Default Store Elec CpnEJ Desc  

Default Mfg Elec Cpn EJ Desc  

Default Store UCI CPN EJ Desc  

Default Mfg UCI CPN EJ Desc  

EOD: 1=AUTODELAY, 2=AUTOSETTLE  

Default ECPN Type 0=MFG, 1=STR  

Sec. Level to Edit Cust FS Tab  

Export Cust File 2.01.xx Formt  

User Defined Lookup Desc  

Don’t Warn on Zero Priced Items  

# Min Process Inactivity Alert  

Use Enhanced Batching  

Batch Items Follow Header Date  

Allow Price Holddown  
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# Days Delete Expired Coupons  

Add Line Item Disc. To Sales  

Show Receipts First on SRR  

Enable Pricer Interface  

Pricer Export Day# (Sun=1)  

Store Name  

Store Location  

Random Winner Probability  

BackOffice Settings 
 
This PC Processes Tlogs  

This PC Does the End-of-Day  

Enable EJ Processor on This PC  

Enable 7800 on This PC  
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Banner File 
The Banner File is the scrolling message on the customer display that displays during 
idle time on the POS workstation.  Customized advertising or customer messages can 
be displayed through this banner. 

The Banner File consists of ten (10) lines of fifty-six (56) characters. 

 
Figure A-19:  Banner File Maintenance Screen 
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Reason Code Maintenance 
The Reason Code Maintenance screen is where you set up reasons for Overrides, 
Refunds, Voids and Media Swaps that appear on the POS workstations.  The reason 
codes appear on the override, refund, void and media swap report by cashier and by 
item. 

Overrides:  Overrides reasons permit you to change the price of a PLU at the POS 
workstation.  This price change only effects one line item, not the price in the item file.  
You can define up to four override reasons that display when a cashier performs an 
override. 

Refunds:  Refund reasons permit you to issue refunds based on the reasons defined.  
You can define up to four refund reasons that display when a cashier performs a 
refund. 

Voids:  Void reasons permit you to void a transaction based on the reasons defined.  
You can define up to four void reasons that display when a cashier performs a void. 

Media Swaps:  Media Swap reasons permit you to specify a reason for correcting 
tender errors after a transaction is completed.  You can define up to for media swap 
reasons that display when a cashier performs a media swap. 



  Appendix A:  Personalization Survey and Setup Guide A-57 

 

Reason Code Reasons 
Overrides:  

  

  

  

  

 

Refunds:  

  

  

  

  

 

Voids:  

  

  

  

  

 

Media 
Swaps: 
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Tax Table Maintenance 
The ScanMaster system can have up to three tax tables. Tax Table Maintenance 
enables you to configure Tax Tables 1-3 with exception ranges. 

The ScanMaster Tax Table is enabled from the POS Workstation Setting “Tax Rate 
##.####%(0=Table)”.  If this feature is not enabled (with a setting of 000000), the POS 
Workstation will use a table to calculate the tax.  If a rate is entered, it will use the 
percent rate entered in this POS Workstation Setting instead. 

 
Figure A-20:  Tax Table Maintenance Screen 
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Keyboard Configurator 
The Keyboard Configurator enables you to customize the POS workstation keyboard.  
You can assign department keys, and function/tender keys for the POS workstation. 

Keyboard Options 
There are six different keyboard options.  They are: 

Fujitsu Touch Screen 

Fujitsu Touch w/TeamKey 

Fujitsu 92R  

DynaKey™  

NCR 56 Key  

NCR 64 Key  

Each POS workstation on the system can be configured the same way or each can be 
configured differently. 

 
Figure A-21:  Fujitsu Touch Screen Configurator 
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Figure A-22: Fujitsu Touch w/TeamKey Configurator 
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Figure A-23:  Fujitsu 92R Key Configurator 
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Media Configurator 
This option enables you to customize the system media fields.  There are 23 media 
types available to customize.  Those fields and their default settings are listed below. 

Cash 
The following configuration options are available for the Cash media. 

 
Enable This Media (Y/N)  

Amount Compulse (Y/N)  

Validate (Y/N)  

Validate Description  

Validation Line 1  

Validation Line 2  

Validation Line 3  

Media Group Link (0-9)  

Allow Pickup (Y/N)  

Allow Loan (Y/N)  

Check 
The following configuration options are available for the Check media. 

 
Enable This Media (Y/N)  

Amount Compulse (Y/N)  

Max. Tender Amount (Mgr. Req.)  

Allow Over Tender (Y/N)  

Manager Over Tender Limit  

Max. Over Tender Limit  

Open Drawer 0=NO 1=FINAL 
2=IMD 

 

Data Capture/Display Prompt  

Data Capture Prompt Message  

Validate (Y/N)  

Validation Description  
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Validation Line 1  

Validation Line 2  

Validation Line 3  

Enable Check Writing (Y/N)  

Print Signature Slip (Y/N)  

Media Group Link (0-9)  

Allow Pickup (Y/N)  

Allow Pickup Counts (Y/N)  

Allow Loan (Y/N)  

Use Elec Payment Auth (Y/N)  

PIN Entry Required (Y/N)  

Maximum Cash Back Amount  

Signature Line on Slip (Y/N)  

Allow Manual Account Entry  

Allow Off-line Approval (Y/N)  

Off-line Tender Limit  

Capture Cash Back Amt At Term  

Term Cash Back Display Amt 1  

Term Cash Back Display Amt 2  

1-EFT Void  2-No Return to Sale  

Enable Term Amt Verification  

Foreign Currency 
The following configuration options are available for Foreign Currency Media. 

Enable This Media (Y/N)  

Media Description  

Amount Compulse (Y/N)  

Media Group Link (0-9)  

Allow Pickup (Y/N)  

Allow Loan (Y/N)  
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ACH (Electronic Check) 
The following configuration options are available for the ACH (Electronic Check) 
media. 

 
Enable This Media (Y/N)  

Amount Compulse (Y/N)  

Max. Tender Amount (Mgr. Req.)  

Allow Over Tender (Y/N)  

Manager Over Tender Limit  

Max. Over Tender Limit  

Open Drawer 0=NO 1=FINAL 
2=IMD 

 

Data Capture/Display Prompt  

Data Capture Prompt Message  

Validate (Y/N)  

Validation Description  

Validation Line 1  

Validation Line 2  

Validation Line 3  

Enable Check Writing (Y/N)  

Print Signature Slip (Y/N)  

Media Group Link (0-9)  

Allow Pickup (Y/N)  

Allow Pickup Counts (Y/N)  

Allow Loan (Y/N)  

Use Elec Payment Auth (Y/N)  

PIN Entry Required (Y/N)  

Maximum Cash Back Amount  

Signature Line on Slip (Y/N)  

Allow Manual Account Entry  

Allow Off-line Approval (Y/N)  

Off-line Tender Limit  
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Capture Cash Back Amt At Term  

Term Cash Back Display Amt 1  

Term Cash Back Display Amt 2  

1-EFT Void  2-No Return to Sale  

Enable Term Amt Verification  

Debit Card 
The following configuration options are available for the Debit Card media. 

 
Enable This Media (Y/N)  

Amount Compulse (Y/N)  

Allow Refund (Y/N)  

Max. Tender Amount (Mgr. Req.)  

Allow Over Tender (Y/N)  

Manager Over Tender Limit  

Max. Over Tender Limit  

Open Drawer 0=NO 1=FINAL 
2=IMD 

 

Data Capture/Display Prompt  

Data Capture Prompt Message  

Check Expiration Date  

Validate (Y/N)  

Validation Description  

Validation Line 1  

Validation Line 2  

Validation Line 3  

Print Signature Slip (Y/N)  

Media Group Link (0-9)  

Allow Pickup (Y/N)  

Allow Pickup Counts (Y/N)  

Allow Loan (Y/N)  

Use Elec Payment Auth (Y/N)  
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PIN Entry Required (Y/N)  

Maximum Cash Back Amount  

Signature Line on Slip (Y/N)  

Allow Manual Account Entry  

Allow Offline Approval (Y/N)  

Off-line Tender Limit  

Capture Cash Back Amt At Term  

Term Cash Back Display Amt 1  

Term Cash Back Display Amt 2  

1-EFT Void  2-No Return to Sale  

Enable Term Amt Verification  

Master Card, Visa, American Express & Discover 
The following configuration options are available for the Master Card, Visa, American 
Express & Discover Card media. 

 
 Master 

Card 
Visa American 

Express 
Discover 

Amount Compulse (Y/N)     

Max. Tender Amount (Mgr. Req.)     

Allow Over Tender (Y/N)     

Manager Over Tender Limit     

Max. Over Tender Limit     

Open Drawer 0=NO 1=FINAL 
2=IMD 

    

Data Capture/Display Prompt     

Data Capture Prompt Message     

Check Expiration Date     

Validate (Y/N)     

Validation Description  

Validation Line 1  

Validation Line 2  

Validation Line 3  
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Print Signature Slip (Y/N)     

Media Group Link (0-9)     

Allow Pickup (Y/N)     

Allow Pickup Counts (Y/N)     

Allow Loan (Y/N)     

Use Elec Payment Auth (Y/N)     

PIN Entry Required (Y/N)     

Maximum Cash Back Amount     

Signature Line on Slip (Y/N)     

Allow Manual Account Entry     

Allow Off-line Approval (Y/N)     

Off-line Tender Limit     

Capture Cash Back Amt At Term     

Term Cash Back Display Amt 1     

Term Cash Back Display Amt 2     

1-EFT Void  2-No Return to Sale     

Enable Term Amt Verification     

 
In-store Charge 

The following configuration options are available for the In-store Charge media. 
Enable This Media (Y/N):  

Amount Compulse (Y/N):  

Max. Tender Amount (Mgr. Req.):  

Allow Over Tender (Y/N):  

Manager Over Tender Limit:  

Max. Over Tender Limit:  

Open Drawer 0=NO 1=FINAL 
2=IMD: 

 

Data Capture/Display Prompt:  

Data Capture Prompt Message:  

Check Expiration Date:  

Validate (Y/N):  
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Validation Description:  

Validation Line 1:  

Validation Line 2:  

Validation Line 3:  

Print Signature Slip (Y/N):  

Media Group Link (0-9):  

Allow Pickup (Y/N):  

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  

Signature Line on Slip (Y/N):  

Allow Manual Account Entry:  

Enable Term Amt Verification:  

Gift Certificate 
The following configuration options are available for the Gift Certificate media. 

 
Enable This Media (Y/N):  

Amount Compulse (Y/N):  

Allow Refund (Y/N):  

Max. Tender Amount (Mgr. Req.):  

Allow Over Tender (Y/N):  

Manager Over Tender Limit:  

Max. Over Tender Limit:  

Data Capture/Display Prompt:  

Data Capture Prompt Message:  

Validate (Y/N):  

Validation Description:  

Validation Line 1:  

Validation Line 2:  

Validation Line 3:  

Print Signature Slip (Y/N):  

Media Group Link (0-9):  
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Allow Pickup (Y/N):  

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  

Food Stamps 
The following configuration options are available for the Food Stamps media. 

 
Enable This Media (Y/N):  

Amount Compulse (Y/N):  

Max. Tender Amount (Mgr. Req.):  

Media Group Link (0-9):  

Allow Pickup (Y/N):  

Allow Loan (Y/N):  

WIC 
The following configuration options are available for the WIC media. 

 
Enable This Media (Y/N):  

Amount Compulse (Y/N):  

Max. Tender Amount (Mgr. Req.):  

Open Drawer 0=NO 1=FINAL 
2=IMD: 

 

Data Capture/Display Prompt:  

Data Capture Prompt Message:  

Validate (Y/N):  

Validation Description:  

Validation Line 1:  

Validation Line 2:  

Validation Line 3:  

Enable Check Writing (Y/N):  

Print Signature Slip (Y/N):  

Media Group Link (0-9):  

Allow Pickup (Y/N):  



A-70 Appendix A:  Personalization Survey and Setup Guide 

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  

Master Card, Visa, American Express & Discover Credit 
The following configuration options are available for the Master Card, Visa, American 
Express & Discover Card credit media. 

 
 Master 

Card 
Visa American 

Express 
Discover 

Amount Compulse (Y/N)     

Max. Tender Amount (Mgr. Req.)     

Allow Over Tender (Y/N)     

Manager Over Tender Limit     

Max. Over Tender Limit     

Open Drawer 0=NO 1=FINAL 
2=IMD 

    

Data Capture/Display Prompt     

Data Capture Prompt Message     

Validate (Y/N)     

Validation Description  

Validation Line 1  

Validation Line 2  

Validation Line 3  

Print Signature Slip (Y/N)     

Media Group Link (0-9)     

Allow Pickup (Y/N)     

Allow Pickup Counts (Y/N)     

Allow Loan (Y/N)     

Use Elec Payment Auth (Y/N)     

PIN Entry Required (Y/N)     

Maximum Cash Back Amount     

Signature Line on Slip (Y/N)     

Allow Manual Account Entry     
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Allow Off-line Approval (Y/N)     

Off-line Tender Limit     

Capture Cash Back Amt At Term     

Term Cash Back Display Amt 1     

Term Cash Back Display Amt 2     

1-EFT Void  2-No Return to Sale     

Enable Term Amt Verification     

 

In-store Chg Credit 
The following configuration options are available for the In-Store Charge Credit 
media. 

Enable This Media (Y/N):  

Amount Compulse (Y/N):  

Max. Tender Amount (Mgr. Req.):  

Allow Over Tender (Y/N):  

Manager Over Tender Limit:  

Max. Over Tender Limit:  

Open Drawer 0=NO 1=FINAL 
2=IMD: 

 

Data Capture/Display Prompt:  

Data Capture Prompt Message:  

Use Neg/Pos Check (0-2):  

Validate (Y/N):  

Validation Description:  

Validation Line 1:  

Validation Line 2:  

Validation Line 3:  

Print Signature Slip (Y/N):  

Media Group Link (0-9):  

Add to Net Sales (Y/N):  

Allow Pickup (Y/N):  

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  
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Maximum Cash Back Amount:  

Signature Line on Slip (Y/N):  

Allow Manual Account Entry:  

Store Coupon 
The following configuration options are available for the Store Coupon media. 

 
Enable This Media (Y/N):  

Open Drawer 0=NO 1=FINAL 
2=IMD: 

 

Media Group Link (0-9):  

Allow Pickup (Y/N):  

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  

MFG Coupon 
The following configuration options are available for the Mfg. Coupon media. 

 
Enable This Media (Y/N):  

Open Drawer 0=NO 1=FINAL 
2=IMD: 

 

Media Group Link (0-9):  

Allow Pickup (Y/N):  

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  

Electronic Food Stamps 
The following configuration options are available for the Electronic Food Stamps 
media. 

Enable This Media (Y/N):  

Amount Compulse (Y/N):  

Allow Refund (Y/N):  

Max. Tender Amount (Mgr. Req.):  

Open Drawer 0=NO 1=FINAL 
2=IMD: 
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Data Capture/Display Prompt:  

Data Capture Prompt Message:  

Print Signature Slip (Y/N):  

Media Group Link (0-9):  

Allow Pickup (Y/N):  

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  

Use Elec Payment Auth (Y/N):  

PIN Entry Required (Y/N):  

Signature Line on Slip (Y/N):  

Allow Manual Account Entry:  

Allow Off-line Approval (Y/N):  

Off-line Tender Limit:  

Capture Gen # On Manual Entry:  

1-EFT Void  2-No Return to Sale:  

Enable Term Amt Verification:  

Electronic Benefit Transfer 
The following configuration options are available for the Electronic Benefit Transfer 
media. 

Enable This Media (Y/N):  

Amount Compulse (Y/N):  

Allow Refund (Y/N):  

Max. Tender Amount (Mgr. Req.):  

Allow Over Tender (Y/N):  

Manager Over Tender Limit:  

Max. Over Tender Limit:  

Open Drawer 0=NO 1=FINAL 
2=IMD: 

 

Data Capture/Display Prompt:  

Data Capture Prompt Message:  

Print Signature Slip (Y/N):  

Media Group Link (0-9):  
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Allow Pickup (Y/N):  

Allow Pickup Counts (Y/N):  

Allow Loan (Y/N):  

Use Elec Payment Auth (Y/N):  

PIN Entry Required (Y/N):  

Maximum Cash Back Amount:  

Signature Line on Slip (Y/N):  

Allow Manual Account Entry:  

Allow Off-line Approval (Y/N):  

Off-line Tender Limit:  

Capture Gen # On Manual Entry:  

Capture Cash Back Amt At Term:  

Term Cash Back Display Amt 1:  

Term Cash Back Display Amt 2:  

1-EFT Void  2-No Return to Sale:  

Enable Term Amt Verification:  
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Gift Card 
The following configuration options are available for Gift Card media. 

 
Enable This Media (Y/N)  

Amount Compulse (Y/N)  

Allow Refund (Y/N)  

Max. Tender Amount (Mgr. Req.)  

Open Drawer 0=NO 1=FINAL 
2=IMD 

 

Data Capture/Display Prompt  

Data Capture Prompt Message  

Check Expiration Date  

Print Signature Slip (Y/N)  

Media Group Link (0-9)  

Allow Pickup (Y/N)  

Allow Pickup Counts (Y/N)  

Allow Loan (Y/N)  

Use Elec Payment Auth (Y/N)  

PIN Entry Required (Y/N)  

Signature Line on Slip (Y/N)  

Allow Manual Account Entry  

Allow Offline Approval (Y/N)  

Off-line Tender Limit  

1-EFT Void  2-No Return to Sale  

Enable Term Amt Verification  



A-76 Appendix A:  Personalization Survey and Setup Guide 

Foreign Currency Rate Editor 
The Foreign Currency Rate Editor permits stores to enter the foreign currency 
exchange rate ScanMaster uses when calculating between the face amount and native 
value. 

 
Figure A-24: Foreign Currency Rate Editor 
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Tax Code Editor 
The Tax Code Editor allows you to assign a letter to each tax table or combination of 
tax tables.  This letter is printed on the customer receipt when that tax table or 
combination is used. 

 
Figure A-25: Tax Code Editor Screen 
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SRR Editor 
The SRR Editor enables you to develop a customized reconciliation report that 
displays all pertinent accounting information for store balancing under three 
headings (Paidouts, Receipts & Memos). 

Paidouts:  The paidouts heading details all store deposits, and anything paid out from 
the store safe. 

Receipts:  The receipts heading details all incoming funds to the store safe. 

Memos:  The memos heading details “other” trackable items that are not considered 
paidouts or receipts. 

 
Figure A-26: ScanMaster Reconciliation Report (SRR) Editor Screen 
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Communication Parameters 
This option provides interface parameters for stores using third-party host 
communication software on their ScanMaster system.  Configure these parameters to 
enable your communications software to interface with ScanMaster. 

Comm Software Drive Designator  

Comm Software Directory  

Comm Software Upload Directory  

Comm Software Download Dir.  

Store Receive Batch Name  

Store Send PLU File Name  

Store/VSP Number   

Save Store Report Codes  

Save Store Departments  

Set Discount 1 On  

Set Discount 2 On  

Save Subdepartment  

Save Mix N Match  

Save Store Mix N Match  

Save Descriptors  

Use Alternative Batching  

Set Tax2 On if Tax 1 On  

Max Number of Items Per Batch  

Electronic Coupon File Name  
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Communication CRT Promo Editor 
This feature is used to set up promotional messages that display on the customer CRT 
at each POS workstation. 

 
Figure A-27:  Customer CRT Promo Editor Screen
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